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GV-VMS Trial Version

GV-VMS is a comprehensive video management system that records up to 64 channels of
GeoVision and/or third-party IP devices. GeoVision offers a 60-day trial period that allows you to
connect to 16 channels of third-party IP devices without license. A “Trial Version” watermark will

appear on the live view and recorded files for the 16 channels of third-party IP devices.

Note:

1. If you insert a dongle for third-party IP devices, the dongle license will override the trial version
and the 16 trial channels will no longer be supported.

2. You cannot remotely access the trial channels using remote applications such as GV-Control
Center, etc.

Once the trial period expires, you will need to purchase a dongle or software license to connect to

third-party IP devices. See License in Chapter 1 for details.

Login Credential Limitation

Special characters ‘@’ and *’ are not supported to be used as the login username and/or password

of GV-VMS.
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V17.4.6 New Features

For the following V17.4.6 features, refer to related sections and page numbers.

Image Orientation by Software function for GV-VMS to perform image orientation from the
connected IP cameras (2.2.1 Configuring Video Settings, page 71).

Download application option for enabling the specified account’s access to downloading
applications on the Web browser. To configure an account’s access permission, see 1.7.2
Configuring Account Settings, page 40; for details on Download Center of the WebCam Server,

see 7.8 Download Center, page 246.

Background repair function for the database and AVI files (5.4 Repairing Damaged File Paths,
page 193).

Support for notifications, alerts, and computer alarms upon abnormal disk events.

o  Toinvoke computer alarms or to enable e-mail notifications upon abnormal disk events on
GV-VMS, see Step 6, 1.3.3 Setting up the Video Storage Location (1.3.3 Setting up the
Video Storage Location, page 19).

o  To activate text message display on GV-VSM (Vital Sign Monitor) and GV-Center V2 upon

abnormal disk events, see GV-CMS Series User’s Manual.

® Export file quality options for selecting the backup file quality (9.11.3.1 Advanced Settings for

Local Backup, page 331~332).

Display Sub Stream Priority option for playing recorded videos in sub stream in priority to
reduce the CPU loading. To access the option, select ViewLog > Toolbar > Setup; see No.3,
4.1.1 ViewLog Window.

Filter option for displaying different event types in different colors on the playback timeline.
(4.1.1 ViewLog Window, page 166).


https://s3.amazonaws.com/geovision_downloads/Manual/CMS/EN/CMS_Manual.pdf
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GPU Decoding

GPU (Graphics Processing Unit) decoding can lower the CPU loading and increase the total frame
rate supported by a GV-VMS. GPU decoding can be performed by an onboard GPU, external GPU,

or both, under the following specifications.

Onboard GPU: GPU decoding is only supported when using the following Intel CPU:
For H.264 Video Compression

. 2nd ~ 8th Generation Intel Core i3 / i5 / i7 Desktop Processors

. 9th ~ 13th Generation Intel Core i3 /i5 /i7 / i9 Desktop Processors

For H.265 Video Compression

. 6t ~ 8 Generation Intel Core i3 /i5 / i7 Desktop Processors

. oth ~ 13t Generation Intel Core i3 /i5/i7 / i9 Desktop Processors

Note: To get the best performance of 12t Generation Intel Processor or later versions, make sure to
upgrade your GV-VMS to V17.4.7 or later.

External GPU: GPU decoding is only supported when using NVIDIA graphics cards with compute
capability 3.0 or above and memory 2 GB or above. To look up the compute capability of the NVIDIA

graphics cards, refer to: https://developer.nvidia.com/cuda-gpus.

Note:

1. One external NVIDIA graphics card can be supported by GV-VMS17.1 or later to perform GPU
decoding at free of charge.
2. NVIDIA GeForce GTX 1060 is not supported.



https://php.gvdip.com/phpBB3/viewtopic.php?p=2673
https://developer.nvidia.com/cuda-gpus
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Onboard GPU + external GPU: To have both the onboard and external GPU to perform GPU

decoding, the GPUs must follow their respective specifications listed above.

Note:

1. If you have both onboard external GPU installed, the onboard GPU must be connected to a
monitor for H.264 / H.265 GPU decoding.
2. CUDA compute capability 5.0 or higher is required to ensure optimal performance. For more

information, see Total frame rate and number of channels supported

Software Specifications

GPU decoding is only supported under the following operating system, resolution, and codec.

2nd Gen | 3rd ~ 4th Gen | 6th Gen 7th Gen 8th ~ 13th Gen
Windows 10 Windows 10/ 11
Windows 8/8.1/10/ Server 2012 R2 /
0OS 64-Bit Server 2016 / Server 2016 /
Server 2016 / Server 2019
Server 2019 Server 2019
1MP/
Resolution o MP 1TMP/2MP/3MP/4MP/5MP /8 MP /12 MP
Codec H.264 H.264 / H.265

Note: Make sure your PC meets the system requirements before installing or upgrading to Windows

11. See Microsoft’s website for details.

Multi-Channel Playback

Multi-channel playback in ViewLog has been enhanced to improve the smoothness of the video by
producing higher frame rate. However, playing back multiple channels at high resolution can increase
the CPU loading especially if GV-VMS is processing other tasks simultaneously. As a result of the
high CPU loading, dropped frames may sometimes occur in recorded video when playing back
multiple megapixel channels. To avoid the problem, it is recommended to play back megapixel

video in single view.

GDPR Practice

For details on how GeoVision Inc. is committed to helping users become GDPR (General Data

Protection Regulation) compliant, visit the GDPR Consent Request.



http://pd.geovision.tw/technotice/IP_Camera/IP_device_integration_notes_VMSV151010.pdf
https://docs.microsoft.com/en-us/windows/whats-new/windows-11-requirements
https://s3.amazonaws.com/geovision_downloads/TechNotice/SW/GDPR_Consent_Requests.pdf
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Creating Camera’s Login Credentials

In order to connect to GV-VMS, after purchasing a new GV-IP camera or factory resetting your GV-IP

camera, you need to set up a login username and password for that camera.

1. Download and install GV-IP Device Utility from our website.

2. On the GV-IP Device Utility window, click Search Q to search for your camera.

3.  Double-click your camera in the GV-IP Device Utility list. This dialog box appears.

MacAddress \PAddress I 192.168.0.30

User Login

UserName [aamin VSS Port 10000
Password ﬁ

SetIP Address Change username and password |

New account |

New Password |

Confirm New Password |

Password strength - Weak

Please enter new account and password

[T Upgrade all devices

Cancel |

4. Click the Change Username and Password tab to type a new username and password.

5.  Optionally click Upgrade all devices to use the same username and password on all

other devices.


http://www.geovision.com.tw/download/product/GV-VMS
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1.1 Installing GV-VMS

1.1.1 License

GV-VMS supports connection of up to 64 IP channels, with connecting up to 32 channels of GV-IP

devices for free. If you need to connect more than 32 channels of GV-IP devices or connect with

third-party IP devices, licenses are required.

Supported Devices Channels | License
32 ch No license required.
GV IP Devices Only
64 ch GV-VMS Pro license required, 32 ch per license.
16 ch Trial Version: 16 channels of 3" party IP devices (60 days).
32 ch 3-Party or HD DVR license required, in increments of 1 ch.
GV + 3rd-Party IP
Devices 2 licenses required:
64 ch e GV-VMS Pro license, 32 ch per license.

e 3-Party or HD DVR license, in increments of 1 ch.

applying software licensing.

IMPORTANT: The licensing comes in two forms: GV-USB dongle and software license. The two are

incompatible. If a GV-USB dongle is inserted on the computer with the system, remove it before



https://s3.amazonaws.com/geovision_downloads/TechNotice/VMS/Licensing_GV-SW.pdf

(® GeoUisi

on:

Note:
1.  GV-USB dongle comes in internal and external dongles. Internal dongle is recommended for the
Hardware Watchdog function, which restarts the PC when Windows crashes or freezes.
2. For details on upgrading GV-USB Dongle, see Chapter 8 Dongle Upgrade in GV-VMS Quick
Start Guide.
Note for GV-VMS V17.4.5:
1. The HD DVR license is only supported by GV-VMS V17.4.5 or later.
2.  The HD DVR license is required for connecting UA-XVR and UA-XVL series (only analog
channels supported)
3. The 3"“-party license is required for connecting UA-IP cameras.
1.1.2 Minimum System Requirements
GV-VMS (Up to 32 Channels) GV-VMS Pro (Up to 64 Channels)
oS 64-bit Windows 8/8.1/10/ 11/ Server 2012 R2 / Server 2016 / Server 2019
CPU 4th Generation i5-4670, 3.4 GHz | 4th Generation i7-4770, 3.4 GHz
Memory 8 GB RAM 16 GB RAM
Processor Graphics To obtain the maximum frame rate possible, see GPU Decoding
Specifications at the beginning of the manual.

Note:
1.
2.

To use the fisheye dewarping function, the graphic card must support DirectX 10.1 or above.
H.265 decoding requires 6th Generation Intel Desktop Processor (Skylake) or above, which
comes with onboard GPU.

The system requirements are determined in round-the-clock recording settings with live view
only, while remote connections and video analysis features being disabled.

To save system logs using Microsoft SQL Server, Microsoft SQL Server 2014 Express or later is

required.



https://s3.amazonaws.com/geovision_downloads/Manual/VMS/EN/GV-VMS_QuickGuide.pdf
https://s3.amazonaws.com/geovision_downloads/Manual/VMS/EN/GV-VMS_QuickGuide.pdf

1.1.3 Options
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For the following optional devices of GV-VMS, contact your dealer for more information.

Optional Devices

Description

GV-I0O Box Series

GV-IO Box series provides 4 / 8 / 16 inputs and relay outputs, and
supports both DC and AC output voltages, with optional support for
Ethernet module and 4E additionally supporting PoE connection.

GV-Joystick V2

GV-Joystick V2 allows you to easily control PTZ cameras. It can be
either plugged into GV-VMS for independent use or connected to
GV-Keyboard.

GV-Keyboard V3

GV-Keyboard V3 is used to program and operate GV-VMS and PTZ
cameras with keyboard and function keys. Through RS-485
configuration, it can control up to 36 GV-VMS. In addition, you can
connect PTZ cameras directly to the keyboard for PTZ control.

GV-NET I/O Card V3.2

GV-NET/IO card V3.2 provides 4 inputs and 4 relay outputs. It supports
both DC and AC output voltages and provides a USB port as well.
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1.1.4 Minimum Network Requirements

The data transmitting capacity of GV-VMS depends on the number of Gigabit connections available.

The numbers of Gigabit network cards required to connect 64 channels are listed below according to

the resolution and codec of the source video.

S | Rl Bitrate Used | Total FPS | Gigabit Network | Max. Channels Supported
(Mbps) for 64 ch | Cards Required per Network Card
1.3 MP 5.05 1920 1 Max. 64 ch / card
2 MP 7.01 1920 1 Max. 64 ch / card
3 MP 10.48 1280 1 Max. 64 ch / card
H.264 4 MP 11.65 960 2 Max. 50 ch / card
5 MP 16.48 640 2 Max. 38 ch / card
8 MP 17.14 1600 2 Max. 38 ch / card.
12 MP 16.67 960 2 Max. 38 ch / card
2 MP 5.90 1920 1 Max. 64 ch / card
3 MP 7.06 1920 1 Max. 64 ch / card
4 MP 9.44 1600 1 Max. 64 ch / card
H.265
5 MP 7.52 1920 1 Max. 64 ch / card
8 MP 9.83 1280 1 Max. 64 ch / card
12 MP 9.85 1280 1 Max. 64 ch / card
1.3 MP 32.36 1920 3 Max. 22 ch / card
2 MP 44 .96 1920 4 Max. 16 ch / card
3 MP 38.73 1280 4 Max. 18 ch / card
MJPEG 4 MP 40.35 960 4 Max. 17 ch / card
5 MP 30.48 640 3 Max. 22 ch / card
8 MP 58.52 1600 6 Max. 12 ch / card
12 MP 65.98 960 6 Max. 11 ch / card
Note: The network requirements may vary depending on the bit rate of the streams.




1.1.5 Installing GV-VMS

Before You Start
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For optimal performance, please refer to the following recommendations before installing GV-VMS:

o It is highly recommended to use separate hard disks; one for installing Windows OS and GV-VMS

software, while the other for storing recorded files and system logs.

. When formatting the hard disks, select NTFS as the file system.

. When GV-VMS is running, it is not recommended to perform disk defragmentation at the same

time.

. Since the size of transmitted data from IP cameras may be quite large and reach beyond the

transfer rate of a hard disk, you should notice the total of recording frame rates that you can

assign to a single hard disk, as listed below:

Frame rate limit in a single hard disk

H.264 H.265
Video Resolution Frame Rate Bit Rate Frame Rate Bit Rate
(fps) (Mbit/s) (fps) (Mbit/s)
1.3 MP (1280 x 1024) 660 5.05 N/A N/A
2 MP (1920 x 1080) 660 7.01 660 5.90
3 MP (2048 x 1536) 440 10.48 660 5.35
4 MP (2048 x 1944) 330 11.65 550 7.74
5 MP (2560 x 1920) 220 16.48 660 6.73
8 MP (3840 x 2120) 550 14.13 440 9.83
12 MP (4000 x 3000) 330 14.47 440 9.85
Note: The data above was determined using the bitrate listed above, hard disks with average
R/W speed above 110 MB/s.

The frame rate limit is based on the resolution of video sources. The higher the resolutions, the lower

the frame rates you can assign to a single hard disk. In other words, the higher the frame rates you

wish to record, the more hard disks you’ll need. For detailed information of recording frame rates, refer

to the user’s manual of the IP camera that you wish to connect to.
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Installing GV-VMS

1. Download GV-VMS by selecting Primary Applications from the drop-down list and clicking

A
Download &=# of GV-VMS on GeoVision’s website.

2. If you are using a USB dongle, insert the dongle to your computer. See 1.1.1 Dongle for
connections requiring dongle license(s).

3. Toinstall USB driver, select Drivers, F/W, Patch from the drop-down list, and click Download icon
Ak
& of GV-Series Card Driver / USB Devices Driver.

. To verify the driver is installed correctly, go to Windows Device Manager and expand
DVR-Devices. You should see GV-Series USB Protector.

> & Audio inputs and outputs
(M Computer
» =y Disk drives
. B Display adapters
4 EF DVR-Devices
uF GV-5eries USE Protector
» Wz Human Interface Devices
» g IDE ATASATAPI controllers

Figure 1-1

1.2 Getting Started

When you run GV-VMS for the first time, the system will prompt you for a Supervisor ID and Password.

1.  Type the desired ID, Password and a Hint to remind you of the password.
2. Optionally set up the following functions
B E-Mail List: Enter e-mail addresses used to receive the password when forgotten.
B Auto Login: Allows auto login as the current user every time when the system is launched.

B Allow removing password System: It is recommended to select this option allowing
removal of the password database once you forget passwords. For details, see the same

option in Account and Password later in this chapter.
[ ] : Click to open the onscreen keyboard to enter the login information.

3. Click OK. The main screen of GV-VMS and a dialog box appears.

4. To choose how to save your system database, select Microsoft Office Access Database or
Microsoft SQL Server and fill out the required fields.

5. Upon first-time starting of GV-VMS, you are prompted with the Automatic Setup dialog box to
assist you in quickly adding IP devices to GV-VMS.


http://www.geovision.com.tw/download/product/GV-VMS
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1.2.1 Main Screen

Login ID Home Toolbar

Version Information

| Storage Space
I

Figure 1-2

Name Description

Login ID  Click to manage accounts and passwords for accessing GV-VMS.

Audio Click to control the volume of your PC.

Home Shows the live view of connected cameras.

ViewLog Shows a timeline of recorded events for playback.

Brings up these options when Home is selected:
e Monitor: Start / Stop monitoring, I/0 monitoring and schedule monitoring
¢ Network: Enable Webcam Server and connection to other GeoVision software.
e Tools: Show / hide volume indicator and set up Object Index.
Toolbar Configure: Set up camera, recording, system, schedule, video processing and 1/O

devices.

e Content List: Access live view layout, camera and I/O device lists and panorama view.
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Brings up these options when ViewlLog is selected:

e Display Play Panel: Display or hide the ViewLog timeline. This function is grayed out

when the Pinned button is selected in the bottom-right corner.
e Tools: Manage event search, system log, event backup and event export.
e Configure: Apply video effects and text overlay during playback.

e Content List: Manage playback layout and access camera list.

Exit Click to minimize or exit GV-VMS.

1.2.2 Adding Cameras

To add cameras to GV-VMS, click Home d - Toolbar k&l > Configure L * SIS Camera Install.
When the camera list is empty, the Automatic Setup dialog box automatically pops up.

Click Automatic Setup to search for IP cameras on the LAN. Then select / deselect the desired

cameras listed and click Apply.

Automatic Setup ﬁ
Network adapter - IIF‘U 92.168.4.223] Realtek RTL8168C(P)/8111C(P) Family PCI-E Gigak + Port ;15000
Automatic Setup Progress -

Name IP Address Port MAC Address Brand

GV-CAW120 192.168.4.95 10000 0013E204FCOD GeoVision_GV-CAW120

GU-MFD520 192.168.5.115 10000 0013E2054F24 Geovision_GV-MFD520_

GV-BX2500 192.168.5.125 10000 0013E209C3F3 GeoVision_GV-BX2500

GV-PT320D 192.168.5.168 10000 0013E20550C5 GeoVision_GV-PT320D

] i r
Check Al | | Uncheck Al { Apply ] { Cancel

Figure 1-3

1. The default login ID and password of connected cameras is admin / admin. To specify a login
credential, double-click the camera. If you select Apply All, the login info will be applied to all
selected cameras.

2. When cameras are added for the first time, they are automatically assigned to the live view grid.

To manually add cameras, see Adding IP Cameras in Chapter 2.

10
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1.2.3 Accessing Live View

After adding cameras, you can access camera live view by dragging the camera in the Content List to

the live view grid.

= 27 o
Click Home M > Toolbar &2 > Content List HM. Then click Camera in the content list to see
the list of cameras added, and drag the desired cameras to the live view grid.

H: Layout v

P Camera (3) ~

©
™
ﬁ Cameral

& Camera2
ﬁ Camera3

= Panorama v

@ 1/0 Device (0) v

Figure 1-4

See Live View and Layouts later in this chapter for details.

1.2.4 Enabling Recording

To start recording, click Home hf.i > Toolbar l&d > Monitor g > Start All Monitoring.
Alternatively, select the cameras you want to start monitoring.

By default, every camera records with the following settings:

Default Recording Settings

Recording Mode Motion Detection

Resolution / Codec | The camera’s current resolution / codec will be used.

® To change recording mode, see Recording Settings later in this chapter.

® To change resolution and codec, see Configuring Video Setting in Chapter 2.

11
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1.2.5 Playing Back Video

Instant Playback

You can instantly play back the recorded video of a single camera from the camera live view by clicking

the Instant Playback button.

13:17:20

Figure 1-5

ViewlLog

For comprehensive playback functions, click ViewLog on the top-right corner.

For details, see Video Playback in Chapter 4.

12



Configuring Main System

1.3 Recording Settings

To configure the recording setting of the cameras, click Home w > Toolbar l.’n.- > Configure 'n'
> System Configure > Record Setting. The Recording Setting dialog allows you to configure the

following settings:
1.3.1 Setting up Global Recording Settings for All Cameras
1.3.2 Setting up Recording Settings for Individual Cameras

1.3.4 Setting up Motion Detection

By default, the system has the following recording storage settings.

Default Data Storage Settings

Storage Location | Recorded Files D:\Record\<camxx or audxx folder>.

Event Database Files | C:\GV-VMS\CameraDBs\

Storyline Files C:\GV-VMS\StoryLine\

Recycle Function Enabled with recycling threshold set to 32 G.

Note: A storage folder is created automatically upon assigning the camera ID. For example, camera
of ID 1 will be saved in the folder D:\Record\CamO1.

13
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1.3.1 Setting up Global Recording Settings for All Cameras

You can configure global recording settings to be applied to all cameras, such as maximum length of

each video clip, recycling function and the actions to take upon recording errors.

Video Record
MaxVideoClip: 1 | Min Database Folder
PreRecord: | DCVsLog)
ZIRecycle []Use Digital Watermark Protection
PlRegister Event $Sync recording from camera 8D card when reconnected
Storyline '™
Record Error Process © '™ PreRecord X
Camera L
[JPost-Rec 3 Sec o2
Camera Name []Pre-Rec: 1 Video Clips Storage o, Stream XA
A 5 = Si
Camera1_GV-VD1530 Video Clips 5 Sec. ftorage 1 v Main and Sub Stream v %
Camera2 ToaiEat ftorage 2 v Main and Sub Stream v ¢
rgent Even v
Camera3 ftorage 3 v Mainand Sub Stream v 3¢
Camerad Cancel ftorage 1 v Main and Sub Stream v ;’(
Camera5 forage 2 v Mainand Sub Stream v ¢
Figure 1-6

[Video Record]

B Max Video Clip: Specifies the maximum time length of each recorded file (from 1 to 5 minutes),

i.e. if you select 5 Min, a 30-minute event will be chopped into six 5-minute event files.

B Post-Rec: Keeps on recording for a set period of time after an event stops. Click the button next

to Pre-Record to access.

B Pre-Rec: Records video for a set period of time before an event starts. Specify the number of
video clips to pre-record and specify the number of seconds per video clip. For example, if you
specify 3 video clips and 5 seconds, 15 seconds of video, 3 files of 5 seconds each, before each

motion or input event will be recorded. Click the button next to PreRecord to access.

To set the frame rate for pre-recording, you can select Urgent Event or General Event. The frame
rate for General Event and Urgent Event can be defined in the camera’s Record Setting dialog box
(Figure 1-7). Normally, you would set a higher frame rate for Urgent Events (Ex: full frame) and a

lower frame rate for General Events (Ex: key frame only).

B Recycle: When selected, the oldest recordings will be deleted when the system requires storage
space for new files. If not selected, the system will stop recording when disk space is full. Select

Register Event if you want to recycle Register Events from the System Log.

14
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B Sync recording from camera SD card when reconnected: Retrieves and restores recordings
from the SD cards of cameras selected when reconnecting after a temporary disconnection. After
enabling, select the cameras for this function to be applied to by checking the checkboxes beside
Camera Name. Recordings that are synced from the SD cards of recorded cameras are displayed

in yellow within the Timeline of ViewLog.

Record Setting

Video Record

MaxVideo Clip: |5~ Min Database Foidar

PreRecord: |~ E\GV-VMSiCameraDBs\

M Recycte [[]Use Digital Watermark Protection

[IRegister Event 4 Sync recording from camera SD card when reconnected
StoryLine ™

Record Error Process

Camera F/

Camera Name Record Type B | videorecordframerate W, | Storage Stream |

Cameral Motion Detection v Urgent Event v Storage 1 Maln Stream v X

amera2 Motion Detection v Urgent Event v Storage 1 Main Stream v X

Figure 1-7

Note: This function is only supported by ONVIF cameras of Profile G conformant and the following
models of GV/UA-IP cameras:

e GV-BL2702 series / 3700 /4702 /4713 /5700/5713

e GV-BX2700 series / 2700-FD / 4700 series / 4700-E / 4700-FD / 5700 series

e GV-EBL4702 series / EBL4711 / EDR4700 series / EFD4700 series

e GV-EFER3700/EFER3700-W / FER5700 / FER5701

e GV-MFD2700 series / MFD4700 series

e GV-VD2702 /2712 /3700 /4702 /4711 /4712 /5700 /5711

e Storage-supporting models of GV-ABL / AVD / EBD / TBL/ TDR / TFD / TVD series

e UA-IP camera models: UA-B580F3 / R500F2 / R560F2 / R580F2 / R800F2

[Record Error Process] Define which actions to take when a recording error occurs.
B Invoke Alarm: Activates computer alarm by playing the selected sound file.

B Invoke to Send Alerts: Sends e-mail notifications. For details, see Setting up E-mail Notifications

later in this chapter.
B Register Event: Records errors to the System Log.

B Output Module: Triggers the selected output device. To configure output devices, see Chapter 6

I/O Applications to configure output devices.

[Storyline]
B Keep Image Ratio: Keeps the image ratio of the recorded storyline videos.

B Resolution: Specifies the resolution of the recorded storyline videos.

15
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B Path: The default storage path for Storyline is at C:\GV-VMS\ Storyline\. Click D to specify a

new storage path.

Note: To record a storyline, see Storyline later in this chapter.

[Database Folder]

The default storage path for Event Database (.db files) is at C:\GV-VMS\CameraDBs\. Click \:l to
specify a new storage path. Note that the storage path of recorded videos is specified in the Add Log

Location option. For details, see Setting up the Video Storage Location later in this chapter.

[Use Digital Watermark Protection] Watermarks all recordings. For details, see Watermark Viewer in
Chapter 9.
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Record Setting
Video Record Database Folder
1 3 Max Video Clip: |5 ~| Min EEEC CAGV-YMS\CameraDBs\ | \ras
L] [JPostRec 5 cee [JRegister Event >
[]Use Digital Watermark Protection StaryLine
[JPre-Rec: 1 Video Clips L
Keep Image Ratio
\ Video Clips 5 Sec. ||y
Resolution: |1280x1024 )
Urgent Event v =
Record Error Process - Path : | CAGV-VMS\StoryLinel |
Camera I
Camera Name Record Type Video record frame rate Storage Stream M
Cameral Motion Detect w B Urgent Event w | Btorage 1 Mai;tand Sub v
rea|
Cameraz2 Motion Detect w WUrgent Event v | Ftorage 1 Ma'é‘tf:j%”b v
Camerag WMotion Detect v MUrgent Event v | Btorage 1 Magt?e"j%l"b vl
Camerall Motion Detect w B Urgent Event v | Btorage 1 Magt?ena({%ub v I ¥
Cameral2 Motion Detect w B Urgent Event w | Btorage 1 Magtraenaj::u'a v i
Main and Sub
Camera13 Mation Detect ~BUrgent Event v | Btorage 1 " .Streadms X vl %
’ ain and Su
Camera22 Motion Detect Urgent Event torage 1
0 wlUrg v g Stream v
Add Log Location Apply Partition to Record [

Figure 1-8
1. Select the camera you want to configure. Hold the Shift key to select multiple cameras if needed.
2. Under Record Type, select Disable, Motion Detection or Round-the-Clock.

3. You can set different recording frame rates. Select Urgent Event to record in full frame rate.

Select General Event to record only the key frames.

The frame rate for General Event and Urgent Event can be defined in the camera’s General
Setting dialog box (Figure 2-13). Normally, you would set a higher frame rate for Urgent Events

(e.g. full frame) and a lower frame rate for General Events (e.g. key frame only).

4. |If there are more than one storage locations, select Storage to specify where to store the

recordings. See Setting up the Video Storage Location later in this section.

5. Under Stream, select the stream(s) you want to record. By default, Main and Sub Stream is set to
record both streams simultaneously. Select Main Stream to record high-resolution video images.

Select Sub Stream to record lower-resolution video images.
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Note:

1. Refer to Configuring General Settings in Chapter 2 for setting the frame rate for General Event

and Urgent Event.

2. In Round-the-Clock mode, for motion recordings, the Video Record Type setting in the
Advanced Motion Detection Setup dialog box has priority over the Video record frame rate
setting in the Record Setting dialog box (Figure 1-8). For example, if you select General Event
in the Record Setting dialog box, but select Urgent Event in the Advanced Motion Detection
Setup dialog box, the motion events will be recorded in full frame rate as Urgent Event.

Camera EJ/
[ Camera Name Record Type [y | Videorecordframerate [F, | sStorage Stream B |X)
Camera3 Round-the-clock v General Event v Storage 1 Main Stream v
Camerad Round-the-clock v General Event v Storage 1 Main Stream v X
Camera5 Motion Detection v Urgent Event v Storage 1 Main Stream v }(
Advanced Motion Detection Setup X
Camera3 v
[Juser-defined
O Define Object
Min Object Size A }
@ Setregion @
Sensitivity: 9 / _‘ y
' -
(O Mask region @ < . !
| o _ﬂ’ (] Minimum Duration Second
[JProcess Video in Lower Resolution @
[ | Level: 1 @
[Jignore environmental changes £4video Record Type
Urgent Event v [
Trigger
[JE-mail [JRegister Motion Event
Output Module Dlinvoke Alarm
Default ApplyAll Cancel
See Setting up Motion Detection later in this section for details.
3.

Main and Sub Stream recording is not supported by fisheye cameras.
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1.3.3 Setting up the Video Storage Location

Add Log Location

You can create a maximum of 24 storage groups with different storage locations. The default storage

location is D:\Record\.

1.  On the Recording Setting dialog box (Figure 1-6), click

dialog box appears.

Add Log Location [~

Apply Partition to Record |~

next to Add Log Location. This

Cancel

Add Log Location

-

[ = storage 1

=| DiskFull Process
= DiskLostProcess

=| DiskAbnormal Process

Path Total Space
[+ DARecord\ 69713 GB

CKeepDays: | 30 | [3)

Enlarge Recycle Threshold: 32 GB

Slze
173.13GB

Cancel

Figure 1-9

2. To add a new folder in the first storage group, click above Path and select a folder. Only 1
folder can be assigned as storage folder per partition (e.g. only 1 folder in D drive).

3. To add a new storage group, click in the top-left corner and repeat the step above to assign at

least one folder to the storage group.

4. Select Keep Days and specify the number of days to keep the video files in storage.

5. Inthe Enlarge Recycle Threshold field, adjust the recycle threshold (minimum 5 GB; maximum

999 GB) if needed. Recycle threshold is the file size at which the recycling begins.

6. To specify the actions to take for different statuses of hard disks, click ~

Process / Disk Lost Process / Disk Abnormal Process.

next to Disk Full

B Invoke Alarm: Activates computer alarm by playing the selected sound file.
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B Invoke to Send Alerts: Sends e-mail notifications. For details, see Setting up E-mail

Notifications later in this chapter.

B Register Event: Records errors to the System Log. (Not available for Disk Abnormal

Process).

B Output Module: Triggers the selected output device. To see how to set up I/O devices, refer

to Chapter 6 1/0 Applications. (Not available for Disk Abnormal Process).

7. Click OK.

Note: If the designated storage space is not big enough to keep all video files for the defined days,
the Recycle Threshold setting will override the Keep Days setting.

Apply Partition to Record

GV-VMS can automate the configuration of recording paths for multiple camera channels. Each of your
cameras will be equally distributed to the assigned recording paths after you have set up the storage

locations.

1. On the Recording Setting dialog box, click Apply Partition to Record.

2. Select the desired recording paths (at least one) to store camera recordings and click OK.

1.3.4 Setting up Motion Detection

The motion detection settings will be applied to motion events in both Round-the-Clock mode and

Motion mode. The following features are available to prevent false motion detection:

® Object Size: Set a minimum and maximum object size to only detect objects within the size

range

® Sensitivity: Designate up to 10 levels of motion detection sensitivity for each outlined area
® Mask Region: Mask off unwanted areas for monitoring, such as cloud and tree movement
® Noise Tolerance: Ignore video noise when the lighting condition is poor or changed

® Ignhore environmental changes: Ignore changes such as rain, snow and tree movement

® Minimum Duration: Set the minimum duration for which motions must persist for the system to

issue a motion alarm
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Open the Recording Setting dialog box (Figure 1-6), select a camera and click . This dialog box

appears.

Camera

Camera Name Record Type I | video record frame rate  IF, | Storage [, Stream
Camera3 Round-the-clock v General Event v Storage 1 Iain Stream
Camerad Round-the-clock v General Event v Storage 1 Main Stream
Cameras Moation Detection w Urgent Event v Storage 1 Main Stream

/Advanced Motion Detection Setup

Cameratt

[

[Juser-defined

Min Object Size
@® Setregion @

Sensitivity: 9

(O Mask region @

¢ []Minimum Duration
Noise Tolerance "% L

Video Record Type

Urgent Event v
Trigger

‘3 | second

[Process Video in Lower Resolution @
[Jignore environmental changes

[JEnable Camera's Built-in Motion Detection @

[ Record

[JE-mail [ Register Motion Event
(] Output Module [Jinvoke Alarm
fod 1 Pnt
Default Apply Al Cancel
Figure 1-10

You can refine motion detection by setting either Object Size or Region Sensitivity.

B Define Object: Limit motion detection to objects within a size range. Select User-defined and

set the Min. Object Size and Max. Object Size in the respective drop-down lists.

B Set Region Sensitivity: Set different detection sensitivities for different parts of the camera

image. Uncheck User-defined, click the Add/Cut Mask @ buttons to create several

areas. To adjust the sensitivity level for individual area, right-click the detection area and move

the slider. By default, the entire image is set to sensitivity level 9.

To ignore motion in specific areas of the image, click Mask Region, and drag areas on the image.

The following options are available to further reduce false alarm:

B Noise Tolerance: Enable to ignore video noise.

B Ignore environmental changes: Ignore environmental changes such as rain or snow. When

this option is selected, objects moving steadily and repeatedly in the same direction for over

1.5 seconds are filtered out and ignored.

B  Minimum Duration: Set the minimum duration for which motions must persist for the system

to issue a motion alarm. Set the minimum duration in seconds (up to 60).
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5.  You can reduce CPU loading by selecting Process Video in Lower Resolution. When this option
is enabled, GV-VMS compresses live view into a lower resolution before GV-VMS detects if there

is motion, which reduces CPU loading, but may affect accuracy.

6. The camera’s built-in motion detection is enabled by default. To use GV-VSM software motion

detection instead of the camera’s, deselect Enable Camera’s Built-in Motion Detection.

Note: The camera’s built-in motion detection is enabled by default in GV-VMS V17.4 or later, with the
exception of GV-QSD series, GV-QFER series, and cameras connected through ONVIF, which use

software motion detection when connected.

7. To set the frame rate setting for motion events, click Video record frame rate and select Urgent
Event or General Event. Normally, you would set a higher frame rate for Urgent Events (Ex: full
frame) and select Urgent Event here for motion events. See Configuring General Setting in

Chapter 2 to modify the frame rates of general and urgent events.
8. Under Event Trigger, select the actions to take when motion is detected.

B E-mail: Send e-mail notifications. For details, see Setting up E-mail Notifications later in this

chapter.
B Output Module: See Chapter 6 1/0 Applications for I/O device setup.
B Register Motion Event: Register motion events to the System Log.
B Invoke Alarm: Activate computer alarm by playing the selected sound file.

9. Click OK to save your settings.

Note:
1. You can only enable motion detection either by sensitivity or by object size at a time.
2. By default, the entire camera view is set to a motion sensitivity level of 9 with Noise Tolerance

and Process Video in Lower Resolution functions enabled.

22



Configuring Main System

1.4 Live View and Layouts

This section describes the functions on the camera live view and how to create new live view layouts.

1.4.1 Utilizing Live View Functions

Live View Icons

Place the mouse cursor on the camera live view to see the icons below.

Figure 1-11

Icons Functions

Instant Play = Plays back the video recorded.

Snapshot m Captures a snapshot of the current live view.

Talk Back Toggle / | Talk to the surveillance site. For details, refer to [The behavior of the talk back

Push-to-Talk \.'.J_ button], Configuring General Settings later in this chapter.

Tools ','K Includes the following options:
B Monitor: Starts monitoring the camera.
B Properties:
© Show Caption: Shows camera name on live view.
© Keep Image Ratio: Locks aspect ratio of the camera image.
B Close: Removes the camera from the layout grid.

The following options are available when related function is enabled or
supported:
B Set to Wave Out: Enables live view audio. (See Configuring Audio

Setting, Chapter 2)

23



Q GeoUision:

Tools % B PTZ Control: Enables PTZ functions. (See PTZ Camera later in this chapter)

B Add to bookmark: Bookmarks a scene to watch later in ViewLog player. The

function is only available when the channel is recording.

B Storyline: Records a sequence of short video clips of a specific incident.

(See Storyline later in this chapter)

E Switches the live view to full screen. If there is a designated Zoom window,
Zoom .

clicking the Zoom button will display the live view in the zoom window instead.

Volume Display an audio volume indicator on the top-left corner of the camera live view.

Click Home k4l > Toolbar & > Tools [J > Audio > Show Volume

Indicator == Indicator.

Note: When PTZ Control is enabled on a PTZ camera, double-clicking the live view will make the

camera zoom in instead of switching to full screen.

Functions on Live View and Content List

The live view screen can be controlled using the actions below.

Actions Functions
Mouse scroll Zooms in or out on the live view.
Double-click Displays the live view in full screen.

In the Content List (Home e - Toolbar &3 > Content List), right-click a camera to access the
following options, when enabled or supported:

B Monitor: Starts monitoring the camera. (See Start Monitoring later in this section)
B Video Process: Opens the Video Processing dialog box. (See Chapter 3 Video Analysis)
B Set to Wave Out: Enables live view audio. (See Configuring Audio Setting, Chapter 2)

B Talk Back Toggle: Talks to the surveillance site from the PC. (See Configuring Audio Setting,
Chapter 2)

B Focus View Setup: Creates up to 7 closed-up views in a camera. (See Setting up Focus View

later in this section)
B PTZ Setup: Enables PTZ functions. (See PTZ Camera later in this chapter)

B Fisheye Settings: Opens the Fisheye Settings dialog box. (See Fisheye View, Chapter 3)
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Audio Broadcasting

When necessary, the GV-VMS operator can broadcast audio to multiple cameras simultaneously with

the speaker function.

Note: This function is not supported by cameras connected through RTSP protocol.

1. Click Home < >Toolbar " >Tools B > Audio Broadcast. This window appears.

X

Figure 1-12

2. Click the Down arrow button to select the cameras you wish to broadcast audio to.
2 )

3. To start audio broadcasting, press and hold the Push to Broadcast button \*/ while talking to

the microphone connected to the computer of GV-VMS.

1.4.2 Arranging Live View Layouts

1. In the Content List, click Layout.

B Layout ~

M Camera (3) v

= Panorama b

I/O Device (0) v
Figure 1-13

2. To add a layout, click Add © and click Add Layout. The Add New Layout dialog box appears.

3.  Name the new layout and select one of the three available methods under Layout Setup to define

a layout and click OK.
4. If you select Customize in the step above, the Customize Layout dialog box will appear.

a. Click Reset to specify a dimension for the grid if needed.
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b.  Select multiple squares and click Merge to create a larger square.
c. Click OK when you are done.

A message appears. Click Yes if you want to automatically assign the cameras to the new layout.

Tip: You can right-click a layout in the Content List to access other functions to arrange the layout.

1.4.3 Setting up Zoom Window

You can designate a Zoom Window to quickly see a close-up view of the camera image without

changing the rest of the live view layout.

Note:
1. Up to two Zoom Windows can be created on each live view layout.

2.  When there are two Zoom Windows, GV-VMS will alternate between the first Zoom Window

and the second Zoom Window each time you click the Zoom button of a camera.

1.  Inthe Content List, select Layout, click Windows and drag Zoom Window to a live view grid.

2. Move the mouse cursor to a camera live view and click Zoom in the top-right corner. The
camera live view is displayed in the Zoom Window.

3. Toremove the camera from the Zoom window, place the cursor on the live view, click Tools b4
and select Close. To change the live view grid back to a normal window, repeat this step again to

close the Zoom Window.
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1.4.4 Setting up Scan Window

You can assign multiple cameras to a Scan Window, and each camera will be shown in sequence for

the Scan Interval specified.

Note: Up to four Scan Windows can be created on each live view layout.

1. In the Content List, select Layout, select Windows, and drag Scan Window to a live view grid.

2. Drag multiple cameras into the Scan Window.

® Geollision GYVMS == 964.10GB  TESTI98-PC | 5/27/2014 6:53:24 PM

® Content List

el
el
—

e Q&

)
\ ﬁ Cameral
)

\ ﬁ Camera?
e
\ﬁ Camera8

Figure 1-14

3.  Move the cursor to the Scan Window, click Tools %, and select Properties. This dialog box

appears.
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Scan Properties ‘ -

MName Scan Interval
Cameral 15
Camera? 5

Camera8 5

Default Scan Interval:
3 = Sec.

Show Caption

["]Keep Image Ratio

Figure 1-15

4.  To adjust the order of a camera, select a camera and click the Up and Down arrows.

5.  To specify how many seconds to show the live view of each camera, click and adjust the Scan

Interval of each camera. Optionally click the Finger to apply this Scan Interval to all

cameras.
6. To show camera name on live view, select Show Caption.
7. To lock the original aspect ratio of the camera image, select Keep Image Ratio.

8. Click OK.

1.4.4.1 Creating a Camera Group

You can also add multiple cameras to a group and the created group can be dragged into a live view
grid directly or Scan Window for display. At least 8 cameras are required in the camera list for this

function to work.

1. Click Camera in the Content List, click Add e , and click Add Group. Rename the group if
necessary.

2. Drag the desired cameras from the camera list to the group created.

3. Drag the created group either into a live grid or Scan Window. For details on setting up Scan

Window, see Setting up Scan Window earlier in this chapter.
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You can designate a Popup Window to display live images of cameras, upon events, on a separate

monitor. For this function to work, you must first create a live view layout on another monitor.

1. Inthe Content List, click Layout > Add © > aAdd Layout to create a new layout.

2. After clicking OK, select a desired monitor from the Apply to... list to activate the layout on the

designated monitor.

3. Inthe Content List, click Windows > Add © > Add camera popup window to select the

cameras to be displayed in the Popup Window.

Note: For details on configuring the Camera Popup Setting, see Popping up Live View later in this

chapter.

4. Rename the Popup Window if necessary and drag the Popup Window from the Content List to the

layout created in Step 3.

1.4.6 Setting up Focus View

You can create up to 7 close-up views per camera and place these created close-up views inside the

live view grid.

1. Inthe Content List, right-click a camera and select Focus View Setup. This dialog box appears.

Talk Back Toggle

Video Process.

Focus View Setup

>

Focus View - Camera6 ‘i =

]

Color: (——] -

Focus ViewArea:

Figure 1-16
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2. Click Enable and draw a box on the camera view to create a focus view. You can create multiple

focus views if needed.
3. You can change the color of the box if needed.
4. Click OK. The created focus views are listed under the camera.

5. You can now drag the focus views to live view grids.

Note: This function is not supported for Fisheye Cameras and PTZ Cameras.

1.4.7 Automatic Switch among Different Live View Layouts

You can have different layouts automatically alternated at a specified interval.

1.  Create and group several layout templates under the Content List (Figure 1-17).

2.  Right-click the group to configure its Scan Setting to specify the scan interval.

m: Layout

Q W

[ Windows

r
Scan Setting
B Default Layout

Default Scan Interval:

- il New Group 1
- i Scan start
M Layout 1 Scan Setting 10 —[ Sec.
M Layout2 Rename |
0K Cance
WE Layout 3 I
Figure 1-17

To start the automatic switch, right-click the group and select Scan Start. In the example above,
Layout 1, Layout 2, and Layout 3 are automatically switched among each other every 10 seconds, with

the currently displayed layout highlighted in orange.
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1.5 Start Monitoring

After setting up the following functions, it is important to start monitoring in order for the functions to

start: Recording, Video Analysis, Motion Event Trigger and Schedule.

To start monitoring, click Home M > Toolbar k&3l > Monitor g and select one of the options:

| &a O i

Start Schedule Monitoring

Start All Monitoring
I/O Monitoring

Camerad

Camera20

Figure 1-18
B Start Schedule Monitoring: If you want to start running a created schedule, select Start
Schedule Monitoring. The schedule takes precedence over the current settings, and these
functions will start and stop according to the schedule: Recording, Video Analysis, 1/0, PTZ Auto
Functions, Motion Event Trigger and Network Connections with Center V2 / Vital Sign Monitor. For

details on creating a schedule, see Schedule later in this chapter.
B Start All Monitoring: Starts monitoring on all cameras to initiate recording and related functions.

B |/O Monitoring: Starts I1/0O monitoring to activate 1/O functions. I/O Monitoring is only available
after at least one 1/O device is set up. For details on setting an I/O device on GV-VMS, see Setting
up I/O Devices in Chapter 6.

B Camera#: Starts monitoring of selected cameras. You can also start monitoring individual

cameras by right-clicking the camera in the Content List and select Monitor.

Note: Motion detection and 1/O trigger will only be registered in the System Log if monitoring is
started. You will also need to enable Register Motion Event in the Advanced Motion Detection

Setup dialog box (Figure 1-10) and Register Input Event in the I/O Application Setting (Figure 6-10).
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1.6 System Configuration
This section introduces system configurations of GV-VMS.
1.6.1 Configuring General Setting

Start configuring General Setting by clicking Home M > Toolbar IV{I > Configure 'n' >
System Configure > General Setting. This dialog box appears.

General Setting -

Location Name Related Actions
| Zoom Camera

| WIN-CIDKMHVL32G]

[JAuto enable wave out

Monitor Option
[] start Delay: & | Sec.

Auto toggle talk back

[w] Auto switch PTZ mapping
[15ervice Mode )

Exit Option
Display

[w] Enable DirectDraw

[ |Auto Restart Windows

The behavior of the talk back button
O Talk Back Toagle

®) push to tak

0K Cancel

Figure 1-20

[Location Name] The given name (maximum 14 characters) is displayed in the main screen as the

name of the server.

[Monitor Option]

B Start Delay: Start recording x second(s) after Start All Monitoring or Start I1/0O Monitoring is

selected.

B Service Mode: Under Service Mode, GV-VMS can start automatically after system startup and

run in the background without logging into Windows.
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[Display]

B Enable DirectDraw Scale: Applies DirectDraw Scale to enhance image quality if it is supported
by your VGA card. For certain VGA cards, DirectDraw Scale can result in blurred images. To avoid
the image problem and maintain DirectDraw Scale, change the image quality to Standard [Video

Setting] of the camera (Figure 2-11).

Note: The Enable Directdraw Scale function can greatly enhance image quality. Enable if your VGA
card supports DirectX9. To check the version of your DirectX, click Start and run dxdiag. Open the
file and find the related information.

[The behavior of the talk back button]

B Talk Back Toggle: Users can click the Y button to talk to the surveillance site and click the
button again to stop talking on the live view.

B Push to talk: Users can click and hold the Y button to talk to the surveillance site and release
the button to stop talking on the live view.

[Zoom Camera]

B Auto enable wave out: Automatically enables Wave Out function of the camera in Zoom Window
or in full screen. Note that the Wave Out function needs to be enabled in the Audio Setting page of

the camera first.

B Auto toggle talk back: Automatically enables Toggle Talk Back function of the camera. Note that

the Toggle Talk Back function needs to be enabled in the Audio Setting page of the camera first.

B Auto switch PTZ mapping: This function only applies to GV-Keyboard connected to GV-VMS.
When selected, PTZ control from GV-Keyboard will be applied to the mapped PTZ camera. When

not selected, GV-Keyboard can only control the first available PTZ camera.
[Exit Option]

B Auto Restart Windows: Restarts Windows OS after exiting GV-VMS.

B Auto Shut down Windows: Shuts down Windows OS after exiting GV-VMS.
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1.6.2 Customizing Startup Settings

To configure GV-VMS to enable certain features upon startup, click Home edl > Toolbar i >
Configure ®¥ > System Configure > Startup. This dialog box appears.

Startup ﬁ
General
Show Style Network
- [] webCam Server
[L|ght Siyle '] [T] Mobile Service
[¥] Auto Monitoring [C] connect to Centerv2
_ [C] Connect to VSM
[Schedule Monitog "] [T Connect to GV-Cloud Center
[] Auto Run when Windows Starts [7] Backup Center

[T Control Center Server
[] Startup and Hide into Systern Tray

Advanced
GPU Decode

Figure 1-21
[General]
B Show Style: Change the color scheme of GV-VMS.
B Auto Monitoring: Select one of the following monitor control modes upon startup:
®© Monitor All: Starts monitoring of all cameras and I/O (if available) upon system startup.

© Schedule Monitor: Starts monitoring of cameras by schedule. See Schedule later in this

chapter.
®© 1/O Monitor: Starts monitoring of all I/O devices upon startup.
© Camera Monitor: Enables all cameras for monitoring.

B Auto Run when Windows Starts: Automatically runs GV-VMS after Windows starts. If you did
not set an Auto Login account or an Auto Startup Login account, the Login dialog box will appear

upon startup.

B Startup and Hide into System Tray: GV-VMS appears in the system tray when you launch

Windows instead of displaying the system login window.

L
R )= s545PM

¥

Note: Startup and Hide into System Tray and Auto Startup Login cannot function at the same
time. When both are enabled, Auto Startup Login will not be applied. For details on Auto Startup
Login, see Setting up a Startup Auto Login User later in this chapter.
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[Advanced]

B GPU Decode: Enabled by default, GPU (Graphics Processing Unit) decoding lowers CPU loading
and increases the total frame rate supported by GV-VMS. But if your PC does not meet the system
requirements as listed in GPU Decoding at the beginning of the manual, you can disable this
function to optimize system operations. After deselecting GPU Decode, restart GV-VMS for the

change to take effect.

[Network]

B Automatically enables connection to the following application(s) upon startup: WebCam Server,
Mobile Service, Center V2, VSM, GV-Cloud Center, Backup Center, Control Center Server

1.6.3 Customizing Display Position and Panel Resolution

You can customize the display settings of GV-VMS by clicking Home K?d > Toolbar kil >
Configure L+ RN System Configure > Set Position. This dialog box appears. The right half is only

available when multiple monitors are installed.

Main Panel ViewLog
Select Monitor Select Monitor

User Define [Monitor 2

Position: Position:

0 -1280

Panel Resolution: Panel Resolution:

1920 X 1280 X

0K ] [ Cancel

Figure 1-22

B Select Monitor: Select the monitor you want to configure from the drop-down list.
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B Position: Offsets the position of the GV-VMS window relative to the upper-left corner of the
screen. The default position is 0, 0. A position of 100, 60 will place the GV-VMS window 100 pixels
to the right and 60 pixels below the upper-left corner. This function is only supported when the

GV-VMS window does not take up the entire screen.

Position: Position:
0,0 100, 60
Figure 1-23

B Panel Resolution: Sets the Panel Resolution of GV-VMS.

1.6.4 Setting up E-mail Notifications

Events that can be used to trigger e-mail notifications include: Video Lost, Recording Error, Disk Full,
Disk Lost, Disk Abnormal, Motion Detection, I/O Trigger, Intruder Event, Crowd Detection, Advanced
Unattended Object, Advanced Scene Change Detection, Advanced Missing Object and Face

Detection.

1. To receive e-mail notifications upon the occurrence of an event, click Home wdl > Toolbar ki >
Configure L S System Configure > Send Alerts Approach Setup. The Alert Approach dialog

box appears.

2. To enable e-mail notifications, select Send Email > Email Setup. This dialog box appears.

E-Mail lﬂ
Mail Setup
ENHEERE geavision.com.tw LTIETTET \%—;v
E-Mail From admin@geovision.com.tw Alert Notification
E-Mail To admin@geovision.com.tw
Subject Security Notice

o

Attach Image Setup Alert Setup
E-Mail Alerts Interval
[ Attach ipg 320x240 1
Win. 0 Sec
SMTP Mail Server requires authentication SMTP Server @ 85L
SMTP Port 25 -
Account @ms
Domain name from DONS
Password
O
[ E-mail in Text-Mode [ ok || cance
Figure 1-24
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Under Mail Setup, type the host name of your outgoing mail server (SMTP), the sender’s e-mail
address, recipients’ e-mail addresses and a subject for the e-mail notification. For multiple

recipients, add a semicolon between each e-mail address.

Click the Test Mail button to send a test e-mail and see whether the setup is correct. If the e-mail

fails to send, you may need to check the following settings:

B SMTP Mail Server requires authentication: If the SMTP mail server needs authentication for

login, select this option and type your account name and password.

B SMTP Server: Keep the default port 25 which is common for most SMTP servers. However
webmail providers such as Gmail, Yahoo, and Hotmail generally use different SMTP port. In
this case, check your e-mail provider for the SMTP port number. Select SSL or TLS if your

e-mail server requires the SSL/TLS authentication for connection.
Complete other optional settings as needed:
B Mail Content: Type the e-mail content that will be included in all e-mail notificaitons.

B Attach Image Setup: Select Attach to include up to 6 snapshots in the e-mail. The image
format and size are selectable. Note the actual size can be either the main stream or the sub
stream depending on the On Demand setting. For details, see the On Demand Display section

later in this chapter.
B Email-Alerts Interval: Specify the time interval (0-60 seconds) between e-mail alerts to
prevent e-mails from being sent too frequently. The default interval is 5 minutes.

B Domain Name from DDNS: This option generates URL links for remote video playback in the
sent e-mails. For this function to work, enter the fixed IP address or domain name of
GV-VMS and enable WebCam Server.

B E-mail in Text Mode: When WebCam Server is enabled, your e-mail alert will be sent in

HTML format. If you want to send the e-mail alert in pure text format, select this option.

Note: To enable WebCam Server, click Home k24 > Toolbar k& > Network -E?i > WebCam
Server.
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1.6.5 System Idle Protection

The System Idle Protection automatically log off and/or start monitoring after GV-VMS is idle for a set

period of time.

1.

4.

Click Home k&4l > Toolbar i > Configure L System Configure > System Idle
Protection Setting. This dialog box appears.

System Idle Protection Setting ﬁ

System Idle over: 30 Sec.

Auto Logout or Switch to Startup Login User if avaiable

’Supervlsor v]

’Mon'rtor All v]
[T Auto Netwaork Service of Startup Setting

Figure 1-25

To automatically log out or switch to Startup Auto Login User, select Auto Logout or Switch to

Startup Login User if available and select the type of account to log out from the drop-down list.

If you have set up a Startup Auto Login User, GV-VMS will switch to the Startup Login User instead

of logging out. For details, see Setting up a Startup Auto Login User later in this chapter.

To automatically start monitoring, select Auto Monitoring, and use the drop-down list to select
Monitoring All, Schedule Monitoring, /O Monitoring or Camera Monitoring. When Monitoring

All is selected, both 1/0 Monitoring and Camera Monitoring will be enabled.

B Select Auto Network Service of Startup Setting to enable network connections to the

applications predefined in Startup. See Customizing Startup Settings earlier in this chapter.

In the System Idle Over field, type an idle time between 10 and 14400 seconds.

5. Click OK.

Note: The feature can monitor keystrokes, mouse clicks and actions from IR Remote Control and
GV-Keyboard.
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1.6.6 Configuring Fast Key Lock

1. To enable/disable certain fast keys, click Home el > Toolbar i > Configure o> System
Configure > Fast Key Lock Setup. The Fast Key Lock Setup dialog box appears.

2. Select one of the four tabs: General, ViewLog, PTZ Control and Network.

3. Clear the checkmark for the fast keys you want to disable. To restore the fast keys, select the

checkbox again.

4. Click OK to apply your settings.

1.7 Account and Password

The password setup allows you to assign permission and rights to accounts. You can create up to
1,000 passwords. Only Supervisor-level accounts are pre-set with access to password settings. Click

the account ID, click Password Setup, and select Local Account Edit to start.

‘ ® B % &

Change User (L)
Logout (Q)

Password Setup > Local Account Edit
Remote Authentication Setup

Startup Auto Login

Figure 1-26

1.7.1 Creating an Account

To create a new account, click the New button at the lower-left hand corner of the Local Account Edit

dialog box. You can create three types of accounts Supervisor, Power User and User.
. Supervisors have permissions over all system settings.

. Power Users have the same permissions as Supervisors, except that they cannot edit user

accounts and delete the password system (described later).

. Users are restricted from all system settings and have limited access to certain functions.

If you want to enable the guest account, click Guest and deselect the Disable Account option. Guests

will only be allowed to watch live view.
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1.7.2 Configuring Account Settings

You may find these options to the right of the account list depending on the authorization level.

e Guest Disable Account [ Time Setting |
b User ID: admin
- PowerUser
B Supenvisor Password : e
R admin Hint : senae
Card Number Field: 190-53790
["]User cannot change password

[7] Force password change at next login

Disable account if user does notlog in after (days)
Export this ID for IR Remote Control (GV-Keyboard)
[[13end password by E-mail D

[7] Login this ID automatically (Single user mode)

Figure 1-27

B Disable Account: Select if you want to disable this account.

B Time Setting: The account will expire and be disabled automatically after a set number of days.
Click Time Setting, and select Expire in (days). Specify the number between 1 and 9999.The
number you set will count down automatically.

B Card Number Field: Users are allowed to automatically log into their accounts by inserting the
card in GV-PCR310 Enroliment Reader. Manually type your card number in the field, or insert your
card in GV-PCR310 Enrolliment Reader and the card number will be shown in the field

automatically. Click #  to attach the card number to the user account.

B User cannot change password: The user is not allowed to change the set password.
B Force password change at next login: The user must change the password at next login.

B Disable account if user does not login after xx day (s): When the user does not log in the

system after a set number of days, its account will be disabled automatically.

B Export this ID for IR Remote Control: Allows you to log into the system by using GV-Keyboard

instead of using the general keyboard and mouse. For details see GV-Keyboard User’s Manual.

B Send password by Email: Allows you to retrieve passwords through e-mails. To specify e-mails,

click the [...] button. See Changing or Retrieving Password at Login later in this chapter.

B Login this ID automatically (Single User Mode): GV-VMS will automatically log into this account

after you click Login at startup.
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At the bottom of the page are global settings, which are applied to all accounts.

Mew | Remove Search |‘-IMS |‘u"lewlﬂgl

| Allow removing password system

Enable double password

| Make ID and passwords case-sensitive

Figure 1-28
B Allow removing password System: Enables the password removal utility. The option is critical if
you forget or are unable to retrieve any Supervisor password. With this option selected, you can
run the password removal utility PassUNINStall.exe from the GV folder and remove the password
database. Otherwise, you can only remove the password database by reinstalling Windows
operating system.
B Enable double password: When selected, after starting ViewLog, you will need to type the

passwords of any two supervisors to continue. At least 2 supervisor accounts are required.

B Make ID and passwords case-sensitive: Select to make all ID and passwords case-sensitive.

Note:

1. Before running the utility PassUNINStall.exe, you need to disable Service Mode on GV-VMS
(Figure 1-21) and close GV-VMS. After running the utility, restart GV-VMS.

2. Theloss of passwords can be solved in the following two ways:

° Retrieving password through e-mails.
° Removing password database by using the PassUNINStall.exe utility and rebuilding all
accounts.

However, if both Send Password by Email and Allow Removing Password System options are
not selected in advance, it is required to reinstall Windows operating system once you lose the
passwords.
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1.7.3 Changing or Retrieving Password at Login

You can change or retrieve passwords of GV-VMS through e-mail upon login.

Changing Password

1. In the Login dialog box, click Change Password. The Change Password dialog box appears.

2. Type the new password information, and click OK to save the changes.

Note: Only Supervisors can change the password.

Retrieving Password through E-mail

The password retrieval function works in the following ways after you click Send Password in the

Login dialog box.

e |If you are a supervisor but do not remember your ID, separate passwords will be sent to all

supervisor e-mail accounts after you click the Send Password button.

¢ If you remember your ID but forgot your password, enter your ID and click Send Password. The

password will be sent to your e-mail account.

1.7.4 Preventing Unauthorized System Termination

1. To restrict a non-supervisor account from exiting or restarting the system, click the account ID,

click Password Setup, and select Local Account Edit. The Password Setup dialog box appears.
2. Select a user from the user list to display its properties.

3. Select the VMS tab at the bottom, and clear the Exit System option to restrict the user from

quitting or restarting the system.

[¥ISearch POS Data

l_l‘\lrldED Attribute ] [T ATTTET
[object Tracking || | | Camera5
Edit Password | | Camera
[IMinimize or Logout Ll L . 5
napshot || L | amera
L | | | Cameraz2
Cad ayout setup || L Cameral
[#Live Text Overlay Camerad v

<]

| »

VMS I‘-ﬁewlog I Webcam,/Mabile I Fast Backup and Restore I Control Center I Privacy Mask I Other |

Figure 1-29
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1.7.5 Setting up a Startup Auto Login User

Configuring Main System

The Startup Auto Login User is typically a user account with limited access rights. After system is

started, GV-VMS will automatically log in with the Startup Auto Login User instead of showing the Login

dialog box.

1. Create an account you want to use for Startup Auto Login. Refer to Creating an Account earlier in

this section for instructions.

2. Click the account ID, click Password Setup, and select Startup Auto Login. Select Startup

Auto Login Setup.

3. Type the ID and Password of the existing account you want to use.

4. Click OK.

If you have selected Auto Logout or Switch to Startup Login User if available in System Idle

Protection Setting dialog box (Figure 1-25), GV-VMS will switch to the Auto Startup Login account after

it is idle for the set period of time.

1.7.6 Setting up Limits on Playback Time

1. To restrict playback time of camera channels, on the Local Account Edit dialog box, select a

account, click the ViewLog tab, and click the playback time column you wish to configure.

Execute EventLog
Export AVl
Delete EventLog
Browse System Log
Backup EveniLog
Display detected faces

&
=
=

Tl

FEEEENEEEEERE

O
CE

CIEEEEEE

9

...| Play Ti...

Unlimited
Unlimited
Unlimited
Unlimited
Unlimited
Unlimited
Unlimited
Unlimited
Unlimited
Unlimited
Unlimited
Unlimited

Camera Na
Cameral
Camera2
Camera3
Camerad
Camera5
Camera6
Camera?
Camera8
Camera9
Cameral0
Camerall
Cameral2

Linlimitad
[

~

m

[] Allow removing password system
Enable double password

[Make ID and passwords case-sensitive

New || Remove [ Vs [ Viewlog | Webcam | Fast Backup and Restore | Control Center | Privacy Mask [ Gther |

Figure 1-30

2. Select Limited Playback Time and specify a time limit. If you click E the time limit will be

applied to other cameras.
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1.8 Schedule

You can create schedules to enable and disable the following functions at specific times of a day and
apply the schedule to a weekly, monthly plan or a specific date.
® Recording
Alert upon motion detection
PTZ object tracking
PTZ Auto functions
Video Processing

I/O monitoring

Network connections to Center V2, Vital Sign Monitor, WebCam Server, Mobile Service and

GV-Edge Recording Manager.

Click Home &l > Toolbar kil > Configure ¥ > schedule Edit. This dialog box appears.

15 Schedule [
Plan Schedule
2014 Jul Today - 201417110
SUN MON TUE WED THU FRI SAT
1 2 3 4 5

B 7 8 9 10 R 12

13 14 15 16 17 18 19

20 21 22 23 24 25 26

27 23 29 0 X

Figure 1-31
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1.8.1 Creating a Schedule with Setup Wizard

The Setup Wizard is an easy way to create new schedule.

1. In the Schedule dialog box, click Schedule and select Setup Wizard.
2. Specify when to apply the schedule plan and click Next.
B Weekly: Applies the schedule plan to the selected days each week.
B Special Day: Applies the schedule plan to a specific date.

B Monthly: Applies the schedule plan to a specific day each month.

Note: You can apply the schedule plan to additional days or modify the time settings later. After the
schedule plan is created, refer to Step 3 in Creating a Schedule Manually later in this section.

3. Type a name for the schedule plan. If you have existing schedule plans, you can select Use

current plan and apply the selected plan to different days.

Setup Wizard

2. Select schedule plan

@ 1. Create new plan

Weekdays|

2 Use current plan

Figure 1-32
4. Click Next. This dialog box appears.

Weekday ﬁ
BB (e T

Application

ICamera? v‘
I J
AP

Apply to all cameras

2.1.2.3.4.5.9.7.§.9.1011.1212 14 15 16 17 18 19 30 21 32 23 3¢

T Round the Clock Rec

M ™ hiation Detection Rec
3™ ajarm Trioger
Server B Enabic Webcam Gon...
B Ename exm
PTZ Object
Tracking

Figure 1-33
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5.  When the Include button is selected, you will start with an empty timeline. Click the Add
button and drag across the timeline when you want the function to be enabled. Use the

Erase button @ when you want to disable the function.

6. You can also click the Exclude button and start with everything disabled. The Add button

is now used for disabling the function instead and the Erase button @ is now used for
enabling the function.

7. Four categories are available on the left.

B Camera:

® Round-the-Clock Recording: When highlighting the timeline, you can choose to apply

the frame rate settings for General Event or Urgent Event. The settings here will
override the settings in Record Setting once schedule monitoring is started. For
information on General Event and Urgent Event, refer to Configuring General Setting,
Chapter 2.

Motion Detection Recording: When highlighting the timeline, you can apply different
motion sensitivity levels. If you select User Define, the sensitivity level selected in

Advanced Motion Detection Setup (Figure 1-10) will be used.

Alarm Trigger: The Event Trigger methods selected in Advanced Motion Detection Setup
(Figure 1-10) will be triggered upon motion during the highlighted times.
PTZ: When highlighting the timeline, you can select a PTZ Auto function to be enabled

during that time. At least one PTZ camera is required.

Enable Webcam Connection: Grants streaming access for WebCam Server for the

camera channel within the time periods highlighted.

Enable ERM Server: Grants streaming access for Edge Recording Manager for the

camera channel within the time periods highlighted.

B AVP: During the enabled times, the selected video processing functions will be enabled even

if the cameras are not recording.

B |/O Monitoring: Enables I/O Monitoring.

B Server: Enables network connections to Center V2, Vital Sign Monitor, WebCam Server,

Mobile Service and/or ERM Service.

8. To apply the Camera and AVP schedules to selected cameras, use the camera drop-down list

above the timeline or click the Advanced Setting button .
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9. Click OK. The schedule plan created appears on the days you specified.

[5] Schedule [
Plan  Schedule
Weekedays
B ¥ 2014 Jul Today - 2014710
SUN MOMN TUE WED THU FRI SAT
1 2 3 4 5
Weekedays Weekedays Weekedays Weekedays
i 7 8 9 10 1 12
Weekedays Weekedays Weekedays Weekedays Weekedays
13 14 15 16 17 18 19
Weekedays Weekedays Weekedays Weekedays Weekedays
20 21 22 23 24 25 26
Weekedays Weekedays Weekedays Weekedays Weekedays
27 23 29 30 k)|
Weekedays Weekedays Weekedays Weekedays
Figure 1-34

Tip:
1. You can drag the created plan on the left of the Schedule dialog box to the calendar on the right
and the plan will be applied to the date.

2. To edit the schedule timeline, simply double-click the plan in the calendar.

1.8.2 Creating a Schedule Manually

1. In the Schedule dialog box, click Plan and click Add.
2. Type a name for the plan and click OK.
3. Click Schedule and select an option below:

B Edit Special Day: Applies the schedule plan to a specific date each year. Select a Date and a
Plan and click the Add button.

B Edit Weekly: Applies the schedule plan to the selected days each week.

B Edit Monthly: Applies the schedule plan to a specific date each month. Select a Day of the
month and a Plan, and click the Add button.

4. Double-click the Plan to edit the schedule timeline. Refer to Creating a Schedule with Setup

Wizard earlier in this section for details.
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1.8.3 Exporting and Importing Schedule Settings

Schedule settings can be exported into an .xml file, and imported back later or to another GV-VMS.
1. In the Schedule dialog box, click Schedule and click Export or Import. A dialog box appears.
2. Specify the path to save the .xml file. Or, specify where the exported .xml file has been stored.

3. Click OK.

1.9 System Log

The System Log provides historical information that can help you track events, system problems and

object counting data.

1.9.1 Setting up System Log

In the System Log Setting, you can specify which events to record, the interval time to write the event
into the system, and the number of days to keep the logs for. Click ViewLog n=h > Toolbar k& >

Configure # > System Log Setting. This dialog box appears.

System Log Setting ﬁ

Manitor Event Counter Event Delete Motifi
General Event Merge CMS
Login/Logout Event Backup Playback

4 | n | 3
Interval of Motion Event: 30 Sec.

Interval of Input Event: 30 Sec.

Always Keep Live Log

Import Previous Days of Live Log Browser: 2
[ Keep Days: a0 ()
Recycle ﬁ @

Log Path
Available: 2.20 GB

CAGVVYMS ’:]

Database Type ll Ok ” Cancel l

Figure 1-35
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Select the types of event to register in the System Log:

B Monitor Event: Registers motion-triggered and I/O-triggered events. For this feature to work, you
must enable the Register Motion Event option in Figure 1-10 or the Register Input Event option
in Figure 6-10.

B General Event: Registers system startup/exit, network server start/stop, and monitoring
start/stop.

B Login/Logout Event: Registers login/logout activities of local users to GV-VMS and WebCam

Server.

Counter Event: Registers counting results.

Merge: Registers the merging of recorded videos.

Backup: Registers the backup of recorded videos.

Delete: Registers the deletion of recorded videos through remote connection.

CMS: Registers the events of central monitoring services.

Playback: Registers playback of recorded videos.

Notification: Registers e-mail notifications.

The following settings are also available:

B Interval of Motion Event: Specify the log interval between motion-triggered events, which
prevents the system to record events too frequently when motion triggers are intensive.

B Interval of Input Event: Specify the log interval between input-triggered events, which prevents
the system to record events too frequently when input triggers are intensive.

B Always Keep Live Log: Display the latest logs in the System Log tables (see Viewing System
Log later in this chapter). When not selected, the logs of the time selected in the ViewLog timeline
will be displayed if available.

B Import Previous Days of Live Log Browser: Specify how many days of data to be loaded into
the System Log.

Keep Days: Set the number of days to keep the logs.
Recycle: Enable the system to delete old log files to make space for newer files when the space
of assigned Log Path is below 500 MB.

B | og Path: Specify a storage path for the logs. By default, it is at :\GV folder\. The available free
space of the storage path will be displayed.

B Database Type: Select Microsoft Office Access Database or Microsoft SQL Server as a

database, and fill out the required connection information.
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1.9.2 Viewing System Log

To view the System Log, click ViewLog IEI > Toolbar 4l > Tools D > System Log. The
following options are available: Monitor Table, CMS Table, and Advanced.

Monitor Table

Local events on GV-VMS are displayed.

Monitor Tab

Monitor | System | Login | Courter | Merge | Backup | Delete | Notfication | 110 | Playback |

Time Device Information Event Mote
12/312014 11:58:41 Cameral Motion
12/312014 11:59:26 Camera’ Motion
121302014 11:59:45 Camerad Camera Connecti...
12312014 11:59:46 Camerad Camera Connecti...
12/312014 12:00:05 Cameral Motion
12/312014 12:00:49 Cameral Motion
12312014 12:01:21 Cameral Motion

Figure 1-36

[Monitor] Shows events related to camera connection and motion. Double-clicking an event will allow
you to view the related video (if available) in ViewLog.

[System] Shows system startup/exit, network server start/stop, monitoring start/stop, and other setting
changes.

[Login] Shows whom and when has logged in and out of GV-VMS and WebCam server.

[Counter] Shows the information and results of GV-VMS'’s counter functions.

[Merge] Shows the merging events of recorded videos.

[Backup] Shows the backup events of recorded videos.

[Delete] Shows the deletion of recorded videos through remote connection.

[Notification] Shows e-mail notifications.

[1/0] Shows the events related to I/O trigger.

[Playback] Shows the playback of recorded videos.
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CMS Table

CMS Table shows the connection status, login activities and service start related to CMS.

CMS Table

CMS

Time UserlD Event Senice IP Address

THOZ014 10:32:38 Start Service Remote ViewlLog

TH02014 10:32:38 Start Service Bandwidth Contral

THU2014 210:02 Start Service Remaote ViewlLog

T12014 210:04 Stant Service Bandwidth Contral

T2014 21223 Stant Service Control Center

THU2014 21237 Start Service Remaote Desktop

THAN2014 21238 Stop Semvice All Semvices

TH12014 2:12:58 Login Failed Access Control 192 168.5.77

Figure 1-37

Advanced Log Browser

See Advanced Log Browser in Chapter 4.
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1.10 Other Functions

1.10.1 Popping up Live View

To pop up live view upon events, click Home 4 > Toolbar kil > Configure £ > camera Popup
Setting. This dialog box appears.

Camera Popup Setting ﬁ

Dweell Time: 3 Sec.

Interrupt Interval: 1 Sec.

[ camera Motion Invoke

[C] cameraz2
Camera4

Input Invoke

Inputl
Input Invoke

|Camera2 -

o [ o

Figure 1-38

Dwell Time: Specify the amount of time a popup live video to remain in the foreground.
Interrupt Interval: Specify the interval between live video popups. This feature is useful when
several cameras are activated for a popup alert at the same time.

B Camera Motion Invoke: Select the camera to enable auto popup upon motion detection.
Monitoring of the camera is required.

B Input Invoke: Select an input module using the drop-down list and select the input number using
the arrow buttons. Select Input Invoke and assign a camera to the input device. Whenever the

input is triggered, the live video of the assigned camera will pop up. I/O monitoring is required.

Note: You can use the Mask Region function in the Advanced Motion Detection Setup dialog box

(Figure 1-10) to mask off certain areas of the camera image that you don’t want to detect motion.

52



Configuring Main System

1.10.2 Adjusting to Daylight Saving Time

GV-VMS can automatically adjust to Daylight Saving Time (DST). If you are in a time zone that uses
DST, make sure DST is enabled. In Windows’ Control Panel, go to Date and Time, click Change Time

Zone, and make sure Automatically adjust clock for Daylight Saving Time is selected.

In the System Log, DST events are labeled with clock icons¥? in the Time column.

Monitor Table

Monitor | System | Login | Counter | Merge | Backup | Delete | Notfication | 110 | Playback |
Time Device Information ~ Event Note Z
11/1/2015 1:06:48 Camera 14 Motion
11/1/2015 1:06:50 Camera 14 Motion
11/1/2015 1:06:58 Camera 14 Motion
Figure 1-39

In ViewLog, click the Camera Date Viewer and click Search Event in DST.

(S g |
Camera Date Viewer X

4 July, 2014 Search event in DST
Sun Mon Tue Wed Thu Fri Sat

« = 711112014 == , 13 14 15 16 17 18 19

Cameral 20 21 22 23 24 25 26

Layout Cameras 27 28 29 30 31

00:00:00 | (@) @ » ) | %

Figure 1-40

Note: Videos recorded during DST periods start with “GvDST”, e.g. GvDST20140722.avi, to
differentiate from regular video files that start with “Event”, e.g. Event20081022.avi.
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1.10.3 Setting up Network Failure Detection

The Network Failure Detection function triggers an output device when the network connection

between GV-VMS and the specified network host has failed.

1. Click Home &4 > Toolbar k&l > Network &8 > Network Failure Detection. This dialog box

appears.
Reference IP:
Interval: 5 Min.
Action

[] output Module:

[Mod.1  ~|[pin.1 -

[] Reqister Event

Figure 1-41

2. Under IP Address, type the IP address or domain name of the remote host.

3. Next to Interval, type the time interval between each ping in minutes ranging from 1 to 999. If the
interval is 5 minutes, GV-VMS will ping the network host every 5 minutes to check if the

connection is still active.
4. Under Action, enable Output Module and select the output module and pin number.
5. Enable Register Event to record errors to the System Log.

6. Click OK.

The selected output device will be triggered when the network host does not respond to GV-VMS’s

ping message.
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1.11 PTZ Camera

With the PTZ control panel, you can control PTZ functions, e.g. pan, tilt, zoom, focus and preset points.

1. Move the cursor to the camera live view of a connected PTZ camera and click Tools 7%.

Set to Wave Out

PTZ Control

Properties

Close

Figure 1-42
2. Click PTZ Control to enable PTZ function.
3. You can control GV-IP Speed Domes using the following actions:
B Double-Click: The camera will center on the spot you clicked.
B Drag: You can select Random Move or Center Move after right-clicking the live view.

©® Random Move: Drag a line on the live view and the camera will move toward the

direction you dragged.

® Center Move: Drag a box on the live view and the camera will zoom in on the area you

dragged.

Tip: Alternatively, you can disable the PTZ functions of a PTZ camera by right-clicking it on the IP

Device Setup page and selecting the Disable PTZ Operation option.

o D Status  Server address Port Video Resolution
1 [ ] 192.168.4.236 10000 4000X3000(H264) | 1024X768(H2¢
n Remote camera setting
./ I Disable PTZ Operation I
>

Select PPTZ Camera
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1.11.1 Accessing PTZ Control Panel and Auto Functions

After PTZ Control is enabled, move the cursor to the live view to see the PTZ control panel. Note that

the PTZ control panel is hidden when live view resolution is less than 240 x 180.

Note: From GV-VMS V16.10.3, ONVIF PTZ cameras no longer supports Iris Open / Close function

on the PTZ control panel.

Cameral4

Zoom In / Out
Home
Focus In / Out

Figure 1-43

In the PTZ control panel, click Home M {0 access the advanced PTZ functions below. The options
available may differ depending on the model of your PTZ camera.

B Home: Returns the camera to Home position.

B Iris Open / Close: Adjusts the camera iris. The iris Control buttons are only available for GV-IP

Speed Dome.
B Auto Focus: Adjusts the camera focus according to the subject.
B Auto Iris: Adjusts the iris opening according to amount of light in the environment.

B Auto Go: Allows you to enable Cruise, AutoPan, Auto Tracking, Sequence and Tour functions.

You can click Stop Auto Go to stop the Auto function you have enabled.
B Auto Set: Allows you to set up AutoPan and Cruise functions. See the section below for details.
B Preset Go: Moves the PTZ to a preset point by clicking the preset number.

B Preset Set: Allows you to configure up to 256 PTZ preset points. Move the camera to the position

where you want set a preset point and then select a preset point number here.
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Auto Pan

The PTZ camera will continuously move between two horizontal positions. You can configure up to 8

sets of Auto Pan mode.

1.  Move the camera to the start position of the AutoPan.

2. To mark the start position, click the Home button ft in the PTZ Control Panel, select Auto Set,
and select Start AutoPan1.
3. Move the camera to the end position of the AutoPan. Any movement in the vertical direction will

not be included in the AutoPan.

1t

4. To mark the end position, click the Home button , select Auto Set, and select End AutoPanl.

5. To create another Auto Pan mode, repeat the steps above using a different Auto Pan number.

To enable the AutoPan, click the Home button ft , select Auto Go, and select the AutoPan number

created. To stop the AutoPan, simply click a Pan/Tilt button in the PTZ Control Panel to interrupt the

1t

AutoPan, or you can click the Home button , select Auto Go, and select Stop Auto Go Function.

Cruise

You can set up a route consisting of different directions, angles, and zooms for the PTZ camera to

follow. Up to 4 Cruises can be created.

1.  Move the camera to the start position of the Cruise.

2. To mark the start position, click the Home button ft in the PTZ Control Panel, select Auto Set,
and select Set Cruise 1.

3. Move the camera according to how you want the camera to move during the Cruise. The camera
positions, zooms, and speed of the movement will all be recorded for the Cruise. .

1t

4. When you are finished with setting up the Cruise, click the Home button , select Auto Set,

and select Set Cruise Stop.

5. To set up another Cruise route, repeat the steps above and select a different Cruise number.

ft , select Auto Go, and select the Cruise number

created. To stop the Cruise route, simply click a Pan/Tilt button in the PTZ Control Panel to interrupt
1t

To enable the Cruise route, click the Home button

the Cruise function, or you can click the Home button , select Auto Go, and select Stop Auto Go

Function.

57



Q GeoUision:

1.11.2 Setting up Ildle Protection and Advanced Functions

In the Content List, right-click the PTZ camera and select PTZ Setup. This dialog box appears.

PTZ Configuration @

Model
Camera Name Camera20
Model Mame Geovision_PelcoD
PT Speed [4 ,]
Advance [ Setup ]

Idle Protection

[V|Enable
Idle Time(Sec.) [30sec 7
@ Preset [Preseﬂ 'l
) Auto Go Cruise 1
) Multiple Position Tour Setup
) Schedule Setup

[ OK l [ Cancel ]

Figure 1-44
B PT Speed: Adjusts the speed of pan and tilt movements.

B Advanced: Click Setup to access advanced functions, such as image attributes, sequence, tour

and Home position. Consult the manual of the connected PTZ model for details.

[Idle Protection]

When the PTZ camera remains stationary for a certain period of time, the PTZ can automatically move

to a Preset Point, enable an Auto function, begin a Multi Position Tour or start the PTZ schedule.
1. Click Enable.

2. Setthe ldle Time. The PTZ camera will follow the action selected in the next step after the idle

time exceeds the specified Idle Time.

3. Select Preset, Auto, Multi Position Tour or Schedule as protection mode. See Setting up Multi

Position Tour below.

4. Click OK.
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You can create a PTZ tour with up to 64 preset points. Note the number of preset points depends on

your PTZ capacity.

1. Select Multi Position Tour in the PTZ Configuration dialog box, and click the Setup button. This

dialog box appears.

| Multiple Position Tour E 1
I Tour Setting
Preset Preset5 -
Dwell Time (Sec.) 5 :

Add Remove
Ma. Preset Mo. Dwell Time (Sec.)
1 Preset1 5
2 Presets 5
3
Figure 1-45

2. Select a Preset as a starting point.

3. Set the Dwell Time that the PTZ will remain at each preset point.

4. Click Add and repeat Steps 2-3 to build more points in the tour.

1.12 QView

If there are multiple monitors connected, you can use the QView feature to display full-screen live view

of a camera on a separate monitor.

1. Click Home k—l > Toolbar n':l > Configure n’ > System Configure > Set Position. This

dialog box appears.

Set Position

Main Panel
Select Monitor
Monitor 1

Position:

[ w0 |, | 0

Panel Resolution:

| 1280 |x| 1024

ViewLog

Select Monitor
Equal Main Panel

Position:

1280 , 0

Panel Resolution:

1280 X 1024

QView
Select Monitor

Disable

Position:

| | ’

Panel Resolution:

Figure 1-46
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2. Inthe QView section, select a desired monitor from the Select Monitor drop-down list to open a

full-monitor display and click OK.
3. Double-click a camera view on the live view grid. The camera view is now displayed in full screen
on the designated monitor.

4. To switch another live view to a full-monitor display, simply double-click another camera view.

To record short video clips on a full-monitor display, see Creating a Storyline in QView later in this

chapter.

1.13 Storyline

With the Storyline feature, you can combine camera images from multiple channels into a sequence of
short video clips of a specific incident, such as gambling fraud, shoplifting and other fraudulent
activities. The recorded videos can be saved and played back later using a media player. This feature

is available in live view, video playback and QView display.

1.13.1 Creating a Storyline in Live View

First, drag the Zoom Window to a live view grid. Any camera views on the Zoom Window will be

recorded as a storyline.

1. Set up the screen division with the camera channels of interest.

2. In the Content List, select Layout, click Windows and drag Zoom Window to a live view grid.

3. To display a live view on the Zoom Window for recording, click the Zoom button in the
top-right corner of a camera view.

4. On the Zoom Window, click the Tools icon x> Storyline to start recording. The orange label

indicates that the recording is in progress.

Figure 1-47
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5. To record from another camera view, click the Zoom button of that camera view.
6. When you finish, deselect Storyline to stop recording. The Edit Description dialog box appears.

7. Type a name or description for the video clip and click OK.

Note:

1. The recording duration is limited to 30 minutes per storyline.

2. The resolution of storyline can be set to 1280 x 1024 (default) or 1920 x 1080. To change the
resolution, select Toolbar > Configure > System Configure > Record Setting and click the

down button next to Storyline.

StoryLine
v Keep Image Rafio

Resolution: [1280x1024 v

Path: | CGV-VMSICameraDBs\StonyLine\ im

Figure 1-48

1.13.2 Creating a Storyline in Video Playback

The procedures of creating a storyline with playback videos are si milar to those for the live view.

&7 il
1. Click ViewLog EZH > Toolbar E&3 > Content List ®™® and drag Zoom Window onto a
playback grid.
2. To display a video on the Zoom Window, click the Zoom button on the top right of a playback
video.
On the Zoom Window, click the Tools icon 74 > Storyline to start recording.

To record another video, click the Zoom button of that playback video.

1.13.3 Creating a Storyline in QView

1. Follow the instructions in QView earlier in this chapter to set up a full-monitor display.
2. On the designated monitor, click Tools x> Storyline to start recording.

3. To record the live video from another camera, simply double-click another camera view.
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1.13.4 Accessing a Storyline

After creating the storyline, select ViewLog > Toolbar |1 > Tools (N Story Line. Your
storyline will be listed in the window below.

Story Line X

Start Time Description Time Length File Path File Size
11972017 17:51:32 During working time 00:00:26 CAGV-YMS\CameraDBs\StoryLine\SLive20170109175132. mp4 4.05MB
1/9/2017 17:52:51 Office hour 1 00:00:10  CAGV-VMS\CameraDBs\StoryLineWLog20170109175251. mp4 863.79 KB
1/9/2017 17:55:16 Office hour 2 00:01:40  CAGVW-VMS\CameraDBs\StoryLineWLog20170109175516.mp4 12,48 MB

Free Disk Space76.26 GB % ﬁ

Figure 1-49

Right-click a storyline on the list to access more features, such as playback, changing the file path and

editing the description. You can also use the Filter button & to search for the desired storylines.

1.14 GV-VR360 Dewarped View

GV-VMS provides two dewarped modes for GV-VR360 under Content List (Home n > Toolbar
> Content List “).

@ Content List

o
= GV-VR360

& VR 360 V1

& VR 360 V2

Figure 1-50
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B GV-VR360: The undewarped image of GV-VR360.
B VR 360 V1: Adewarped mode of GV-VR360 that allows manual control to view all angles of the

image. Click and hold on the image to adjust the angle of view and click to zoom in.

B VR 360 V2: A dewarped mode of GV-VR360 that automatically pans around the image 360°
endlessly. Click @ or to adjust the speed of the auto pan and click m to zoom in.

Camera2 - VR 360 V2

Figure 1-51

Note:

1. To view the dewarped image of GV-VR360 on GV-VMS, the graphic card must support DirectX
10.1 or above.

2. Upto 2 GV-VR360 can be connected to a GV-VMS with a total frame rate of 24 fps.
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2.1 Adding IP Cameras

There are several ways to connect IP devices to GV-VMS, and the procedures may vary depending on

the device. To access the IP Device Setup, click Home u > Toolbar lil > Configure >
Camera Install.

= 1P Device Setup ===

o D Status  Server address port Video Resolution Bitrate Brand settings
2 ) 192.168.6.79 10000 2502X1044(H265) [ 640X480(H264) 1939 / 118 kbps GeoVision_GV-BX5700 74
*

s | 3 ) 192.168.5.182 10000 1020X1080(H264) / 640X360(H264) 1999 / 384 kbps GeoVision_GV-C51320

Figure 2-1

® To manually set up an IP device, click Add Camera O
® To detect for IP devices on the LAN, click Scan Camera & .

® To detect for and automatically add multiple IP devices on the LAN, click Automatic Setup 'C;’.

® To import IP devices from GV-IP Device Utility, click Import Camera B-i=
® To map IP devices through GV-IP Device Utility, click IP Device Utility "-"".
® To license GV-VMS Pro and third-party cameras using software license, click GeoVision

License Activation Tool 59, and see the technical notice for instructions.

For details on Automatic Setup, see Adding Cameras in Chapter 1. For other methods, see the

sections below.
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Third-Party IP Devices

Aside from GV-IP devices, GV-VMS also supports third-parity IP devices, through ONVIF, RTSP
and/or PSIA.

In the event of unbaling to detect a third-party device through Scan Camera or Automatic Setup, the
device can be added through Manual Setup. See Connection through RTSP, ONVIF & PSIA later in
this chapter.

2.1.1 Adding Cameras Manually

1. To manually add IP devices, click Add Camera |§| in the IP Device Setup (Figure 2-1).
2. Type the IP address, username and password of the IP device. Modify the default HTTP port 80 if

necessary.

3. Select a camera brand and model name from the Brand and Device drop-down lists, respectively.

This dialog box appears.

GeoVision_GV-BX220D/BX2300_Series
Cluery

Dual Streams l l Cluery Status : Standby

Camera list
Select

Part
Port 10000

Stream Type

Codec Type

Resalution

Apply

Figure 2-2
4. Configure the options listed below, which may vary between camera brands.

B Dual Streams: GV-IP Cameras are set to dual streams by default. Select this option to apply
the dual-streaming settings (lower resolution for live view and higher resolution for recording) if

the camera supports dual streams.

B Query: Detect and apply the current codec and resolution setting on the camera. This function

may not be available for some third-party cameras.

B Camera list: Select a camera number.
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B Port: Modify the video streaming port of 10000 if necessary.

B Stream Type: You may have the option of Single Stream or Dual Streams depending on

camera models.

B Codec Type: You may have different codec options depending on camera models. If the
selected camera supports dual streaming, the live view codec and recording codec can be set

differently.
B Resolution: You may select the different resolutions for live view and recording.
Click Apply to add the IP camera to the IP Device List.

To connect the added camera, select the checkbox beside the ID column. The Status icon turns
green upon successful connection, with the video resolution and bit rate being displayed in the

correspondent columns.

] Status | Server address Port Wideo Resolution Bitrate Brand Setting
1 E 192,168.3.151 10000 1920%1080(H264) / 448¥252(H264) 6902/ 51 kbps Geovision_GV-BXS20D/BXS300_Series %
2 [ ] 192,166.6.15 10000 1920%1080(H264) | 448¥252(H264] 6854/ 137 kbps Geotision_GV-BX2200/8X2300_Series %
3 192,168.7.101 10000 Geoision_GV-BL1500 WA
Figure 2-3

To change the number of the camera, click the device’s ID and select a desired number. Note this

function is only available for disconnected cameras.

Note: The indication of status icons is as below.

Connected The camera is connected.
Connecting GV-VMS is trying to connect to the camera.
Connection Failed Unable to connect to the camera. Place the cursor on the red icon to

see the error message.

Inactive Camera The camera is inactive. Select the checkbox to connect to the
camera.

Started Monitoring The camera is under monitoring.

Pre-Rec Enabled Pre-recording is enabled.

Tips: You can access the camera’s own configuration interface by right-clicking the IP camera and

selecting Remote Camera Setting.
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2.1.2 Scanning for Cameras

1. To detect for IP devices on the LAN, click Scan Camera @ in the IP Device Setup (Figure 2-1).
The Scan Camera dialog box appears.

2. Click Start Scan. The IP devices detected are displayed.

3. Double-click the IP device you wish to connect to, type its username and password and click OK.

Figure 2-2 appears.

4. Click Apply. The IP camera is added to the IP Device List and automatically enabled for

connection.

2.1.3 Mapping GV-IP Cameras using GV-IP Device Utility

GV-IP Device Utility detects all available IP devices within the LAN and allows users to map detected
cameras to the specified channels. Users can then export the device list and import it into GV-VMS. In
addition, GV-IP Device Utility also lets users to quickly set IP addresses, upgrade firmware,

export/import device settings for and reboot IP devices.

Click IP Device Utility in the IP Device Setup (Figure 2-1). All the available IP cameras on the
LAN are detected and listed in the window.

== GV IP Device Utility
File  Tool

Qi 8T

General settings MVR camera settings I

HostMame | Camera ... | IP Address | Mac Addr. A g2ls|x Q‘; l’:‘
SRD-win7 Cameral 192.168.3.. 0026186...
SRD-win7  Camera2  192.168.3.. 0028186.. neR1 |
SRD-win?  Cameral 192.168.3.. 0026186.. Camer... | Host M... | Camer... | P Add.. | Mac A. L
test166-0f.. Cameral 192.168.0.. 00012971 1
test1G6-0f.. Camera2 192.168.0.. 0001291.. =
test1 66-0f.. Camerad 192168.0.. 0001391, 3
testt G6-0f. Camerad 182168.0 0001291 4
test1 66-0f.. Camerad 192.168.0.. 0001291.. 5
testt G6-0f. Cameraf 182168.0 0001291 [
test1 66-0f.. Camera? 192.168.0.. 0001291.. 7
test166-07.. Camerad 192.168.0.. 0001291 a
test1 G6-0f.. Camerad 192.168.0.. 0001291... q
Figure 2-4

To map IP cameras to the channels of GV-VMS, see 7. Assigning Camera Channels for

GV-DVR / NVR / VMS in GV-IP Device Utility Guide.
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2.1.4 Adding Cameras of Mobile Devices using GV-Live Streaming

Only supported by GV-VMS V17.4 or later, GV-Live Streaming is a paid mobile app that allows the
camera of your Android / iOS mobile device to connect and stream live view to GV-VMS via GV-Relay.

For details, see GV-Live Streaming Installation Guide.

2.2 Configuring Individual IP Cameras

To configure the IP camera settings such as video, audio and other general settings, click the Setup

button of the connected camera on the IP Device List.

= IP Device Setup
o D Status Server address Port Video Resolution Bitrate Brand Settings
1 192.168.2.101 10000 2048X1944(H264) 15440 kbps GeoVision_GV-FE420/FE4301_Series 54
6 (1] 192.168.5.168 10000 GeoVision_GV-5D220/GV-5D2300/GV-S...
' | 6 102.168.5.168 10000 GeoVision_GV-50220/GV-5D02300/GV-S...
e 2 192.168.4.26 10000 GeoVision_GV-UBX1301_Series
Figure 2-5
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2.2.1 Configuring Video Settings
You can configure video settings such as frame rate, codec type and resolution of the camera.
Settings X
i Video Setting £ Video Setting
o) Audio Setting
£+ General Setting General Setting Video Lost / Connection Lost
CameraName : | Camerall @ [ vrigger output
Mod. 1 v| |Pn1 v B
Camera Lens
&
General v
Video Attrbute
Stream Setting Brightness: ] 12
Main stream v :
Contrast: ] 128
Codec Selecton:  |H265 v
Saturaton: i 128
FPS: 2 v
Gop: |9 |ms(5~250) Sirpnede: ! =
?JBII(‘{ /Bitrate Gamma :
[OF:3
Defaut Save
Qualty:  Standard v
ax. Bitrate : > Image Orientation
— Max.Bitrate:  |5760 | Kbps (128 ~ 16384) oo GaTon @
) Normal Horizontal Mirror
Osmats Vertical Fip Rotate 180
e Rotate 270 Rotate 30

4] 1mage Orientation By Sofeware

> — : -
g B

|

Resolution
169 2
Main stream :  3840x2160 i
SubStream:  1280x720 -t

Figure 2-6

[Stream Setting] Select a stream from the drop-down list. Settings for Main Stream will be used for

recording. Live view can use either Main Stream or Sub Stream depending on the On Demand

settings. For details, see On Demand Display later in this chapter.

Codec Selection: Set the codec to MIPEG, H.264, or H.265.
FPS: Set the number of frames per second.

GOP: Set the number of seconds between each key frame. For example, when the FPS is set to

30, a GOP of 0.5 means there will be 1 key frame among every 15 frames.

Quality and Bitrate: When using the H.264 / H.265 codec, you can select between VBR and

CBR.

© VBR (Variable Bitrate): The quality of the video stream is kept as constant as possible at the
cost of a varying bitrate. Set the image quality to one of the 5 standards: Standard, Fair,
Good, Great and Excellent. Set a Max. Bitrate if needed, or select Auto if you do not want to

enable this function.
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® CBR (Constant Bitrate): CBR is used to achieve a set bitrate by varying the quality of the
H.264 / H.265 stream. Select one of the bitrates from the drop-down list.

B Smart Streaming:

© Static Scene: Set the image quality to one of the 5 standards: Standard, Fair, Good, Great
and Excellent. Set a Max. Bitrate if needed.

® Dynamic Scene: Set the image quality to one of the 5 standards: Standard, Fair, Good,
Great and Excellent. Set a Max. Bitrate if needed.

© Bitrate Reduction Level: The bigger the value the more bitrates can be reduced in static

scenes, thus saving the recording size.

B Resolution Change the display ratio and resolution.

[Video Lost / Connection Lost]

B Trigger Output: Trigger the specified output module upon video lost or connection lost until the
output device is manually turned off. To configure the output device, see 1/0O Device Setup in
Chapter 6.
® Right-Arrow button: Set the counting time between 0 and 1000 seconds to delay the

activation of the specified output module.

[Camera Lens] Select Wide Angle if you want to correct warping toward the edge of the camera

image. For details, see Wide Angle Lens Dewarping in Chapter 3.

If you are using third-party fisheye cameras, select IMV1 Panorama for cameras installed with an
ImmerVision IMV1 Panorama Lens, and select Fisheye for other third-party fisheye cameras. For

details, see Setting up a Third-Party Fisheye Camera in Chapter 3.

[Video Attribute] Adjust video characteristics, such as brightness, contrast, saturation, sharpness and

gamma.

[Image Orientation] Adjust the image orientation by selecting Normal, Horizontal Mirror, Vertical
Flip, Rotate 180, Rotate 90 and Rotate 270 (Corridor format). Check Image Orientation by

Software for GV-VMS to perform the function; otherwise, it's performed by the IP camera.
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Note:

1. Changes made to the Video Setting page will change the settings on the IP camera.

2. When the image orientation is performed by the IP camera, the options for Rotate 90 and Rotate

270 (Corridor format) are only available for GV-IP Cameras that support the function.

3. When over 32 channels are connected, the sub stream frame rate will be automatically set to 15
and GOP set to 30.

2.2.2 Configuring Audio Settings

On the Audio Setting page, you can adjust audio devices and listen to live sound.

Settings

Hf Video Setting
o) Audio Setting
£t General Setting

(43 Audio Setting

Audio setting

Audio Gain
U
Wave Qut

[¥] Wave Out

Rec Audio

[¥]Rec Audio
By Sensitivity
9 Round-the-Clock Audio

Audio Format

| 16 KHz, 16 bit

B Audio Gain: Increase or decrease the gain of the microphone.

B Wave Out: Select to listen to the audio around the camera.

Figure 2-7

B Denoise: Select to reduce audio noise.

B Rec Audio: Select Rec Audio to record the audio around the camera.

®© By sensitivity: Audio recording is activated when the volume reaches the sensitivity level

indicated.
® Round-the-Clock Audio: Audio recording is continuously enabled.

B Audio Format: Select an audio format from the drop-down list. The default is 16 KHz, 16 bit.
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You can configure the general settings, such as for video recording.

Settings

[ Video Setting
o) Audio Setting
#% General Setting

# General Setting

E Network Time Out
45 Second e

Cadhing

[ Frames to keep in ive view buffer
B0 v

E On Demand Dispiay

(@) Enable L2x
O Disable

|88 Recording codec format

(O standard codec (®) Geovision codec

E Automaticaly adjust DST

(OEnable (®) Disable

[ video Lost / Connection Lost
] Invoke Alarm

[ video Lost / Connecton Lost

[CInotification

[ MessageBox etting

[CInetwork Congestion

Set codec and resolution sutomatically

Frame rate control for e view decodng
Live view frame rate control (Main stream)

(®) Madmum live-view frame rate, () Live-view key frame only.

Live view frame rate control (Sub stream)

(®) Maimum live-view frame rate, (D) Live-view key frame only.

Recording frame rate control
Urgent Event

(® Maximum record frame rate. () Record key frame only,

General Event

(C)Maimum record frame rate.  (®) Record key frame only.

Reboot IP Camera via POE Switch

Metwork Adapter : | [P[192.168.5.75] Quakcomm Atheros ARB151

Port: | 15000

POE Switch ID : ‘adr'nn

POE Switch Password : | ®®eee

[ set codec and resclution automatically 5can Device Reboot
[@ s device tme with PC Set sub stream frame rate to all cameras
NO v 10FPg ~
==

Figure 2-8
B Network Time Out: When network disconnection exceeds the specified time period, the status

icon on the IP Device List (Figure 2-1) becomes yellow.

B Live View Decode Postpone Time (Caching): Specify the number of milliseconds to postpone
live view decoding. When the network connection with the IP device is unstable or when the time
length between frames is not evenly distributed, postponing the live view decoding will make the
video smoother. Note this function is only available for configuration when the camera is

disconnected.

B Frames to Keep in Live View Buffer: Specify the number of frames to keep in the live view buffer.
When CPU performance is insufficient, you can reduce the number of frames kept in buffer to
achieve a real-time appearance by dropping frames. This setting does not affect the frame rate of

the recorded videos.

B On Demand Display: Enable automatic adjustment of live view resolution. For details, see On

Demand Display later in this chapter.

B Recording Codec Format: Specify whether to record in standard or GeoVision codec.
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Automatically Adjust DST: When enabled, the time on the GV-IP Device Web interface will be
synchronized with the time of GV-VMS when DST period starts or ends on GV-VMS.

Video Lost / Connection Lost (Invoke Alarm): Enable if you want to trigger an alarm sound

upon connection lost. Click the Arrow button to select a sound.

Video Lost / Connection Lost (Notification): Enable if you want to send an e-mail notification

upon connection lost. See Setting up E-mail Notifications in Chapter 1 to set up the e-mail server.

Message Box Setting: When enabled, the Network Congestion message will pop up under such

a condition.

Set Codec and Resolution Automatically: If enabled, GV-VMS will resume the configured

codec and resolution when it detects the changes made by the camera.

Sync device time with PC: Disabled by default, GV-VMS’s system time will be synced to the

camera once connected and to be re-synched after the specified time period.

Live View Decode Frame Control (Main / Sub Stream): Set the live view frame rate for main

stream and sub stream.

® When using MIPEG, every frame is a key frame, so the options of Max. frame and Key only

are grayed out.

® When using H.264 / H.265, only one key frame is transmitted per the specified number of
frames, so you can select Key only to decode key frames only and omit all intermediate

frames or Max. frame to include all frames.

Recording Frame Rate Control: Set the recording frame rate for Urgent Event and General
Event. This function allows you to set different recording frame rates for motion, non-motion and

other alarm events. See Setting up Recording Settings for Individual Cameras in Chapter 1.

® When using MIPEG, every frame is a key frame, so the options of Max. frame and Key only
are grayed out. You can specify the recording frame rate for Urgent Event and General

Event respectively.

® When using H.264 / H.265, only one key frame is transmitted per the specified number of
frames. You can select Max. frame for Urgent event and select Key only for General event.
POE Switch Reboots IP Camera: Restart a specified camera via its connected GV-POE Switch

with the functionality of Web management. Type the ID and PW of the switch to start rebooting.

Set sub stream frame rate to all cameras: When connected to over 32 channels, GV-VMS
automatically adjusts the sub stream frame rate of all cameras to 15 fps. Select from the

drop-down list to manually adjust the sub stream frame rate for all cameras at once.
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2.3 Connection through RTSP, ONVIF & PSIA

To add IP devices compliant with RTSP, ONVIF or PSIA to GV-VMS, follow the steps below.

1. To add through the abovementioned protocols, click Home M > Toolbar k&l > Configure
'o' > Camera Install.

2. Click Add Camera @ to manually add an IP camera. The dialog box appears.
3. Type the IP address, username and password of the IP camera. Modify the default HTTP port if

necessary.
4. Select Protocol from the Brand drop-down list.

5. Select the protocol that is supported by your IP camera from the Device drop-down list.

Select Brand gl
Server |P | 192.168.4.109 v|
HTTP Part - | 80 |

User narme | adrmin |

Password | enne |

Brand : |F‘r0t0c:0| V|

Device | |Please select the brand of IP camera

e select the brand of IP camera
GeoVision_GY-HTTP_SDK
Geovision_GV-HTTP_SDK_RTSP
Please check all fields 4 QnwIF
PS5l
RTSF aver HTTF
RTSP over TGP
RTSF aver UDF

hMessage :

Figure 2-9
B GV_HTTP_SDK: For SDK users only. The RTSP protocol uses a HTTP port for data

streaming from the IP camera.

B GV _HTTP_SDK_RTSP: For SDK users only. The RTSP protocol uses a HTTP port for data

streaming from the IP camera.
B ONVIF: This option is for connecting the camera using ONVIF standards.
B PSIA: This option is for connecting the camera using PSIA standards.

B RTSP over HTTP: The RTSP protocol uses a HTTP port for data streaming from the IP

camera.
B RTSP over TCP: The RTSP protocol uses a TCP port for data streaming from the IP camera.

B RTSP over UDP: The RTSP protocol uses an UDP port for data streaming from the IP

camera.
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6. If you select ONVIF, this dialog box appears after the system confirms that the camera is ONVIF

compatible. Click Dual Stream to enable the second stream if needed, and click the Setting

button L] next to Stream1 and Stream 2 to adjust the following information.

¥ ~
Profile Select S5 VE Default ‘ 5
Single Stream © Dual Stream
I Codec : H254 w
Stream1: profile_Default - Resolution : 320 x 240 v
»
>
Stream2 : profile2_Default - Quality a1
FramRate : 10
‘ Bitrate {kbps) : 2194
Stream? ‘ ez 32
Codec : H264 Codec : H264
Resolution : 1920 x 1080 Resolution : 448 x 252
t Apply [ Cancel
Quality : 2.000000 Quality : 2.000000
Frame rate : 30 Frame rate : 60
Gov: 30 Gov : 30
Advance oK Cancel
& = — ——
Figure 2-10

B Codec: Select H.264 or JPEG.

B Resolution: Set a resolution.

B Quality: Adjust the image quality. The range of image quality varies for different brands.

B Frame Rate: Set a maximum frame rate. The range of frame rate varies for different brands.

B Bitrate: The current bit rate setting of the IP device will be displayed. You can adjust the bit

rate limit within the device’s supported bit rate range if needed.

B  GOV: Set the number of frames between each key frame. For example, a GOV of 10 means

there will be 1 key frame every 10 frames.

7. Ifyou select PSIA, a dialog box appears after the system confirms that the camera is PSIA

compatible. Click Apply.

8. If you select RTSP, select Dual Streams to enable the Sub Stream if needed and type the RTSP

link address.

For the RTSP command, consult the documentation of your IP camera. For instance:

e For an AXIS IP camera, type RTSP://<IP of the IP camera>/<codec>/media.amp

e For a HIKVISION IP camera, type RTSP://username:password@<IP of the IP Camera>

9. Click OK to add the IP camera to the IP Device List.
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2.4 On Demand Display

IP Camera Setup

For cameras that support dual streaming with different resolutions, you can select the On Demand

Display option to enable automatic adjustment of live view resolution. This option produces good

image quality without causing high CPU usage.

You will need to set a value of X times the resolution of the sub stream as the threshold. When the

camera image on the screen is bigger than the threshold, the system will switch to the higher

resolution streaming, usually the main stream. Such adjustment is enabled when using the view

modes that require higher quality images, such as single view or PIP / PAP mode. The system will

switch to the lower resolution streaming to reduce CPU usage when watching live view in view modes

where higher resolution does not make a difference, such as highly divided divisions.

1. Make sure the IP camera has been added to GV-VMS and you have selected Dual Stream during

setup. For details, see Adding IP Cameras earlier in this chapter.

2. In the IP Device Setup (Figure 2-1), click the Setup button 74 of the desired connected camera

within the IP Device List and select General Setting.

3. Inthe On Demand Display field, click Enable and select a value. When the camera image on the

screen is X times bigger than the resolution of sub stream, the system will switch to the higher

resolution streaming.

Settings

B Video Setting
L d Audio Setting
L. ¥ General Setting

#+ General Setting

[ Metwork Time Out

45 Second A

Postpone live view decoding

Frames to keep in live view buffer

On Demand Display
(@ Enable

() Disable

Figure 2-11

Note:

1.  The On Demand Display function is not supported for Privacy Mask.

2. The On Demand Display function is not supported by GV-Fisheye cameras
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Application Example

The resolution of sub stream is 640 x 480, and a value of 1.2 times the resolution of the sub stream
has been selected for the On Demand Display function.

e Higher Resolution Streaming

1152 x 540 > 1.2 x 640 x 480,
higher resolution streaming will be used

Figure 2-12

The camera image in the middle has a resolution of 1152 x 540, so the higher resolution streaming
will be used, because 1152 x 540 is bigger than 1.2 x 640 x 480.

e Lower Resolution Streaming

640 x 360 < 1.2 x 640 x 480,
lower resolution streaming will be used

Figure 2-13

After switching to 9-channel screen division, the resolution for each channel is 640 x 360, which is

smaller than 1.2 x 640 x 480, so the lower resolution streaming will be used.
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Video Analysis

3.1 Object Counting and Intrusion Alarm

Object Counting provides bi-directional counting of objects under the surveillance area. It can count
any moving objects (such as vehicles), people or animals. Intrusion alarm can be set to send

notifications when an object moves into the defined region.

Note: It is not recommended to apply the counter function to Fisheye cameras.

3.1.1 Object Counting

You can select up to 16 cameras to set up Object Counting.

e

1. Click Home LS4 > Toolbar |-© > Configure ® > Video process. The Setup dialog box
appears.
2. From the Video Analysis drop-down list, select Counter/Intrusion Alarm Setting, select the

desired cameras and click Setting. This page appears.

Setup x

Counter  Alam

Choose Camera
Counter-1/Intrusion Alarm

Setting
HEnable Setting

@ Define Detection Zones

=
XEM o
O Define Object Size
(@) @
Test Count Counting Result
Sensitivity Test In: 0
3 ' out 0
Door Demo v
Option
[4 show Alarm Regions [FResetAlert
[ skip Frame ] ©[% | minute
O 1 Hour
Demo
=
Figure 3-1
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3. Select a desired camera under Choose Camera and select Enable Setting to define the counter.
B Define Detection Zones: Select this option to define the detection zones.

a. On the live view, draw at least two boxes to mark the in and out detection zones.

Each detection zone is numbered. Use these buttons to edit the detection zones:

Name Button | Function

Reverse Flips the detection zone.

Switch E Switches to another detection zone.

Delete B] Deletes the detection zone.

Direction Configures the in and out directions. See Step 3-b.

b. Click the button to define the in and out criteria. This dialog box appears.

Direction, Setting g|
Select Detection Zone Set Direction
@ In
0 - = 1 -
" Out
Detection Zones | Direckion
0--=1 In
1--=0 Cuk
Figure 3-2

c. Select In/Out under Set Direction and define the direction in Select Detection Zone.
d. Click Add. The setting is added and appears in the table below.

e. Click OK. The directions are added and indicated by arrows on the live view.

B Define Object Size: Select this option and click @ to pause the live view.
Outline a size matching that of targeted objects on the live view. Click % to resume.

4. To test your counting settings, select Live from the Test Count drop-down list and click the Test
button to start testing. The number in Counting Result should change as objects move through
the detection zone. Optionally use the Sensitivity slider to adjust detection sensitivity as needed.

5. Click OK to apply the settings.

6. Start monitoring to begin counting. The counted objects, people or animals are indicated on the

live view with yellow boxes.
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More options in the Counter dialog box:
B Show Alarm Regions: Displays the detection zones on the preview image.

B Skip Frame: Skips frames to lower the CPU loading, where the system only counts objects

every three frames. This option may reduce the accuracy of counting result.

B Reset Alert: Specify a time interval, between 1 and 1440 minutes, to reset the recorded

counting result in the System Log.

Note:

1. Draw the detection zones as closely as possible to avoid omission of counting when target

objects show up in the unmarked area and move only through one of the two boundaries.

1%¢

Figure 3-3
2. Toinclude counting results in the recorded files, see Setting up Text Overlay later in this

chapter.

3.  To view the logs for counter events, click View Log, Toolbar, Tools, System Log, Monitor

Table and click the Counter tab.

4. Optionally create a schedule for counter to be enabled only at the time periods specified. For

details, see Creating Schedules in Chapter 1.
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3.1.2 Intrusion Alarm

Up to 16 cameras can be set up for Intrusion Alarm.

1. To set Intrusion Alarm for object(s) entering a defined region Click Home |24 > Toolbar >
Configure ® > Video process. The Setup dialog box appears.
2. Select Counter/Intrusion Alarm Setting in Video Analysis, select the desired camera, click

Setting and click the Alarm tab. This dialog box appears.

| Counter ‘ Alarm I

Choose Camera

lCameraS v/
Setting
Enable Setting
(® Define Detection Zones
EBXEN o

(O Define Ohject Size

Alarm Mode 1 ;\ @

Option
[¥] Show Alarm Regions [CJinvoke Alarm :
[ skip Frame (@) [JoutputMadule :

[[1Never Recycle @

Figure 3-4
3. Select a desired camera under Choose Camera and select Enable Setting to define the
intrusion alarm.
B Define Detection Zones: Select this option to define the detection zones.

a. On the live view, draw at least two boxes to mark the in and out detection zones.

Each detection zone is numbered. Use these buttons to edit the detection zones:

Name Button | Function

Reverse Flips the detection zone.

Switch E Switches to another detection zone.

Delete @] Deletes the detection zone.

Direction Configures the in and out directions. See Step 3-b.
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b. Click the button to define the alarm criteria. This dialog box appears.

C.

d.

e.

Direction Setting E|
Select Detection Zane Set Directian
o R
'E‘ . m + 1 Direction
" 2 Direction
Detection Zones | Direction
0--=1 1 Direckion
Add Delete | oK
Figure 3-5

Select 1 Direction or 2 Direction under Set Direction and define the direction in Select

Detection Zone.
Click Add. The setting is added and appears in the table below.

Click OK. The directions are indicated by arrows on the live view.

B Define Object Size: Select this option and click .| pause the live view.

Outline a size matching that of targeted objects on the live view. Click % to resume.

B Define Image Depth: When the object moves toward or away from the camera along a path,

for example, a hallway, it appears larger when it is closer to the camera and vice versa.

Rather than using a fixed object size, you can define a maximum and minimum object size

according to the object’s proximity to the camera.

a.

Figure 3-6

Select Define Image Depth and select With Image Depth using the drop-down list. A
line & & appears.
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b. Drag and place the line along the path where the objects will be moving. The larger icon

indicates the point closer to the camera.

c. Select Define Object Size. Click the larger icon & and click @ to pause the live

view. Use the mouse to outline the maximum size of objects on the live view.
d. Click the smaller icon ﬂ and repeat the step above to define the minimum size of
objects when they are further from the camera.
4. In the Setting section, there are two kinds of alarm modes:

B Alarm Mode 1: The alarm sets off when the target object moves through the first detection

zone and touches the second detection zone in the defined direction.

B Alarm Mode 2: The alarm sets off when the target object moves through the first detection

zone and its center moves through the second detection zone in the defined direction.
5. To set up alarm devices, configure any or both of the following options.

B Invoke Alarm: Enable the computer alarm when an object enters the defined region. Click

the button next to the option to assign a .wav sound file.

B Output Module: Enable an installed output device when an object enters the defined region.

Assign the output module and pin number.

6. To test your alarm settings, select Live from the Test Count drop-down list and click Test. When
intrusion objects are detected, the configured computer alarm or output device will be activated.

Optionally adjust the Sensitivity slider as needed.
7. Click OK to apply the setting.

8. Enable monitoring to start intrusion detection. The detected intruding objects are indicated on the

live view with red boxes.

When an intrusion event occurs, the configured computer alarm or output device will be activated, and

the event will be recorded as Intruder in the System Log for later retrieval
More options in the Alarm dialog box:

B Show Alarm Regions and Skip Frame: See the same options in Object Counting above.

B Never Recycle: Alarm-triggered events will never be recycled if selected.
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Note:

1. Draw the detection zones as closely as possible to avoid omission of intrusion events when

target objects show up in the unmarked area and only move through one of the two boundaries.

Figure 3-7

2. To view the logs for intrusion events, click View Log, Toolbar, Tools, System Log, Monitor
Table and click the Monitor tab.

3. Optionally create a schedule for intrusion alarm to be enabled only at the time periods specified.

See Creating Schedules in Chapter 1.

3.2 Object Index

The Object Index feature allows you to view the very first frame of a continuous movement in a video
stream. With Object Index Live Viewer, you may view the most recent 50 frames captured. When
accessing Object Index in ViewLog, you can easily locate and play back events by selecting and

specifying the desired camera channels and time periods.

3.2.1 Setting up Object Index

You can select up to 16 cameras for which their Object Index is kept.

1. Click Home [ > Toolbar 2 B Configure # > Video process. The Setup dialog box
appears.
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2. From the Video Analysis drop-down list, select Object Index, select the desired cameras and click

Setting. This dialog box appears.

Object Index 3]

Camera5 v

Mask Region:
[ B-1¢]

Storage
Available: 178.11GB

( Set Location |

Recycle Keep Days 30

Setup
(® Object Index

O Face Detection @

O Video Snapshot

[ Never Recycle @

Noise Tolerance
3 Level : 1

[ ok ][ cance |

Figure 3-8

4. Select one camera from the drop-down list and configure the following.

Mask Region: Use the mouse to outline a mask area where motion will be ignored.

Set Location: Click the button to assign a path to save the log files and image snapshots.
Keep Days: Specify the number of days the log files will be kept for, from 1 to 999 days.
Recycle: Select to recycle the oldest log files when the remaining disk space is less than 500
MB. When both Keep Days and Recycle are selected, the system reacts to whichever
condition that is first met.

Never Recycle: Log files and image snapshots will not be recycled when selected.

Noise Tolerance: Use the slider to adjust the tolerance level. The higher the level, the more

tolerant the system is to video noise.

5. Click OK to apply the settings.

6. E

nable monitoring to start the function.

Note:

Optionally create a schedule for object index to be enabled only at the time periods specified.

For details, see Creating Schedules in Chapter 1.
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3.2.2 Viewing Object Index

Once set, you can start to view the most recent frames captured, up to 50 frames, through Object

Index.

1. Start camera monitoring. The detected face or objects are indicated on the live view.

2. Click Home [2 > Toolbar U7 >Tools B > Live Object Index. The Live Viewer window
appears and displays the most recent 50 frames recorded.

3. Click the lock icon and select Lock to pause the real-time updating of Object Index.

& Object Index Live Viewer X

T TU TS

Camera7 Camera7
131017 13:10:20
4
Camera7 Camera7
13:10:20 13:10:24

Camera7 Camera7
13:10:26 13:10:27

e

Camera7 Camera7

13:10:41 13:11:42 v
Figure 3-9

4. With the camera name and recorded time shown below each frame image, double-click an image
to play back its recording. The recording will be displayed in ViewLog, where you can play it back

using the Timeline.

Note: To display the corresponding recording, make sure the layout in ViewLog includes the camera

channel selected.
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3.2.3 Searching Object Index

In ViewLog, you can locate, and instantly play back, the frames of the desired cameras within a

specified time.

1. Click ViewLog E] > Toolbar |+ > Tools [ > Object Index.
2. Select the desired camera channels at the top and click Refresh to display all the event frames of

the channels selected, including the ones most recently recorded.

[] camera1
Camerab
Camera9

|
Sl o,

- 202088 AlE =
£ 302089 10:51:13921  10:5021276  1051:23926  10:51:30.383  10:51:34 633
£ 3020810
£ 2020811
£ 202008412 -
E-E 2020843 Je L
(D) 01330 ~03:59 10:51:38.515  10:5040925 105147900 10:51:50.399  10:50:50.659
-(5) 0500 ~05:29
-((5) 06:00 ~06:29
-5 06:30 ~06:59 ¥
-(5) 07.00 ~07:29 -
(D) (07:30 ~07:59 10:51:52.342  10:50:58.375 105205654 10:52:10981  10:52:15981
-((5) 08:00 ~08:29
-((5) 08:30 ~08:59
-((5) 09:00 ~09:29
(D) 05:30 ~09:59 E
(D) 10:00 ~ 10:29 10:52:40.343  10:5306853 105311081 10:53:14.452  10:55:19.309
-5 10030 ~ 10:59
pepteedl (0 1 T0 B

Figure 3-10
3. Select the desired date and time to display the event frames during that time period.

4. Double-click the frame you want to play back. The recording will be displayed in ViewLog, where

you can play back using the Timeline.

Note: To display the corresponding recording, make sure the layout in ViewLog includes the camera

channel selected.
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3.3 Automatic Video Snapshots

The Video Snapshot allows the system to take up to 30 snapshots per second as monitoring starts.

This function allows you to keep the surveillance records as still JPEG images instead of AVI videos
when storage space is limited.

Note: After you start monitoring, the system will start taking video snapshots whether there is motion
or not.

3.3.1 Setting up Video Snapshots

You can select up to 16 cameras to take video snapshots.

1. Click Home L& > Toolbar s Configure # > Video process. The Setup dialog box
appears.

2. From the Video Analysis drop-down list, select Object Index, select the desired cameras and click

Setting. The Object Index dialog box appears.

Object Index

L [T 8

Storage
Avaitable: 178 11G8
( Set Location ]

[“IRecycle  [“]Keep Days o

Setup

(® Object Index

O Face Detection @
[O Video Snapshot I

[]Never Recycle @

[“INoise Tolerance

Level - 1

Figure 3-11
3. Select one camera from the drop-down list.

A. Optionally configure the Storage settings. See Step 4, Setting up Object Index earlier in this
Chapter.

B. Select Video Snapshot.
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C. Click [...] after Video Snapshot for further setup.

1 Seconds 2 Frarnes

[ &ave as JPEG file
[1Enahle i3 triger

| Ok | [ Cancel
Figure 3-12
4. Specifies the frequency of automatic video snapshot. By default, the system will take 2 frames
every second when the monitoring starts.
B Save as JPEG file: Saves the images in JPEG format. Otherwise, you can only access the
snapshots using the ViewlLog player.
B Enable I/O Trigger: Takes snapshots only when the assigned input device is triggered.
5. To configure another camera, select a different camera on Step 3.
6. Click OK to apply the settings.
7. Start monitoring to take snapshots.
Note:
1. For details on other settings of the Object Index dialog box, see Step 4, Setting up Object Index
earlier in this chapter.
2. Optionally create a schedule for video snapshot function to be enabled only at the time periods

specified. For details, see Creating Schedules in Chapter 1.

3.3.2 Searching Video Snapshots

To locate video snapshots of desired cameras, click ViewLog L.:_- > Toolbar -+ >Tools O >
Object Index. A window similar to that of Object Index appears (Figure 3-10).

Select a desired camera channel and click Refresh to display all its event frames, including the

ones most recently recorded.

Select the desired date and time to display all the video snapshots captured, along with their event

frames, during that time period.

Note: When Save as JPEG file is enabled (Figure 3-12), you can also view the video snapshots

from the directory specified by Set Location (Figure 3-11).
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3.4 Face Detection

The Face Detection enables the system to detect and record human faces, including individual faces

when a group of people enter the scene. This feature captures human faces only, ignoring other body
parts, objects or background views.

3.4.1 Setting up Face Detection

Up to 16 cameras can be configured for this application.

1. Click Home &4 > Toolbar Ed- Configure ® > Video process. The Setup dialog box
appears.
2. From the Video Analysis drop-down list, select Object Index, select the desired cameras, and

then click Setting. The Object Index dialog box appears.

Object Index

Cameras v

as| n:
K|

Storage
Available: 178.11G8

[ Set Location |

[“IRecyctle  [“]Keep Days )

Setup

(® Object Index

I O Face Detection I@
(O Video Snapshot
I Never Recycle @

[“INoise Tolerance
Level : 1

Figure 3-13

3. Select one camera from the drop-down list.

A. Optionally configure the Mask Region, Storage and Noise Tolerance settings. For details, see

Step 4, Setting up Object Index earlier in this chapter.

Select Face Detection.

C. Click[...] after Face Detection to adjust the sensitivity. The higher the value, the more sensitive
face detection is.

4. To configure another camera, select a different camera on Step 3
5. Click OK.
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6. Start monitoring.

Note:

1. For details on other settings of the Object Index dialog box, see Step 4, Setting up Object Index
earlier in this chapter.

2. Optionally create a schedule for face detection to be enabled only at the time periods specified.

For details, see Creating Schedules in Chapter 1.

3.4.2 Searching Face Detection Snapshots

1. Click Home 24 > Toolbar |-+ >Tools [ > Live Object Index to display the Live Viewer

window.
Object Index Live Yiewer 23]
Camera 1 Camera 1
17:57.08 17:58:25
Camera1 Camera 1
17:58:29 17:58:44
e fm, =
-~ 4 L
<<
Camera 1 Camera1
17:59:09 17:59:13
Figure 3-14

2. Double-click a desired frame to instantly play back its recorded file.

Note: Consider the following when installing the camera for face detection:

e Face contour must be clearly seen

e Only faces tilting within the range of 15° vertically and 30° ~ 45° horizontally can be detected.
e The face to be detected must cover least 1/10 of the screen.
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3.5 Face Count

The Face Count function allows you to count the number of faces that appear in the image. You can
also select to invoke a computer alarm or trigger an output device when a face is detected or when no
face is detected.

The number of faces counted is saved to GV-Web Report which can analyze counting data from

multiple GV-VMS systems. For details, see GV-Web Report User’s Manual.

Note:

1. Up to 16 cameras can be configured for this function.

2. The Face Count results are only available on GV-Web Report V2.2.6.0 or later.

3.5.1 Installing the Camera

1. Install the camera inside an entrance pointing outward. The Face Count function is designed to
detect front-view faces only, and the area of the detected face must take up 10% to 50% of the
live image.

Camera Selection

Camera v‘

Definition

(&) Mask Region

(O Detected Face Size ﬁ

- 010/01/1803:37:41
Setting S GEOVISION 2F

Alarm Type
i Option

Mask Filter v
‘ l []Enable upon input trigger

Reset at l ! \ o'tlock
4 [[]Save counting results to G¥-Weh Report

Sensitivity 3
73 Invoke Alarm m
[[] output Module
—_— [ Never Recycle @
@ I 0OK l [ Cancel ]
Figure 3-15

2. Avoid installing the camera where it is subjected to direct sunlight or reflections. The lighting of
the entrance where you set the camera should be sufficient but not too bright or dark. Light
should be distributed evenly across faces without too much light coming from one side. Sharp
shadow edges in the camera view may affect the accuracy of face count.
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3.5.2 Setting up Face Count

1. Click Home &4 > Toolbar s Configure ® > Video process. The Setup dialog box
appears.
2. From the Video Analysis drop-down list, select Face Count, select the desired cameras and click

Setting. This dialog box appears.

Camera Selection

Camera3 v

Definition

®MaskRegion  [Fh]E-] X¢]

O Detected Face Size n

Setting .
ion T
Detection Type | Option
|Face Count v
Reset at 12 o'clock
[] save counting results to GV-Web Report
Sensitivity 3

J

lg [ OK ] [ Cancel ]

Figure 3-16

3. Under Camera Selection, select a camera from the drop-down list to be configured.
4. The following configurations are available:
[Definition]
m  Mask Region: Use the mouse to outline a mask area where motion will be ignored.
m  Detected Face Size: You can adjust the Minimum Face Size and the Maximum Face
Size to instruct the system to only detect faces within that size range. Pause the live
image by clicking @ before configuring.
[Setting]
m  Detection Type
® Face Count: Counts the number of faces. The counting results are only available

on GV-Web Report. To connect to GV-Web Report, see the Saves counting
results to GV-Web Report option below.

® Face Detected Alert: Detects faces to invoke a computer alarm or triggers an

output device.
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® No Face Detected Alert: Invokes a computer alarm or triggers an output device
when no face is detected after the number of seconds specified in the Detection

Interval.

Reset at: Type a counting reset time between 0 and 23. For example, if you type 23, the

number of faces counted will become zero at 23 o’clock daily.

Sensitivity: Adjust the detection sensitivity by moving the slider. The higher the value the

more sensitive the system is to motion. The default value is 3.
Detection Interval:

® When Face Detected Alert and Enable Upon Input Trigger are both selected, the
Detection Interval slider specifies the number of seconds you want the system to

detect faces when the input device is triggered.

® When No Face Detected Alert is selected, the system will attempt to detect the

faces for the duration specified for Detection Interval.

[Option]

Enable upon input trigger: The system will begin detecting only when the input device

is triggered. Assign an input module and pin number for the device.

Saves counting results to GV-Web Report: Saves the face counting results to
GV-Web Report. Type the Domain Name or IP Address, Port, User Name, and
Password of GV-Web Report. After settings, click the Test button to see if the

connection succeeds.

Invoke Alarm: Activates the computer sound alarm when faces are detected under Face
Detected Alert or when no face is detected under No Face Detected Alert. Click the [...]

button to designate a sound file for the computer alarm.

Output Module: Activates the output device when faces are detected under Face
Detected Alert or when no face is detected under No Face Detected Alert. Assign an

output module and pin number for the device.

Never Recycle: Prevents recorded events from being recycled when the recycle

threshold is reached.

Click the Test button to see if the settings have been configured according to your preference. If

you have set a detection interval, the test will only run for the number of seconds you specified.

Click OK to apply the settings.

Start monitoring to run the application. The detected (counted) faces are indicated on the live view

with green boxes.
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Note:

1.

Events triggered under Face Detected Alert or No Face Detected Alert will be recorded to the
System Log for later retrieval. In the System Log, the events are recorded as Face Count under

the Monitor tab (ViewLog > Toolbar > Tools > System Log).

The Face Count results will only be saved when Saves counting results to GV-Web Report is

selected and GV-Web Report is connected.
The counter function is not recommended to be applied in fisheye cameras.

Optionally create a schedule for face count to be enabled only at the time periods specified. For

details, see Creating Schedules in Chapter 1.
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3.6 Face Recognition

Face Recognition integrates the facial recognition abilities of GV-Face Recognition Camera for the
system to distinguish detected human faces. Based on the camera’s Face Database, this feature
displays the names of the recognized persons on the live view, while recording the recognition events
during video recording. Additionally, the recognition events recorded can at the same time be used to

trigger e-mail alerts and/or output and computer alarms based on the rules defined.

Note: GV-Face Recognition Cameras include GV-VD8700 and GV-FD8700-FR and this feature only
supported by GV-VMS V17.1 or later.

3.6.1 Enrolling Face Data

Prior to using Face Recognition, it is required to create the necessary recognition data via Face

Enrollment — adding photos of the persons to be recognized into the Face Database of GV-Face

Recognition Camera.

e Enroll faces by adding portrait photos directly into the camra’s database, see the steps
below.
® Synchronize face data from other connected camera, see Synchronizing Face Database

later in this section.

IMPORTANT:

1. GV-VMS directly accesses and manages the Face Database of GV-Face Recognition Camera,

thus all changes made are done directly to the camera’s database.

2. Photos used as recognition data can be pictures of the persons previously taken or snapshots of
the persons captured by connected cameras.
3. All photos used for Face Enroll must meet the criteria as specified in No. 3 under Face

Recognition FAQ of the FAQ.

1. Click Home LS4 > Toolbar = > Configure & > Video process. The Setup dialog box
appears.
2. From the Video Analysis drop-down list, select IPCVA, select the desired cameras and click

Setting.
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3. Select the desired channel from the drop-down list at the top, select Face Recognition > >

Face Enroll.

IP Cam Video is. L J
| .
Cameral0 X

IP Cam video analysis

Motion Detection
Gv 3D People Count > \
Face Recognition E‘ ‘

Time

Schedule

Face Setting

Group Setup

Face Database Synchronization

Figure 3-17
4. Click Add to define a new Face ID. Alternatively, select or Search for an existing ID from the

Enrolled Face list.

Face Envolment(192.168122) g 2]
Total Enrolled Faces:2(Max. 10000) Name Bias7777
Blias7777
Nelson888 Group E]
Organization mm
Access Schedule
Face Image(2/20)
L |
k|
< T, 7%
H[ Adi) ([Remove.) [LSearch) [ Add ][ Remove |[cropimage] (@)

Figure 3-18
5. Click Add, on the bottom the right side, to add photos and/or snapshots for the Face ID selected
from your local PC. Optionally crop the image added by selecting it and click Crop Image.
6. You can also configure the following options for the Face ID selected:
B Name: Type a desired name for the Face ID.
B Group: Select from a list of ten groups in which the Face ID shall be categorized under.

Click the '~ button to modify the group name. This setting can be used to trigger e-mail
alerts and/or output alarms when persons from a specified Group is recognized at the

surveillance site. See Configuring Face Setting later in this chapter.

B Organization: Type a desired organization name for the Face ID.
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B Access Schedule: Select a predefined schedule in which the Face ID is allowed access or
select Current Setting and click to define an exclusive schedule for the person. To set

a schedule, refer to Defining Access Schedule later in this chapter for details.

7. Click OK to save.

Note: All changes made here take immediate effect on the Face Database of the selected camera.

3.6.2 Synchronizing Face Database

To synchronize the face databases of two or more cameras, follow Steps 1 to 3 in Enrolling Face Data

earlier in this chapter and select Face Database Synchronization. The following window appears.

Select Source Camera
|Camera8(192.1685.197) v S0
Select Sync Camera
[] Camera Name Total Enrolled Faces P
[¥] camerat0 151 192.16862
:‘Cameva15 7 192.168.7.127
SyncData |
Figure 3-19

B Select Source Camera: Select the camera you want to synchronize from.
B Select Sync Camera: Select the cameras that you want to be synchronized.

B Sync Data: Click to start synchronizing.
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3.6.3 Starting Face Recognition

Monitoring of the camera must be enabled for Face Recognition to work.

1. Make sure Face Recognition is enabled. Refer to Steps 1 to 3 in Enrolling Face Data earlier in

this chapter.

(1P Cam Video Analysis [

IP Camvideo analysis

[] Mation Detection

ot [ ]
|
| Face Recognition

aro e
Figure 3-20

2. Start monitoring of the camera channel (Home > Toolbar ﬂ > Monitor g > select
Channel).

3.6.4 Viewing and Searching for Face Recognition Events

When Face Recognition is enabled, all recognition events, along with recognition snapshots,
recognition time, and schedule alerts, when applicable, are recorded in an event log during video
recording. To view Face Recognition in recorded videos, click ViewLog L=l > Toolbar m s Tools

O > Face Recognition. This window appears.

Recognitiol
Show All | Total record(s): 10000
Image Name Group Camera Name Time Alert (v
u Sara_Meng normal Camera2 2/8/2018 3:59:18 PM
ﬁ Louis_Liang normal Camera2 2/8/2018 3:59:18 PM Schedule Alert
Sara_Meng normal Camera2 2/8/2018 3:59:18 PM
]
a Louis_Liang normal Camera2 2/8/2018 3:59:18 PM Schedule Alert
a Sara_Meng normal Camera2 2/8/2018 3:59:18 PM
% Louis_Liang normal Camera2 2/8/2018 3:59:18 PM Schedule Alert
-.; Sara_Meng normal Camera2 2/8/2018 3:59:18 PM
% Louis_Liang normal Camera2 2/8/2018 3:59:18 PM Schedule Alert
a Sara_Meng normal Camera2 2/8/2018 3:59:18 PM v
< >
Figure 3-21
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B Show All: Select Show All, Show Identified Persons Only or Show Unknown Persons

Only to filter the recognition events displayed.

B Event Image: Display the captured Snapshot of the recognition event. Double-click the

Snapshot to see the recording of the recognition event in ViewLog.

B Name: Display the Name of the individual recognized. Written as “Unknown” if

unrecognizable.
B Group: Display the Group the recognized person is categorized under in the Face Database.
B Camera Name: Display the Channel in which the recognition event was recorded.
B Time: Display the Time of the recognition event.

B Alert: Record Schedule Alerts when the recognition event recorded is outside of the person’s

(Face ID) allowed access schedule.

B Query: Click to access the Query window, where you can filter and search for recognition

events in selected camera channels.

3

Choose Camera | start Time
Cameral - =
Camera2 1/29/2018 v | |12:00:00 AM >
e End Time
Camera4

1/29/2018 J~ | [11:50:50 PM g

Name

Figure 3-22

Note: The Name search in Query functions as a keyword search and is case-sensitive.
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3.6.5 Defining Access Schedule

Access Schedules are used to specify the time periods in which specific persons (Face ID) are allowed
or denied access of from Monday to Sunday. Whenever a person is recognized outside of his/her
allowed schedule, a schedule alert is recorded, which can be used to trigger e-mail alerts and/or

output alarms.

The Access schedule can be set in five steps:
° Step 1 Setting up 24-hour Schedules
Define the minutes and hours a person is allowed / denied access of in a day.
° Step 2 Setting up Weekly Schedules
Define the days a person is allowed / denied access of in a week.
° Step 3 Assigning Access Schedules
Assign the defined schedules to the desired persons in Face Enrollment.
° Step 4 Setting up Schedule Alerts to Trigger E-mails / Alarms

Select Schedule Alerts as the parameter to trigger e-mail alerts and output alarms in Face
Setting. See Configuring Face Setting later in this chapter.

° Step 5 Starting Camera Monitoring

Start monitoring of the camera channels and enable Face Recognition to activate access
monitoring as defined by the Access Schedules.
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3.6.5.1 Step 1: Setting up 24-hour Schedules

Before creating weekly schedules, you need to first define a number of desired 24-hour schedules that
can be used to prepare the weekly schedules. Follow Steps 1 to 3 in Enrolling Face Data earlier in this
chapter and select Time. In this window, up to 254 24-hour schedules can be defined, with two default

schedules for “Full Access” and “Deny Access.”

24-hour Schedule = I . _ l
# & BE O
P AR AFR TR ILNBERUEPB I RRANRD N

1 »

0:DenyAccess

255 : Full Access | |

1: Day Shift | :

2: Night Shift 7 '
penviso |

B Access Time

Figure 3-23

1. Click the Add button &¢. An ID number ascending from the lowest existing ID will be

automatically generated. Type a desired name for the new schedule, e.g. Day Shift and click OK.

2. Click the Add Access Time button @ . Then drag the mouse on the timeline to specify the time
periods of allowed access, e.g. from 09:00 to 19:00.

3. Repeat Steps 1 to 3 to create multiple schedules if needed, e.g. for Night Shift from 00:00 to
09:00 and 19:00 to 24:00 and for Supervisor from 07:00 to 24:00.

4. To remove time periods of allowed access, click the Delete Access Time button @ Then drag
the mouse over the periods that you want to remove.

5. Click OK to save the changes.
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3.6.5.2 Step 2: Setting up Weekly Schedules

Once the desired 24-hour schedules are set, follow Steps 1 to 3 in Enrolling Face Data earlier in this
chapter and select Schedule. In this window, up to 254 weekly schedules can be defined, with two

default schedules for “Full Access” and “Deny Access.”

& &

255 : Full Access Monday Deny Access
1:Schedule 1

Tuesday Deny Access

Wednesday Deny Access

Thursday Deny Access

Friday Deny Access

Saturday Deny Access

Sunday Deny Access

Figure 3-24

1. Click the Add button &' An ID number ascending from the lowest existing ID will be

automatically generated. Type a desired name for the new schedule, e.g. Rotation and click OK.

2. Select the desired schedules for Monday to Sunday, predefined from Step 1 earlier in this section,

in each of the respective drop-down lists, as exemplified below.

& &
0 : Deny Access ‘

255 : Full Access

Figure 3-25

3. Repeat Steps 1 to 3 to create multiple schedules if needed, e.g. for Daytime-only and

Weekend-only access.
4. To delete schedules, select the schedule to be deleted and click the Remove button &

5. Click OK to save the changes.
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3.6.5.3 Step 3: Assigning Access Schedules

Once the weekly schedules are set, follow Steps 1 to 4 in Enrolling Face Data earlier in this chapter,

select or Search for a desired Face ID and select a schedule in the Access Schedule drop-down list.

—
Face Enrolment(192.168.1.22) - [
—
Total Enrolled Faces:2{Max. 10000) Name Hias 7777
Blias7777
o =
Organization 11777
Access Schedule
BRLIG SR s rapan)
Figure 3-26

Once the Access Schedules are assigned, turn on monitoring of the camera channel and enable Face

Recognition, see Recording Recognition Events later in this chapter, to start access monitoring based

on the schedules.
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3.6.6 Configuring Recognition Alerts and Recognition

Database

In this section, you can use Schedule Alerts, Unknown Alerts or the Recognition Events of a specified
Group, e.g. blacklist, to send e-mail notifications and/or trigger output alarms, and also configure the
database of face recognition events, including storage path of the snapshots and log files of

recognition events.

Note: For Face Setting to work, make sure Face Recognition is enabled, see Starting Face

Recognition later in this chapter.

To configure Face Setting, follow Steps 1 to 3 in Enrolling Face Data earlier in this chapter and select

Face Setting. This window appears.

[Face Setting @
- -
m Ewvent Trigger : [Schedule Alert hd
E-Mail :
Interval : 60 Sec

Qutput Module :  |Module 1 v] [Pin 1 - l

Interval : 30 Sec

Database Setting
|

[i
L=

Figure 3-27

B Event Trigger: Select Schedule Alert or the Group of Face ID that e-mail notifications, or 1/0
should be triggered for. For details on using Schedule Alerts, refer to Defining Access

Schedule earlier in this chapter. A GV-I/O Box needs to be connected to GV-VMS for the 1/0

function to work.

© For E-Mail, Set the minimum time Interval allowed, from 0 to 3600 seconds, in between

each e-mail notification.
© For I/O, select the desired Output Module and Pin number.

B Database Setting: Click to configure the Database Settings as below:
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DatabaseSetting

Database Folder
GV-VMS\CameraDBs B

Recycle Setting

V| Recycle V|Keep Days: 30

oK ‘ l Cancel

Figure 3-28

® Database Folder: Click the Browse button [ to modify the save path for the snapshots

and log files of recorded Recognition Events.

© Recycle: Enable to recycle the data in the Database Folder.

© Keep Days: Type the desired number of days that data in the Database Folder should be

kept for, from 1 to 999.

Note: Make sure the e-mail and 1/O functions are configured properly before use. For details, see

Setting up E-mail Notifications and Setting up I/O Devices in Chapter 1 and 6, respectively.

3.6.7 Tracking Recognized Faces

Tracking of recognized faces can be displayed on the E-Map when there are multiple cameras with

synchronized Face Databases.

To display Face Tracking, refer to the following for the related settings:

Step 1 Synchronizing Face Database

To synchronize Face Databases, see Synchronizing Face Database earlier in this chapter.
Step 2 Creating E-Map(s)

To create E-Map(s) and add the camera, see Creating an E-Map in Chapter 8.

Step 3 Enabling Face Recognition

To enable Face Recognition, see Starting Face Recognition earlier in this chapter.

Step 4 Turning on Monitoring
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Once all the related settings are set, turn on monitoring and you will see arrows indicating the

movements of recognized persons on the E-Map.

Tiffany H
_ 2019/03/06 13:38:22

Tiffany H
_2019/03/06 13:39:05

Figure 3-29

No. Name Description

1 Face Tracking Display the direction of movement of the individual recognized.

2  Latest Recognition Site The end point of the Face Tracking arrow indicates the
surveillance site (camera channel) where the recognized
individual was last seen.

3  Previous Recognition Site The initial point of the Face Tracking arrow indicates the
surveillance site (camera channel) where the recognized
individual was previously seen.

4  Recognition Event Display a live image of the Recognition Event.
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Adjusting the Display Mode on E-Map

To adjust the display mode of the recognition events on E-Map(s), click Tools X and select Face
Recognition for the following options:

Auto Rotate

Icon Options >

Properties Show face only

Hide face

al=l2 &' Close

Figure 3-30

B Show face and path: Selected by default, display both Face Tracking and the Recognition
Events on the E-Map.

B Show face only: Display only the Recognition Events on the E-Map.

B Hide face: Do not display any Recognition Events and Face Tracking on the E-Map.

Configuring Face Tracking

For an increased accuracy, you can modify the interval setting of Face Tracking based on your

surveillance needs.

1. In Content List of Live view, click Configure 0 > General Setting. This window appears.

&
{  Emap Popup Settings l [0 V] Days [1 V] - [0 V] - [0 ']

General Setting

Figure 3-31

2. Under Tracking Time, select the days (0~31), hours (0~23), minutes (0~59) and seconds (0~59)
to define the time interval in which Face Tracking is effective for. Face Tracking will not be

displayed for any subsequent Recognition Events occurring beyond the set Tracking Time.

3. Click OK to save the changes.
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3.7 Privacy Mask Protection

The Privacy Mask can block out sensitive areas from view, covering the areas with black boxes in both
live view and recorded clips. This feature is ideal for locations with displays, keyboard sequences (e.g.

passwords), and for anywhere else you don’t want sensitive information visible.

You can also choose to retrieve the block-out areas during playback. The retrievable areas will be

protected by password.

Note: No motion will be detected in the areas set up with Privacy Mask. To have Privacy Mask and
motion detection functions together, you need to use built-in motion detection function of the camera
instead (Home > Toolbar > Configure > Video Process > IPCVA > Setting > Motion Detection), as well

as enabling motion detection on the camera.

3.7.1 Setting up a Privacy Mask

1. Click Home LS4 > Toolbar “+ > Configure ® > Video process. The Setup dialog box
appears.
2. From the Video Analysis drop-down list, select Privacy Mask Setup, select the desired cameras,

and then click Setting. This dialog box appears.

Privacy Mask Setup @
‘ Camerad v RRRRER o W |
a3
f
4
O Recoverahle @

Figure 3-32

3. Select a camera from the drop-down list.
4. Select Un-recoverable and/or Recoverable.
B Un-recoverable: The block-out area(s) will not be retrievable in the recorded clips.

B Recoverable: The block-out area(s) will be retrievable with password protection.
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5. Drag on the area(s) where you want to block out on the image. You will be prompted to click Add

to save the setting. The Un-recoverable region is marked in black, while the recoverable region is
shown in red.

6. Click OK to apply the settings.

Note: Optionally create a schedule for Privacy Mask to be enabled only at the time periods specified.
For details, see Creating Schedules in Chapter 1.

3.7.2 Granting Access Privileges to Recoverable Areas

By default, only a Supervisor account is granted access to see the block-out areas on recorded videos.

To grant access rights to Power Users and Users, follow the steps below.

1. Click the login user button Gaiid i on the main screen, select Password Setup > Local
Account Edit. The Local Account Edit dialog box appears.

2. Select one account, click the Privacy Mask tab, select Restore Recoverable Video and select

the camera to grant the privilege.

Lecal Account Edit =
Guest Disable Account Expire in (days)
Maer D: fadmin
Powerllser
Pessword:  [seese
=} Supervisor
‘ Hint
admin
Level : Supervisor
[E] User cannot change password
[ Farce password change at naxt login
Disable account f user does not log in after (days)
[E] Export this ID for IR Remote Control (GV-Keyboard)
[ Send pessword by Emai (]
[ Login this 1D automatically {Single user mode)
[@IRestore Recoverable Video
—I Video | Camera Name
Camera?
Camerad
- VMS [ Viewlog [ Webcam [ Fast Backup and Restore | Cantrol Center | Privacy Mask |Cther
[E] Allow removing password system
Enable double password
[E] ke ID and passwords se sensiive
Figure 3-33

Note: If you open the event files (*.avi) directly from local disks, the valid ID and password are also
required to access the block-out areas. For details on retrieving the block-out areas in the exported
files, see Merging and Exporting Video in Chapter 4.
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3.8 Panorama View

A panorama view joins multiple camera images together and allows you to monitor a large area in one

view. The cameras selected for the panorama view will keep the recording in original format. Up to 4

sets of panorama views can be created. There are two ways to create a panorama view:

e  Stitch camera images together by overlapping and matching reference points

® Use the Easy Mode to place camera images next to each other with no overlapping

In Content List of Live view, select Panorama > Configure £} . The Panorama View Setup dialog

box appears.

Note: This function is not available for V17.4.6 or later.

3.8.1 The Main Window

T Parforanpa View ietup

) T

Fanaorama selection

| Easzy mode (Video source must be

the same resolution)

Source

{CameraE -

[

3Selected Source

Panorama 1 -

Figure 3-34
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The controls on the Panorama View Setup dialog box:

No. Name Description

1 Add Adds an image for automatic splicing.

2 Undo Cancels the settings.

3 Manual Setting Manually splices the images together.

4 Blending Makes the spliced images seamless.

5 Demo Displays the setup procedure.

6 Left / Right Place the selected image to the left or right of the previous image.

7 Top / Bottom Place the selected image on the top or bottom of the previous image.

8 Save Before Exit Saves the created panorama view and closes the dialog box.

9 Exit Closes the dialog box.

10 Preview Window Displays the selected source image or the spliced images.

11 Easy Mode Places camera views next to each other with no overlaps.

12 Panorama Selection Selects the panorama set for the images to be spliced together.
Clicks again to rename the panorama set.

13  Source Selects the source image to be spliced.

14  Selected Source Displays the selected image.

3.8.2 Stitching a Panorama View with Overlapping Areas

To stitch images from different cameras together, follow these steps:

Select one panorama set (No. 12, Figure 3-34) from the drop-down list. If you want to rename the

selected panorama set, type the name in the field.

Select one camera from the Source drop-down list and click Add. The image will be the reference

image on which other images will be sliced.
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3. Select another camera from the Source drop-down list (No. 13, Figure 3-34) and click Manual

Setting (No.3, Figure 3-34). This dialog box appears.

Panorama View Setup @

Source Reference

Camera § > Camera 4 >

Cancel

Preview : Spread out these 3 points and avaid lining
them up straight.

Figure 3-35
4. From the Source drop-down list, select one camera as the Source image to be stitched with the
Reference image.
5. To stitch the two images together, click on a significant point in the Reference image and then look
for the same point in the Source image. A dialog box of point selection will prompt you to confirm.

You need to set up 3 points for stitching.

Note: For the best result, position the points in the overlapping areas on both images. Avoid placing
the points in a cluster or lining them up straight.

6. The resulting image is displayed in the Preview window. If satisfied with the result, click OK to exit
the setup dialog box. If not, re-enter the 3 points for stitching.

7. If you want to stitch a third image or more, click Manual Setting and repeat Steps 3 to 5 multiple
times.

8. When you finish stitching images, click the Save Before Exit button (No.6, Figure 3-34) to save

the created panorama view before exiting the Panorama View Setup dialog box.

Note: The resolution of the images to be stitched will be reduced to 320 x 240. A panorama view
has a resolution limit of 1920 x 1080. Once the limit is reached, you cannot stitch more images to
the created panorama view.
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9. This panorama view is saved to the Panorama category in the Content List.

® Content List

&

Figure 3-36

10. Drag the created panorama view to the live view grid for display.

3.8.3 Easy Mode with No Overlapping Area

When you have multiple camera views covering areas right next to each other with no overlaps, the

Easy Mode allows you to simply place camera views together.

o 97 S0 S0

Figure 3-37

1.  Select Easy Mode (Video source must be of the same resolution) (No. 11, Figure 3-34).

117



Q GeoUision:

2. Use the Source drop-down list (No. 13, Figure 3-34) to select the first camera view to be placed

in the panorama and click the Add g button. The first camera view is added to the Preview
Window.

) Panorama View Setup [E
Ot iR EBrHEa

Panorama selection

Easy mode (Video source must be
the same resolution)

Panorama 1 v T—

Source

Camera2 v

‘Selected Source

Figure 3-38

3. Toadd a second camera view, select the camera from the Source drop-down list.

=
4.  To place the camera view on the left or right of the first camera view, click the ﬂ icon and
select to place the second view on the Left or Right of the first view.

0 Panorama View Setup EI
ook ByvHEa

Fancrama selection

Easy mode (Video source must be
the same resolution)

Fancrama 1 -

Source

Camera‘ -

Selected Source

Figure 3-39
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+f

5. To place the camera view above or below the first camera view, click the icon and select to

place the second view on the Top or Bottom of the first view.

6. Repeat the steps for any additional cameras.

Note: You will only be able to add additional cameras next to the last camera view added. For
example, when adding a third camera, you can only use the direction buttons S| ] in relation to
the second camera. You will not be able to go back and select the first camera.

[
7. When you finish stitching images, click the Save Before Exit button before exiting.

8.  This panorama view is saved to the Panorama category in the Content List (Figure 3-36).

9. Drag the created panorama view to the live view grid for display.

3.8.4 Accessing a Panorama View

Drag the configured panorama from the Content List (Figure 3-36) to the live view. The panorama view

is displayed on the main screen.

Panorama 1

Figure 3-40
Right-click the panorama view to have these options:
B Snapshot: Save the current panorama view as an image file.

B Zoom: Put the cursor on the live view and scroll your mouse to zoom the live view.
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3.9

Video Defogging

Smoky environments and bad weather, such as rain, snow or fog, all affect image quality and reduce

scene visibility. This feature helps to enhance image quality for live viewing.

Note:

1.

This function takes high CPU and memory usage. Make sure at least 1 GB of RAM is installed on
your system.

2. Defogging is not supported when Heat Map is enabled.
1. Click Home |24 > Toolbar |- > Configure ® > Video process. The Setup dialog box
appears.
2. From the Video Analysis drop-down list, select Defog, select the desired cameras, and click
Setting. This dialog box appears.
LCamera2 - [ Demo ] |sample 1 v |
Original
Refresh Rate @
0
<< Low|High >* [ OK ] [ Cancel ]
Figure 3-41
3. Use the drop-down list to select a camera.
4. When the image enhancement is enabled, the system load will increase. Adjust the Refresh rate
by moving the slider bar to optimize system performance.
5. If you want to view the demonstration of this function, click the Demo button.
Note:

1.

This function only applies to live view and does not affect the recorded video. To apply defogging
to recorded videos during playback, on ViewLog right-click the desired image > Effects >
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Defog.

2. For better image quality, it is recommended to change the streaming to single stream before you
enable the video analysis effect. This effect does not support On Demand Display for automatic
adjustment of live video resolution in single-channel division.

1. Optionally create a schedule for video defogging to be enabled only at the time periods specified.

For details, see Creating Schedules in Chapter 1.

3.10 Video Stabilization

Images from a shaky camera are jittery or blurry. This feature helps to reduce camera shake, leaving

you with clear and steady images.

Note:
1. This function takes high CPU and memory usage. Make sure at least 1 GB of RAM is installed on

your system

2. Stabilization is not supported when Heat Map is enabled.

1. Click Home 24 > Toolbar s Configure ® > Video process. The Setup dialog box

appears.
2. From the Video Analysis drop-down list, select Stabilizer, select the desired cameras, and click

Setting. This dialog box appears.

Video Stabilizer Setup

Cameral v
2
]
i

‘Refresh Ra@ ‘ @
—— {1

Figure 3-42
3. Use the drop-down list to select one camera. The enhanced view is shown on the right.

4. When the image enhancement is enabled, the system load will increase. Adjust the Refresh rate

by moving the slider to optimize system performance.
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5. If you want to view the demonstration of this function, click the Demo button.

Note:

3. This function only applies to live view and does not affect the recorded video. To apply
stabilization to recorded videos during playback, on ViewLog, right-click the desired image >
Effects > Stabilizer.

4. For better image quality, it is recommended to change the streaming to single stream before you
enable video stabilization. This effect does not support On Demand Display for automatic
adjustment of live video resolution in single-channel division.

5. Optionally create a schedule for stabilization to be enabled only at the time periods specified. For

details, see Creating Schedules in Chapter 1.

3.11 Wide Angle Lens Dewarping

Camera images can sometimes appear curved toward the edges of the view. This feature helps

correct distortion towards the edge of the camera view.

1.

3

Click Home 24 > Toolbar |~ > Configure ® > Camera Install. The IP Device Setup dialog

box appears.

IP Device Setup

O ¥ D Status | Server address  Port | Wideo Resolution Bitrate Brand Setting
1 o 192.168.7.25 10000 1920X1080(HZ64) [ 44B8X252(H264) 7646 [ 158 kbps  GeoVision_Gv-BX2200/BX2300_Series
2 [ ] 192.168.0.64 10000 1280X1024(H264) 339 kbps GeoVision_GW-FE110_Series =4
(&)
Figure 3-43
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2. Click Settings 4. This dialog box appears.

®

Setting
B video setting ‘

o) Audio Setting
¥ General Setting Zamera Jetking Zamera Lens

Camera Mame : | Carneral

ide Angle

Wideo Attribute
Brightniess : i 50

Contrast

Satuation J 50

Figure 3-44
3. Use the Camera Lens drop-down list to select Wide Angle

4. Click the button. This dialog box appears.

Wide Angle Dewarping Setting

Criginal Image

Dewarped Image
Settings

Field of View Angle
[ 240 degree I~ apply all

Cancel

Figure 3-45
5. Move the slider to adjust the degree of warping. The adjusted view is shown on the right.

6. Click OK. The dewarping is immediately applied on the live view.

Note:

1. This function only applies to live view and does not affect the recorded video. To apply
stabilization to recorded videos during playback, on ViewLog, right-click the desire image >

Effects > Wide angle lens dewarping.

2. If dual-stream IP channels are applied, for better image quality, it is recommended to change the
streaming to single stream before you enable wide angle lens dewarping. This effect does not
support On Demand Display for automatic adjustment of live video resolution in single-channel

division.
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3.12 Crowd Detection

Crowd detection is used to generate an alert when a crowd of people gathers in a specified area and

exceeds the defined time threshold.

Note: Up to 16 cameras can be configured for this application.

1. Click Home LS4 > Toolbar |~ > Configure ® > Video process. The Setup dialog box
appears.

2. From the Video Analysis drop-down list, select Crowd Detection, select the desired cameras, and

then click Setting. This dialog box appears.

Crowd Detection

Camera Selection

Cameral v|

Diefinition

Alarm Redion IE!!K]

Setting
Sensitivity 3
-

Y

Ratio of Changes a0 %

-

.Y
Talerance Time of Alarm {zec.)

(=]

Alarm Option

Qption

[] 5kip instant light change

[ irvake Alarm
(&) Automatically disable alarm Sec.

(- Automatically disable alarm when the crowd [JOutput Madule

disperses
[ Mever Recycle @
[ 0K ] ’ Cancel ]
Figure 3-46

3. Select a camera from the Camera Selection drop-down list.
4. By default the whole camera view is set to be the alarm region. Click the |Z| button to clear the

default setting. Click the IE button to freely draw the alarm region. To cancel the previously
drawn area, click the button.
5. To adjust the Crowd Detection sensitivity, move the Sensitivity slider. The higher the sensitivity

value, the more sensitive the system is to detecting crowds.

124



6.

10.
11.

Video Analysis

To define the minimum ratio of change (in the alarm region) for the alarm to be activated, move the
Ratio of Changes slider to set a value. The smaller the ratio of changes, the more sensitive the

system is to the changes in the camera view.

To define the minimum time that a crowd needs to stay for the alarm to be activated. Use the

Tolerance Time of Alarm slider to specify a value or type a number in the blank.

Optionally configure the following settings:

B Automatically disable alarm: Triggered alarms are automatically disabled after the specified
time (seconds). The default setting is 30 seconds.

B Automatically disable alarm when the crowd disperses: Triggered alarms are
immediately disabled when no crowds are detected.

B Skip Instant Light Change: Ignores sudden illumination changes to minimize false alarms.
For example, light switches can cause illumination changes suddenly. With the option
selected, the system will ignore significant illumination changes without triggering the alarm
and continue monitoring. See the Note below for possible risk.

B Invoke Alarm: Enables the computer alarm when an assemblage is detected. Click the [...]
button next to the option to assign a .wav sound file.

B Output Module: Activates the output device when a crowd is detected. Select this option and
use the drop-down list to assign an installed output module and a pin number.

B Never Recycle: Prevents the system from recycling the event files of crowd detection when
the recycle threshold is reached.

You can click Test to test your settings. When an assemblage is detected in the camera view, a

flashing box will appear on its location for warning. If an assemblage cannot be detected,

decrease Ratio of Changes to increase the system sensitivity for detection.

Click OK to apply the settings.

Start monitoring to run the application. The detected crowd is indicated on the live view with

blinking red and green boxes.

When a crowd of people gathers in the alarm region for the specified time, its location will be

highlighted on live view, the selected alarm or output will be activated, and the event will be recorded

as Crowd Detection in the System Log for later retrieval.
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Note:

1. For the Skip Instant Light Change option:

When the option is selected, you may be subject to the risk that the system will not generate
an alert whenever the lens of the camera is covered by malice.

¢ This option is not recommended for infrared cameras.

2. Optionally create a schedule for crowd detection to be enabled only at the time periods specified.
For details, see Creating Schedules in Chapter 1.

To manually stop all triggered alerts, click the Tools button 7 onthe triggered channel, select
Reset Alert and select Crowd Detection.

B Reset Alert: Disables and resets the triggered alert. After the alert is reset if the crowd remains

gathering over the specified tolerance time, the system will still detect it as a crowd gathering and
keep generating alert.

3.13 Advanced Scene Change Detection

The Advanced Scene Change Detection detects any changes of scene, viewing angle or focus

clearness made by malice in both indoor and outdoor environments.

Note: Up to 16 cameras can be configured for this application.

1. Click Home LS4 > Toolbar -+ > Configure # > Video process. The Setup dialog box

appears.

From the Video Analysis drop-down list, select Advanced Scene Change Detection, select the

desired cameras, and then click Setting. This dialog box appears.

Camera Selection =3
Camera3 N
Definition

Mask Region EEX] &S

Setting

Sensitivity 3

J

Tolerance Time of Alarm (sec.)

0
Option
0| [} : :
[[] Automatically disable alarm

[] Skip instant light change
E—c—

[Jinvoke Alarm

| sec.

[] output Module

[JNever Recycle @

Figure 3-47
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3. Select a camera from the Camera Selection drop-down list, and configure these settings:

Mask Region: If necessary, mask off the area on the camera view where any scene change

will be ignored.

Sensitivity: Adjusts detection sensitivity. The higher the value, the more sensitive the system

is for changes in the camera view.

Tolerance Time of Alarm: Sets the duration of scene change before an alarm condition is

activated. Move the slider or type a value (in second) in the blank.

Automatically Disable Alarm: Stops all types of triggered alerts, including sound alarm,
flashing boxes and output module after the specified duration. Disabling the alerts will not

disable alert settings and the detection in progress.

Skip Instant Light Change: Ignores sudden illumination changes to minimize false alarms.
For example, light switches can cause illumination changes suddenly. With the option
selected, the system will ignore significant illumination changes without triggering the alarm

and continue monitoring. See the Note below for possible risk.

Invoke Alarm: Enables the computer alarm when the scene change is detected. Click the [...]

button next to the option to assign a .wav sound file.

Output Module: Activates the output device when the scene change is detected. Select this

option and use the drop-down list to assign an installed output module and a pin number.

Never Recycle: Prevents the system from recycling the event files of scene change when the

recycle threshold is reached.

4. You can click Test to test your settings. If the scene change cannot be detected, increase

Sensitivity value to increase system sensitivity to changes in the camera view.

5. Click OK to apply the settings.

6. Start monitoring to run the application.

When a scene change is detected in the camera view for the specified time, its location will be

highlighted in live video, the selected alarm or output will be activated, and the event will be recorded

as Advanced Scene Change in the System Log for later retrieval.

Note:

1. For the Skip Instant Light Change option:

When the option is selected, you may be subject to the risk that the system will not generate

an alert whenever the lens of the camera is covered by malice.

This option is not recommended for infrared cameras.
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2. To create schedules for Advanced Scene Change, see Creating Schedules, Chapter 1.

To manually stop all triggered alerts, click the Tools button 7 onthe triggered channel, select
Reset Alert and select Advanced Scene Change Detection.

B Reset Alert: Disables and resets the triggered alert. After the alert is reset, if the scene change

remains over the specified tolerance time, the system will still detect it as a scene change and

keep generating alert.

3.14 Advanced Unattended Object Detection

The Advanced Unattended Object Detection can generate an alert when any unattended object stays

within the camera view. This function can be applied to both the indoor and outdoor environments.

Note: Up to 16 cameras can be configured for this application.

1. Click Home LS4 > Toolbar |~ > Configure ® > Video process. The Setup dialog box
appears.
2. From the Video Analysis drop-down list, select Advanced Unattended Object Detection, select

the desired cameras, and click Setting. This dialog box appears.

Advanced Unattended Object Detection @

Camera Selection
Cameral
Definition

(5 Mask Region

O Unattended Object Size

Sefting
Sensitivity

=

v

Tolerance Time of Alarm (sec.)
l Test

0 Jo §
Option
[[J Aautomatically disable alarm [Jinvoke Alarm
29C [ Output Module
[T] Skip instant light change [T Never Recycle ]
[ ok [ cance |
Figure 3-48
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Select a camera from the Camera Selection drop-down list.

If necessary, use the Mask Region function to mask off the area on the camera view where

motion will be ignored.
Select Unattended Object Size, and click the Camera icon to pause live images.

Outline Min Object Size on the camera view, and select Max Object Size from the drop-down list

and outline the maximum object size on the camera view.

To adjust the detection sensitivity, move the Sensitivity slider. The higher the value, the more

sensitive the system is for changes in the camera view.

To adjust the minimum time required for the alarm to be activated, adjust the Tolerance Time of

Alarm slider or specify a value in the blank.
Optionally configure these settings:

B Automatically Disable Alarm: Stops all types of triggered alerts, including computer alarm,
flashing boxes and output module after the specified duration. Disabling the alerts will not

disable alert settings and the detection in progress.

B Skip Instant Light Change: Ignores sudden illumination changes and avoids false alarms.
For example, light switches can cause illumination changes suddenly. With the option
selected, the system will ignore significant illumination changes without triggering the alarm
and continue monitoring. See the Note in Crowd Detection earlier in this chapter for possible

risk.

B Invoke Alarm: Enables the computer alarm when an unattended object is detected. Click the

[...] button next to the option to assign a .wav sound file.

B Output Module: Enables the output device when an unattended object is detected. Select

this option and use the drop-down list to assign an installed output module and a pin number.

B Never Recycle: With the option selected, the event files of unattended object detection will

not be recycled when the recycle threshold is reached.

You can click Test to test your settings. When an object is left unattended in the camera view, a
flashing box will appear on its location for warning. If the unattended object cannot be detected,

increase Sensitivity value to increase system sensitivity to changes in the camera view.
Click OK to apply the settings

Start monitoring to run the application. The detected crowd is indicated on the live view with

blinking red and green boxes.
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When any unattended object is detected in the camera view for the specified time, its location will be
highlighted on live view, the selected alarm or output will be activated, and the event will be recorded

as Advanced Unattended Object Detection in the System Log for later retrieval.

To manually stop all triggered alerts, click the Tools button % onthe triggered channel, select
Reset Alert and select Advanced Unattended Object Detection.

B Reset Alert: Disables and resets the triggered alert. After the alert is reset if the object remains
unattended over the specified tolerance time, the system will still detect it as an unattended

object and keep generating alert.

Note: Optionally create a schedule for Advanced Unattended Object Detection to be enabled only at

the time periods specified. For details, see Creating Schedules in Chapter 1.
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3.15 Advanced Missing Object Detection

The Advanced Missing Object Detection can generate an alert when any object disappears from the

camera view. This function can be applied to both indoor and outdoor environments.

Note: Up to 16 cameras can be configured for this application.

1. Click Home LS4 > Toolbar |+ > Configure ® > Video process. The Setup dialog box
appears.

2. From the Video Analysis drop-down list, select Advanced Missing Object Detection, select the

desired cameras, and then click Setting. This dialog box appears.

Advanced Missing Object Detection

Camera Selection
|Camera3 v|
Definition L
Define Object EREREAE -
Setting
Sensitivity 3
“
v
Tolerance Time of Alarm {sec.) E
s g é
o }—
J j [ Test ]
Option
[ Automatically disable alarm [Jinvoke Alarm
\i\ sec. [[] Output Module
[[] Skip instant light change [ Never Recycle @
[ ok ][ cance |
Figure 3-49

3. Select a camera from the Camera Selection drop-down list.

4. Click the IE button to outline the regions on the objects you want to detect. To cancel a
previously drawn area, click the button and outline the area. To remove all previously drawn
areas, click the IE button.

5. To adjust detection sensitivity, move the Sensitivity slider. The higher the value, the more

sensitive the system is for changes in the camera view.

6. To change the minimum duration required for the alarm to be activated, move the Tolerance Time

of Alarm slider or specify a value (in seconds) in the blank.
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7. In the Options section, configure these settings:

B Automatically Disable Alarm: Stops all types of triggered alerts, including sound alarm,
flashing boxes and output module after the specified duration. Disabling the alerts will not

disable alert settings and the detection in progress.

B Skip Instant Light Change: Ignores sudden illumination changes to avoid false alarms. For
example, light switches can cause illumination changes suddenly. With the option selected,
the system will ignore significant illumination changes and continue monitoring. See the Note

in Crowd Detection earlier in this chapter.

B Invoke Alarm: Enables the computer alarm when an object is detected to be missing. Click

the [...] button next to the option to assign a .wav sound file.

B Output Module: Enables the output device when an object is detected to be missing. Select

this option and use the drop-down list to assign an installed output module and a pin number.

B Never Recycle: With the option selected, the event files of missing object detection will not

be recycled when the recycle threshold is reached.

8. You can click Test to test your settings. When the defined object is missing, a flashing box will
appear on its location for warning. If the missing object cannot be detected, increase Sensitivity

value to increase system sensitivity to changes in the camera view.
9. Click OK to apply the settings.

10. Start monitoring to run the application. The detected crowd is indicated on the live view with

blinking red and green boxes.

When any object, which you have outlined the regions for, disappears from the camera view for the
specified time, its location will be highlighted in live view, the selected alarm or output will be activated,
and the event will be recorded as Advanced Missing Object Detection in the System Log for later

retrieval.

To manually stop all triggered alerts, click the Tools button 7 onthe triggered channel, select
Reset Alert and select Advanced Missing Object Detection.

B Reset Alert: Disables and resets the triggered alert. After the alert is reset if the object remains
missing over the specified tolerance time, the system will still detect it as a missing object and

keep generating alert.

Note: Optionally create a schedule for Advanced Missing Object Detection to be enabled only at the

time periods specified. For details, see Creating Schedules in Chapter 1.
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3.16 Text Overlay

You can align camera name, time stamp and triggered input name to different positions for each

channel.

1. Click Home 24 > Toolbar |~ > Configure ® > Video process. The Setup dialog box
appears.
2. From the Video Analysis drop-down list, select Text Overlay Setting, select the desired cameras,

and click Setting. This dialog box appears.

Text Overlay Setting IﬂH

{Pr\nt on video file vI

Enable

Alignment

Set Font

:
:

<

- 3
O

Figure 3-50
3. Select a camera from the drop-down list.
4. In the Options section, configure these settings:
B Print on video file: Displays camera ID, location name, date and time on recorded videos.

B Print on screen (Only for IO alarm): Displays the name of triggered input device on the
camera screen. For this function to work, it is required to map a camera to an input device,

see Other I/O Application Functions in Chapter 6.

B Embed Counting Results into Recorded Video: Displays counter results to recorded

videos. For details on establishing a counter alarm, see Object Counting later in this chapter.

B Print ASManager Text on Screen: Displays GV-ASManager data such as the license plate
number on the live view and recorded videos. For this function work, it is required to enable
the text overlay setting in GV-ASManager. See 5.6 Using Text Overlay, Chapter 5, in
GV-ASManager User’s Manual.

Note: Text overlay is not supported when standard format codec is enabled. To change this setting,
select Home [ .54 > Toolbar |-+ > Configure &} > Camera Install > Settings ¥4 of the

camera > General Setting and locate the Recording codec format field.

133



Q GeoUision:

B Alignment: Select how you want the camera information to be aligned on a camera screen.

B Set Font: Click to configure the font, font size, font style and related settings.

3.17 Fisheye View

A fisheye camera allows you to cover all angles of a location with just one camera. The circular fisheye
view can be dewarped into the following four view modes, and you can drag PTZ views to different

angles.

Note: To use the fisheye dewarping function, the graphic card supporting DirectX 10.1 or above is

required.

Y Y
o4

Bdn

Dual 180 degree: 2 180° views Single view: 1 PTZ view

Figure 3-51
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3.17.1 Setting up Fisheye View

1. To display the dewapred view, from the Content List, drag the fisheye camera (circular source

image) or one of the dewarpped views to the live view grid.

2. To change the dewarped settings, right-click the fisheye camera from the Content List > Fisheye

Settings. The Fisheye Setting window appears.

® Content List
: Layout

Camera (9)

> cv-mFDI301

= ™ GV-FER5303
< Monitor

™ quad View

Talk Back Toggle
™ qQuad_Left-Top

Video Process
™ Quad_Right-To

Fisheye Settings
™ quad_Left-Bottu/

™ qQuad_Right-Bottom

Figure 3-52
3. Right-click on the Fisheye Settings window > Fisheye Option to access the following settings:
[ | Camera Mode: You can choose among four view modes.
® Quad view: Composed of four PTZ views.
® 360 degree: Composed of two PTZ views and one 360° panoramic view.
® Dual 180 degree: Composed of two 180° views.

®  Single view: Composed of one PTZ view. This view mode supports the advanced
Picture-in-Picture (PIP) function, which allows you to have a close-up dewarped view

without missing the entire view of surveillance site.
m  Camera Position: Select Ceiling, Wall or Ground according to installation scenarios.

B Adjust Auto Pan Speed At Top-Left Channel: Select low, medium, or high speed to
enable Auto Pan for the PTZ view at the rotation speed of your choice. This option is only

available in Quad view, 360 degree and Single view.
B Zoom: Select Zoom In or Zoom Out and then click on the image.

m  Show Source Video At Top-Right Channel: Display the circular source image in the

top-right quadrant when Quad view is selected.
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B 360 Object Tracking: Only available in 360 degree view. Track and highlight detected
motion in live view. For details, see Object Tracking later in this chapter.

® Disable automatic zoom adjustment during 360 Object Tracking: Enabled by

default. When disabled, the zoom ratio will be kept at constant as configured.
m  Disable PIP: Disables the PIP function in Single View mode.

m  Guard Tour Setting: Only available in Single View mode. Enable to set up a virtual PTZ
tour using the defined preset points on live view. For details, see Virtual PTZ Tour later in

this chapter.

m  Settings:
Settings @
Wall Mount 180 View:
[T] wide View
Frame Rate Control ~| 3 Apply Al
[ OK ][ Cancel
Figure 3-53

® Wide View: Increases the height of the 180 degree view when camera position is set

to wall mount.

Wide View Disabled Wide View Enabled
Figure 3-54

® Frame Rate Control: Limits the frame rate of the fisheye live view to the number

specified here. Select Apply All to apply the frame rate control to other fisheye views.

4. Drag the dewarped fisheye views from the Content List to live view grids for display. You can drag

and drop PTZ view or 180 degree view to adjust the viewing angle.
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3.17.2 Setting up a Third-Party Fisheye Camera

You can also enable dewarping for 3 party fisheye cameras and access fisheye related functions.

1. Make sure you have connected the fisheye camera to GV-VMS. The camera should appear in the
Content List.

2. Select the camera lens type to dewarp the image.

A. Click Home 24 > Toolbar |+ > Configure # > Camera Install. The IP Device Setup
dialog box appears. Then click the Settings button % of the desired camera-

B. For the camera installed with an ImmerVision IMV1 Panorama Lens, select IMV1

Panomorph using the Camera Lens drop-down list.

C. For other third-party fisheye cameras, select Fisheye using the Camera Lens drop-down

list.

i Video Setting I
%) Audio Setting
2 General Setting General Setting CameraLens
CameraName:  Camerad

Video Attribute

Brightness: {1 50

Contrast: [} 0
.....
Saturation: {I 50
Stream Setting 0
Sharpness :
Main stream - P I E
Codec Selection :  [H264 = Gamma : 0 0
o
Image Orientation
Quality / Bitrate
® Ver [ Normal ] ( Horizontal Mirror ]
[ Quality : | Good = [ Vertical Flip ] ( Rotate 180 ]

CBR
l 10240 Kbps

Resolution

© 43
Main stream : [2560x1920 >

Video Lost / Connection Lost
[] Trigger output

[Mod. 1 ~] [pn.1 - ®

Figure 3-55

3. From the Content List, drag the fisheye camera (circular source image) or one of the dewarpped

fisheye images (e.g. Quad View) to the live view grid.

4. To access fisheye related functions, follow Step 2 to 4, Setting up Fisheye View earlier in this

chapter.
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5. To adjust the image alignment for optimal results, follow Steps 2 and 3, Setting up a Fisheye View
earlier in this chapter and select Image Alignment. In the dialog box, align the dotted circle with

the outer edge of the camera image, and then align it with the inner edge of the image frame.

Image Alignment

Outer Edge
Inner Edge

Figure 3-56

Note:

1. For GV-Fisheye Cameras, the image alignment function is only available on its Web interface.

2. Regardless of the view mode selected here, the hemispherical fisheye source image will be
recorded. When playing back fisheye events in ViewLog, GV-VMS can convert the source image
to different view modes according to your preference. To play back the events in fisheye view
mode, select ViewLog | = > Toolbar -+ > Content List B8 and select a dewarped view of

the camera.
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3.17.3 Object Tracking

You can set up object tracking in fisheye view to track a moving object. The function is only available
when the view mode is set to 360 degree. When motion is detected in the fisheye view, the top-right

channel will start tracking the moving object, which is highlighted in the 360-degree view at the bottom.

Figure 3-57
1. Set the fisheye view to 360 degree by following Step 1 - 3 in 3.17.1 Setting up Fisheye View and

selecting Camera Mode > 360 degree.

2. On the Fisheye Settings window, right-click the fisheye view > Fisheye Option > 360 Object

Tracking > Advanced Settings. This dialog box appears.

Digital Object Tracking X

Definition

@ Mask Region IZ]
O Object Size Min Object Size Bl e.
Dwell Time Of Motion [j sec. _“
I Schedule [“] Disable automatic zoom adjustment during 360 Object Tracking @ c | "
ancel
Figure 3-58
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B Mask Region: Use the mouse to outline a mask region where motion is ignored.
B Object Size: Click the @ button to pause the live view and then use the mouse to outline
the maximum and minimum size of the target object.

B Dwell Time of Motion: When the target object stops moving, the highlighted region and the
top-right channel will remain fixed for the number of seconds specified. Any new motion
detected during the dwell time is ignored to prevent the camera view from frequently jumping

from one region to another.

B Schedule: Click Schedule to set up the times to start object tracking.

3. To enable object tracking, on the Fisheye Settings window, right-click the fisheye view > Fisheye

Option > 360 Object Tracking > Tracking.

140



Video Analysis

3.17.4 Virtual PTZ Tour

You can set up a virtual PTZ tour to monitor important spots of your surveillance site. Before you start,

make sure your fisheye camera has been set to Single View mode.

1.  Set the fisheye view to Single view by following Step 1 - 3 in 3.17.1 Setting up Fisheye View and

selecting Camera Mode > Single view.

2.  Right-click the fisheye camera on the Content List > Fisheye Settings. The Fisheye Settings

window appears.

3. Right-click the fisheye view on the window > Fisheye Option > Guard Tour Setting. The Guard

Tour Setting dialog box appears along with the Fisheye Settings window.

4. On the Fisheye Settings window, move the live view to a desired starting point for the PTZ tour

by clicking on the inset window at the bottom right.
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5. Enable the settings, type a name for the current view and click Add. This view point (preset point)

appears under Preset ID.

Guard Tour Setting X

[~]Enable

Current Position

Name Home Add

Available Preset Setting

Preset ID Dwell Time
I Home w I | 10 | Sec.
Freview Apply Delete

Guard Tour List

Preset ID Dwell Time
Home 10
View Order
A Remove
W
Demo oK
Figure 3-59

6.  Specify the duration for the live view to stay on this preset point (dwell time). The default is 10

seconds.
7. Optionally click Preview to see a preview of the preset point.
8.  Click Apply. This preset point is added to Guard Tour Setup.
9. To add more preset points, repeat the steps above.

10. To change the order of the preset points, use the View Order drop-down list to move a preset

point up or down the list.
11. Optionally, click Demo to watch a preview of the PTZ tour.

12. Select OK to start the PTZ tour. To stop the PTZ tour, disable the function on the Guard Tour
Setting.
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3.18 Video Analysis by Camera

You can choose to process video analysis on the camera instead of on the GV-VMS system.

Currently only GV-BX2600 supports full video analysis functions running on the camera, including
Motion Detection, Intruder, People Count, Missing Object, Unattended Object, Loitering, and
Tampering Alarm functions. For all other camera models, only Motion Detection and GV-3D People

Counter are supported to process on the camera.

Note:
1. You can only choose either the camera or GV-VMS software to process video analysis.

2. The video analysis by camera function does not support GV Al-capable IP cameras (48xx,

58xx and 88xx series).

To access the feature, follow the steps:
1. Click Home | .©. >Toolbar 4| > Configure %¥ > Video Process.
2. In the Setup dialog box, select IPCVA, select the camera(s), and select Setting.

3. Select which video analysis to process on the camera.

IP Cam Video Analysis 5

IP Cam video analysis

Motion Detection

M

Gv 3D People Counter
Intruder
People Count
Missing Object
Unattended Object
Loitering

Tampering Alarm

[ OK ] [ Cancel

Figure 3-60

-

4. For motion detection option, click on the arrow button to activate the following functions:
A. Adjust the level of sensitivity by moving the slider to the desired value, with 1 being the least

sensitive and 10 being the most sensitive.

143



Q GeoUision:

B. Select the area of motion detection by drawing an area on the live view. You may draw 8

areas in maximum.

IP Cam Motion Setting X

Camera 1:

Cancel

Figure 3-61

All video analysis events detected on the camera will be recorded in the System Log. For example, if
you set up the People Count function on GV-BX2600, the following analysis results appear:

Monitor Table
Moritor | System | Login A Counter | Merge 7 Backup | Delete | Notfication | o | Playback
‘ Start Time End Time Device In Out
6/15/2015 10:50:12 6/15/2015 15:40:01 Cameral 155 271
6/15/2015 20:37:22 6/15/2015 20:38:34 Camera1 23 12
6/16/2015 16:10:34 6/16/2015 16:16:03 Cameral 67 0
Figure 3-62

5. For the function of GV-3D People Counter, select right beside GV-3D People Counter.
A. Type the IP address, ID and Password of GV-3D People Counter. Select Test to see if

GV-3D People Counter is properly connected. Select OK to establish connection.

g

Connect Setting

CameraZ :

P
192,168.0.66

Part
30

o}

admin

Password

[ Test ] [ OK ][ Cancel

Figure 3-63
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On the live view of the camera, select Tools i and Monitor. You will see the number of

people going pass the detection area of the camera.

Figure 3-64
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3.19 Heat Map

With the Heat Map feature, you can see the level of motion intensity in a region, which is represented
by different shades of colors. The visualized traffic data will inform you where people go through and

stay often. This feature is available in both live view and video playback.

Note: Stabilization and Defogging are not supported when Heat Map is enabled.

3.19.1 Enabling Heat Map

1. Click Home 24 > Toolbar |- > Configure # > Video process. The Setup dialog box
appears.

2. From the Video Analysis drop-down list, select Heat Map, select the desired cameras, and click

Setting. The Heat Map Settings dialog box appears.

3. Select a camera from the Camera drop-down list.

Heat Map Settings @
Camera

Setting
[¥]Enable Blending
Color Scheme

© Full-spectral color

| = |
* Single hue progression
|
Dwell Time (Sec.)
0
Detect Region
[¥] Show Selected Regions Test Time Elapsed
EEE

Figure 3-65

4. If you want to enable heat map on the live view, select Enable Blending.

Note: If t Enable Blending is unselected, heat map will not be displayed on live view, but heat

map analysis can still be accessed through video playback.

5. To specify a certain area for Heat Map analysis, click the plus sign IE and draw an area on the
live view. To exclude a selected area from analysis, click the minus sign , draw and crop the
area. To clear the whole selected area, click the X sign .
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Note: To draw a shape, click on the live view and draw a line, move the cursor to a different place

and click again. To complete the drawing, connect the end of two lines.

6.

10.

You can select from two color modes:

B Full-spectral color: The redder the hue, the higher the motion intensity; the bluer the hue,

the less motion intensity.

B Single hue progression: The darker the hue, the higher the motion intensity; the lighter the

hue, the less motion intensity.

Figure 3-66: Full-spectral color mode Figure 3-67: Single hue progression mode

Type the number of seconds under Dwell Sec to determine the number of seconds a motion

remains at an area before the Heat Map analysis starts.

To preview the effects, click the Test button. To clear all the preview results, click the Reset button.

Time Elapsed shows how much time has passed since your testing has started.
Click OK and start monitoring.

To clear the heat map results on the live view, click the Tools button ;] on the channel window

with heat map analysis, click Reset Alert, and click Heat Map.

v/ Monitor

Add to Bookmark

Reset Alert > I

Properties

Figure 3-68
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3.19.2 Accessing the Heat Map in Recordings

You can freely define a period of time and apply the heat map analysis in recordings.

1. On the ViewlLog player, right-click the desired image and select Heat Map. This dialogue box

appears.
Heat Map @

Heatmap Mode

@ Full-spectral color progression
[ e
Single hue progression

Time Span Setup
Start Time :

11122015 09:00

End Time :

11/13/2015 09:00 A
: 15:00 - 16:00 ]

Apply [ Reset ] [ Save

Figure 3-69
2. Select the color mode for the Heat Map analysis under Color Scheme.

3. Select the Start Time and End Time under Time Span Setup. You may move the slider under the

image to see the heat map analysis of each hour.
4. Click Apply to see the preview. To clear all the preview results, click the Reset button.

5. Click Save to save an image of the Heat Map analysis.

Note: The time interval for the Time Span Setup must be less than 24 hours.
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3.20 Event Alert through E-mail Notifications

You can choose to be notified of specific types of alert events through e-mail notifications. To fully
activate the function, see 1.6.4 Setting up E-mail Notifications to set up the e-mail server and be sure

that the settings of each type of events are configured in advance.

- -
1. Click Home "-“* > Toolbar E&X > Configure & > Video Process.

2. Click the arrow button next to Send Event Alerts. This dialog box appears.

F: b |
‘Setup | = |
EW Camera list Video Analysis
[ camerat Object Index -
[[] cameraz
Alert Events Setup ﬁ
ClearAll
E-Mail Setting
SelectAll
] Intruder
| advanced Unattended Object D...
| Advanced Scene Change Detect...
| advanced Missing Object Detect...
Send EventAlerts @ | Face Count
:| Heat Map g By Hour
Max 16 < | ] | r
Select 1 [ OK ] [ Cancel ]
4
Figure 3-70

3. Select types of events for e-mail notifications.

4. Click OK to apply the settings.

149



Q GeoUision:

3.21 PTZ Object Tracking

By combining a PTZ and a stationary camera, you can automatically track and zoom on a single

moving object on live view. You can also use only one PTZ camera for object tracking.

3.21.1 Dual-Camera Tracking

To automatically track an object, you need one PTZ camera set for tracking and one stationary camera
set for a fixed view. Install the PTZ camera and the stationary camera in close proximity of each other

so the focus and the camera view of both resemble each other.

Note: The Dual-Camera Tracking function is only supported by GV-PTZ010D, GV-SD220 Series,
GV-SD2723-IR / SD2733-IR / SD2300 / SD2301 / SD2411 / SD4825-IR / SD4834-IR,
GV-QSD5730-Indoor / Outdoor / QSD5731-IR.

1. Click Home & > Toolbar "+ > Configure LN Object Tracking Setup. The Object
Tracking Config dialog box appears.

2. Selecta PTZ Camera from the left drop-down list and a Fixed Camera from the right drop-down
list.

3. Select Enable Tracking and start the settings.

Object Tracking Config

Object Tracking [Advance Single Camera Tracking \

Selection Live tuning
Track Time(sec)
Pan 0 Ul » 10 @
uli 0 Idle Mode
Sensitivity 3 (8, Idle Time(sec)
5
Define Detect Region v @
Enable Mask
The priority of Object Tracking is higher than Advance Single Camera Tracking when both functions are enabled simultaneously.
[ OK ] [ Cancel ]
Figure 3-71
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Use the Pan, Tilt and Zoom sliders to adjust the current PTZ camera view.

Specify Tracking Duration in seconds for every tracking movement.

Specify Idle Mode and Idle Time. When the PTZ camera remains stationary for a specified time,
the camera can automatically move to a Home position, a Preset Point, or start an Auto setting.
Select Define Detection Region from the drop-down menu. Outline an area on the right (Fixed

Camera) image. You are prompted to confirm Detect Region.

Detect Region

Delete Detect Region

lection
ack Time(sec)

no

Cancel

Figure 3-72
Select Define Object Size from the drop-down menu. Outline the max and min object sizes for
tracking targets separately on the right (Fixed Camera) image. Every time when finishing the

outlining, you will be prompted to confirm Maximum Object Size or Minimum Object Size.

. Maximum Object Size
election
rack Time(sec)
10 Minimum Object Size
le Mode

- Cancel
le Timel(sec)
Figure 3-73
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9. Click Test and move an object through the camera view to see if its movement is tracked or not.
There are two major settings you have to observe in the test. 1) Tracking: Observe if the target
shown in the defined detection region is being tracked with a highlighted mask, and magnified
automatically in the left (PTZ) image. If not, increase the sensitivity degree. 2) Zooming: Observe
if the target is magnified in the left (PTZ) image clearly. If not, use the Live Tuning buttons to
adjust the level of zooming.

10. Click OK to apply the settings.

11. To start object tracking, click Toolbar ? , select Tools [ and select Object Tracking Start.

Tip: You can interrupt the PTZ tracking and take over the camera control by using PTZ Control
Panel, PC’s keyboard and GV accessories such as GV-Keyboard, GV-IR Remote Control, and
GV-Joystick. When the controlling device or panel is inactive for over 5 seconds, the PTZ camera will

go back for tracking.

Note: When multiple objects are moving at the same time, the camera will track the object with the

largest area.
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3.21.2 Single Camera Tracking

The Advanced Single Camera Tracking can track a moving object using only one PTZ camera. When

an object moves within the view of camera, the PTZ camera will follow its movement. When the object

is out of view, the PTZ camera can be set to return to a designated position.

Note: The Single Camera Tracking function is only supported by GV-PTZ010D, GV-SD200,
GV-SD220 Series, GV-SD2722-IR / SD2723-IR / SD2733-IR / SD2300 / SD2301 / SD2411.

1. Click Home k24 > Toolbar

Camera Tracking tab. This dialog box appears.

[ Object Tracking \ Advance Single Camera Tracking ‘
Setup Idle Mode
Enabie {rckng [Plesel v] IPresetZ =B
PT Speed 2 " Idle Time(sec)
Sensitivity 5 s 5
[¥] Support Zoom Function @
[Nmmal v
Enable Mask
The priority of Object Tracking is higher than Advance Single Camera Tracking when both functions are enabled simultaneously.
( OK ] [ cancel |
Figure 3-74

2. Select the camera from the PTZ Selection drop-down list.

3. Select Enable Tracking to start the following settings.

- > Configure LS Object Tracking Setup > Advanced Single

4, Select Support Zoom Function to be able to zoom in and out. Select Normal and the camera will

zoom in once on the moving object. Select Deep Zooming and the camera will zoom in three

times on the moving object.

5. Click the button to adjust the direction and zoom level of the camera.
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9.

To set the camera to return to its home position or a preset position when no motion is detected for
a certain time period, specify Idle Mode and Idle Time in seconds. Click the [E] button to
preview the designated position. Note that your camera will need to support home position and

preset position.

To outline an area where motion will be ignored, draw an area on the camera view and select Set
Mask on the dialog box that pops up. To remove the mask, draw an area bigger than the mask,

and click Remove Mask.

Click Test and move an object through the camera view to see if its movement is tracked or not. If
not, move the Sensitivity slider to increase the sensitivity of motion detection. If the tracking
speed is not fast enough, move the PTZ Speed slider to adjust the speed of PTZ movement. If you

have set up a mask, you can select Enable Mask to display the masked area during the test.

Click OK to apply the settings.

10. To start object tracking, click Toolbar %y > Tools O > Object Tracking Start.

Tip: You can interrupt the PTZ camera tracking and take over the camera control by using PTZ

Control Panel, PC’s keyboard and GV accessories such as GV-Keyboard, GV-IR Remote Control,

and GV-Joystick. When the controlling device or panel is inactive for over 5 seconds, the PTZ

camera will go back for tracking.

Note: When multiple objects are moving at the same time, the camera will track the object with the

largest area.
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3.22 Panoramic PTZ Object Tracking

With a single GV-Panoramic PTZ Camera (GV-PPTZ) or a pair of GV-Speed Dome Camera and
GV-Fisheye Camera, you can track moving objects on live view. The fisheye camera allows you to
monitor all angles of a location, while the speed dome can instantly point toward an area with just one
click on the fisheye live view. In addition to that, you can also set up object tracking on fisheye live view
to track a moving object automatically. When motion is detected in the fisheye, the speed dome will

start tracking the moving object in the 360 degree view, and the moving object will be highlighted.

To use a pair of GV-Speed Dome Camera and GV-Fisheye Camera for the object tracking, it is
required to pair up the speed dome and fisheye camera first. Right-click on either camera on the IP
Device Setup page, click Select PPTZ Camera, and then click the camera you are pairing to. The

speed dome will be grouped under the fisheye camera in the Content List.

=¥ IP Device Setup

o i} Status  Server address Port Video Resolution Bitrate Brand
Remote camera setting . . .
[ ] 192.168.6.32 80 . Tt GeoVision_GV-QSD5731-IR
I Select PPTZ Camera I ¥ MNone
x| [+ camera2icH 2 ]
| kJ

= P Camera1-Fisheye
e 360 View

™ PP View

™ cameraz-Speed Dome

Figure 3-75

Note:

1. To use a pair of GV-Speed Dome Camera and GV-Fisheye Camera for object tracking, install
the cameras in proximity of each other so the focus and the camera view of both resemble each
other.

2. The function is supported by GeoVision speed domes and fisheye cameras only. Refer to our

website for supported models: speed domes and fisheye cameras.
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3.22.1 Accessing the Live View

To access the live view, drag both the fisheye camera and speed dome channels in the Content List to
the live view grid. Click on the fisheye live view, and the speed dome will turn toward the selected

location.

Figure 3-76

3.22.2 Automatic Object Tracking

The PPTZ Automatic Object Tracking function only works in a 3-division live view. Follow the steps to

create the 3-division live view and to enable the PPTZ Object Tracking in the 360 View.

Ty

Figure 3-77
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1.  Click Home, select Toolbar, and select Content List.

2. Under Layout, click Add 0, and select Add Layout.

< Content List

© W &

Add Group

[E] Scan Window
B2 Default Layout
B Default

ME 3-Division GV-PPTZ7300

Figure 3-78

3.  Type the name of the layout under Name, select Customize, and click OK.

Add new Layout : )( |

Name

3-Division GV-PPTZ7300

Layout Setup
o T O

@] 2 X 2

(@ Customize...

o ][ one

Figure 3-79

" tocreate a2 x 2 live.

T e

Figure 3-80
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5. Select the 2 grids at the bottom, click Merge @ and click OK to merge the grids.

P&I

Merge

Codl ==

Figure 3-81
When the message “Do you want to assign the cameras to this layout automatically” appears, click
No to assign the camera channels manually instead.
Drag 360 View, SD View, FE View (for GV-PPPZ camera) or 360 View, PIP View, Speed Dome

camera (for the paired fisheye and speed dome cameras) to the live view grid.

£ 45076 GB | TEST198-PC = 3/15/2017 3:13:46 PM

2 Geolision GV-VMS = =
® Content List

o

™ 360 view

P FE view

> 5D View

Figure 3-86

After creating the 3-division live view, go through the steps below to enable the object tracking options.

8.

On the Content List, right-click the GV-PPTZ camera or the paired GV-Fisheye camera, and
select PPTZ Setup. The Fisheye Settings dialog box appears.

Manitar

Talk Back Toggle

Video Process

Figure 3-82
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9. Right-click on the Fisheye Settings dialog box and select Fisheye Option > Camera Mode > 360

View.

Fisheye Settings X

=2
PPTZ Alignment
Camera Mode
Camera Position
360 Object Tracking

Figure 3-83
10. Select 360 Object Tracking > Advanced Settings to customize the object tracking. For details,
see Object Tracking, Fisheye View earlier in this chapter.

11. Select 360 Object Tracking > Tracking to enable the object tracking.

Fisheye Settings X

PPTZ Alignment

Camera Mode

%

\
>
00 ObjctTackng > T

Advanced Settings

Camera Position

Figure 3-84
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3.23 Specifications

Feature Notes
e 1 GB of RAM required at minimum
Panorama View e 4 sets of panorama view for live view
monitoring
e 35 MB of RAM required per channel at
Defogging minimum
e Maximum of 64 channels
e 34 MB of RAM required per channel at
Stabilizer minimum
e Maximum of 4 channels
Crowd Detection e Maximum of 16 channels
Advanced Scene Change Detection /
Advanced Unattended Object Detection / e Maximum of 16 channels
Advanced Missing Object Detection
e 7 fpsand 6 MB of RAM required per channel at
Object Counting minimum
e Maximum of 32 channels
e 31 MB of RAM required per channel at
minimum
Privacy Mask e Maximum of 250 detection boxes
e The overall size of detection boxes cannot
exceed 102400 bytes.
Face Count e Maximum of 16 channels
. : ) e 7 fpsand 16 MB of RAM required per channel
Object Index / Object Monitor / Face o
Detection at milnlmum
e Maximum of 16 channels
Object Counting Yellow
Intrusion Alarm Red
) Object Index Blue
Detection
Box Color Face Count Green
Crowd Detection Blinking red and green
Advanced Missing Object Blinking red and green
Advanced Unattended Object | Blinking red and green

Specifications are subject to change without notice.

Note: To use two or more of the following functions simultaneously, at least 2 GB of RAM is required:

Advanced Video Analysis, Video Analysis, IP Camera and Pre-Record by Memory.
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Video Playback

Recorded videos can be played back using the following various software applications offered by

GV-VMS. Below summarizes their main characteristic to help you decide which application to use

under a given situation.

Application Description
A full-function player to play back video, search for a video event,
ViewlLog merge and export video and more. See Playing Back on ViewLog in
this chapter.
Object Search A more convenient tool to search video files recorded on motion or

alarm. See Object Search in this chapter.

Remote ViewLog Service

A program to retrieve files from a remote GV-VMS and it supports most
functions provided by the ViewLog player. See Remote ViewLog

Service in this chapter.

WebCam Server

A server that remotely accesses live view and play back recordings on
your Web browser without installing additional software. See Remote

Viewing in Chapter 7.

Single Player

A player that plays back the backup recorded files with simple and

easy playback functions. See Single Player in this chapter.
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4.1 Playing Back on ViewlLog

The ViewlLog is a video player that plays back recorded videos without affecting the recording in

process. To launch the ViewLog:

1. Select ViewLog || > Toolbar |\ > Content List BE.The Content List appears.

2. SelectAdd €& > Import from Live to import current live views to the playback screen. For
details on configuring the ViewLog layout, follow Step 2 to 5 of Arranging Live View Layouts in

Chapter 1.

B Content List

Add Layout

Add Group

Figure 4-1
3. Optionally drag and drop more cameras from the Content List to the playback screen.

4. On the timeline, click the arrows or click on the date to select a date from a pop-up calendar.

Camera Date Viewer X

4 O yi2gr2015 » QOO 4 October, 2014 »
Camera3 sun Mon Tue Wed Thu Fri Sat
All Gameras on Layout 1 2 3 4
‘2:54:1r @ Li_i;l 5 6 7 8 g9 10 11
1iz) 20 21 22 23 24 25
26 27 28 29 30 31
Figure 4-2

5. Click Play m to start playing back. For details, see ViewLog Control Panel later in this chapter.
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4.1.1 ViewlLog Window

2

MM
V.

0:20:13.192

13:46:23.000

l‘?.')ll.l.l. : < o« W 1=t (4] 2= o e Bt (¥ |
Figure 4-3
No. Name Description
1 Camera Name Indicates the camera name.
2 Camera View Displays the playback video.

Accesses the player’s various settings. From Setup (Toolbar >
Configure), you can enable/disable text overlay and audio timeline

3 Toolbar ) o ) )
during the playback, as well as configuring the size of the Preview
window (see ViewLog Control Panel later in this chapter).

4 Recorded Time Indicates the time of recording.

) o Indicates the recording date and reflects video recordings.

5 Recording Timeline

For details, see ViewLog Control Panel later in this chapter.

Contains typical playback control buttons. For details, see ViewLog
6 Playback Panel T
Control Panel later in this chapter.

7 Display All Database Displays the recording timelines of all camera channels.
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Select from the Filter pop-up window to display different event types

8 Filter L . .
in different colors on the timeline.

4.1.2 ViewlLog Control Panel

Preview Window
Move the cursor on the timeline to see a preview of recording. Click on the timeline to pause all

channels at the selected time. To change the size of the preview, click Toolbar ﬁa > Configure >

Setup.
Preview Window
Motion Event
(10 J <€ |/O Event
Never Recycle Event
Intrusion Event
< 0 121242015 * 10

Camera8

All Cameras on Layout

06:25:50 o @ > o) = |
Cursor Position

Figure 4-4
Timeline

Calendar

Focused Camera g ,;nd.the-clock Recording

All Cameras on Layout Motion Recording

< 0 122242095 * 10
Camera8 .
All Cameras on Layout -
06:25:50 | () @ O ) | 7 T [ (%]
A
Playback Time Play Mode -T
Previous Frame Audio A to B Mode Playback Speed
Rewind| Next Frame

Play / Pause

Figure 4-5
Colors in the timeline:
® Red: Motion / Intrusion / IO event recordings

®  Blue: Round-the-clock recordings

165



Q GeoUision:

Orange: Audio recordings
Yellow: Recordings retrieved from the SD cards of cameras when reconnecting after a
temporary disconnection

® Green: Never recycle event recordings

Note: Round-the-Clock events are shown as blue, except the following conditions:
1. If Register Motion Event or Intrusion is enabled, the timeline interval of the triggered event

becomes red.
2. If Webcam Service is enabled, the timeline interval becomes red when users log onto GV-VMS

remotely (such as using mobile applications).

Tip:
1. Right-click and drag on the timeline to have a quick access to various functions.

2. Click Display All Database 1 to access the timelines of all camera channels.

Backup
Delete
Save as Avi

Ohbject Search

Mark Never Recycle > b

16 17
[ 1 UnhMark Never Recycle 3
I I T

[¥]
L]
=]
w

a[1]m

Figure 4-6

Playback Mode Option

By default, the ViewLog is set to play back video in the Real Time mode. To change playback modes,
click on the ViewLog Control Panel.

B Frame by Frame (without audio): Plays back video frame by frame without audio; however,

playback can be delayed depending on the bandwidth and computer performance.

B Real Time: Plays back video on real time. Despite saving rendering time, this method drops

frames.
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A to B Playback Mode

When playing back videos, you can set a start frame and an end frame for auto-playing:

1.  To set the start frame, click E and double-click a time on the timeline.

2. To set the end frame, click E and double-click a time on the timeline.

3. The start time and end time are displayed besides A and B as illustrated below.

1z21:52 ) 14:12:19 [ an®

Figure 4-6
4. Click E to play back from frame A to B repeatedly.

5. To cancel this playback mode, click RN

Changing the Displayed Date on the Recording Timeline

You can directly drag the timeline to search and view recordings of a previous or next day with

recorded events.

1. Scroll the mouse wheel forth to enlarge the timeline. The default display of the timeline is 24 hours.

2. Click and drag the timeline back and forth. The timeline jumps between the recording days.

Date Search

Default
Timeline

Layou

23:54:27

Enlarged
Timeline

235427 O OO O 7

Figure 4-7
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4.1.3 Adjusting the Camera View

To adjust the image quality for the recorded videos, right-click on the camera view or click Tools
to access these settings:

Add to Bookmark

Object Search

Heat Map
Print

Effects

Property

Close

13:06:54.281 %

Figure 4-8

B Print: Prints the current image from the camera view. For details, see Printing Images later in this

chapter.
B Effects: Click to apply image effects.

© To take a snapshot of the current playback image, select Copy and then open a WORD or

Paint file to paste and save the image.

® To undo the last enabled effect, click Undo To Prev Action. To restore to its original video

settings, click Undo All Effects.
B Property:
® Show Caption: Enabled by default. Shows the camera name.

©® Keep Image Ratio: Change the camera view to its original ratio.
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4.1.4 Bookmarking Video Events in ViewlLog

You can bookmark desired recordings on the ViewlLog player.

1. Right-click a camera view and select Add to Bookmark.

Y

>Tools [0 > Bookmark. Double-click any
bookmark to move to the corresponding position on the timeline with Playback Scroll.

2. To access all the bookmarks, click Toolbar

W Book-Mark ==l
Camera All =
[ List Mode |

GV-UBX3301

GV-UBL2411

UEX3301 : Door faresd

Playback Scroll

Figure 4-9

3. You can select List Mode to present all the bookmarks in a list.

Note: The bookmarked video events will be marked as Never Recycle in the ViewLog.
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4.1.5 Merging and Exporting Video

You can merge several videos into a single AVI or EXE file and export it to the local computer.

Note: The maximum size of the exported file is 2 GB. Any file exceeding 2 GB will be split into

another file. A maximum of 16 channels are supported for merging and exporting multiple videos.

1. Click ViewLog "=l > Toolbar s Tools D > Save as Avi. This dialog box appears.

B Save Avi File

Start Time: End Time (24H):
[018 1131 [~ |oe:2638 [ 2018/ 131 [~ |[18:1236 [

Timeline —[ 06:26:36 g 18:12:36

Start — %

Export with New Privacy
Mask Region(s)
-Unrecoverable

Export with New Priv
Mask Region(s) ——
-Recoverable

Video Effect and
Camera Setting

Setting — ’( %

Figure 4-10

2. Click Video Effect and Camera Setting to select the camera channel(s) you wish to export.

3. Drag the timeline to define a starting and ending time of the video(s) to be exported.
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4. To configure the saving path and format of the exported video, click Setting 7" This dialog box

appears.

Set Locafion

CWsers\Public\VideosFile20200109000000000.avi

General Sefting

B %5

Standard Merge  Direct Merge (Higher Speed)

M compactMode ?

Audio Export

Date / Time
Export Resolution c
—

Use AES Encrypion

(]

O saveasExe ?

(] Add Copyright Text

Codec Selection

Codec: ? H264

Figure 4-11

[Set Location] Click [...] to assign a saving path.

[General Setting]

Standard Merge: Save a full-length video, containing the images of a single camera or

multiple cameras within the ViewLog, with recorded and non-recorded periods. A blank blue

screen will be displayed during the non-recorded periods. By default, Compact Mode is

selected to merge only the periods with recorded images.

Direct Merge (Higher Speed): Only available when exporting the videos of one channel. It

speeds up the video merging process and saves the video files in the codec in which it was

originally recorded. By default, Compact Mode is selected to save compact video files by

only exporting the key frames.

Note: When using Direct Merge (Higher Speed), the conversion time is significantly reduced,

but you will not be able to customize the following settings: codec selection, privacy mask

recoverability and digital watermark.
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Audio Export: Select Denoise to remove audio noises from the video, or select Channel

for audio exporting.

Date / Time: Select whether to show date and / or time stamps. You can also select the

stamp position, font type and size and text color on the images.

Export Resolution: Select a resolution for the exported video.

Watermark: Only available when the watermark is applied to the recorded video. Select to

include the watermark in the exported video.

Use AES Encryption: Select and type a 16-digit Secret Key, containing only letters and

numbers, to add additional security protection for the exported video.

Add Copyright Text: Select to stamp user-defined copyright texts to the recording being

exported.

®  Set Font: Click to set the font type and size as well as the position of the copyright
text on the recording image.

Save as Exe: Select to save files in EXE format to auto-play the files with any third-party

player. Enable this feature to play back video at the computer without installing GeoVision

codec.

[Codec Selection]

Geo H264: A codec created by GeoVision which provides better image quality, higher
frame rates and smaller file size than other standard codecs. When selected, the GeoVision
codec must be installed on the computer playing the exported video. Otherwise export the
files in EXE format to play the video at any computer.

WMV9, H.264 or MPEG4: The standard code allows users to play the video with Windows
Media Player or other third-party video players without using GeoVision codec. When

selected, the Privacy Mask you created in Save as AVI will be disabled.

5. Click the Start icon % to start exporting.

Note: Audio is not supported for videos exported in MPEG4 codec.
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To optionally include other features in the exported video, refer to the following:

Configuring Privacy Mask

Video Playback

To configure the Privacy Mask settings for the exported files, click Setting X and change the Codec

to Geo H264 first.

Save AviFile
@ 130000 3 (&) 235959 21| (a4n)

00:00:00

) 2359559

Figure 4-12

u Unrecoverable privacy mask: The block-out area(s) marked in black will not be

retrievable in the exported files.

u Recoverable privacy mask: The block-out area(s) marked in red can be retrievable
with the administrator’s ID and password.

To set up the block-out area(s), click and drag on the image and select Add or Delete.

Combining Special Effects

To combine special effects to the exported video, click the Video Effect + Camera Setting icon &

and select the desired effects for each of the cameras selected.

Camera Setting

‘ Camera name | Defog | Stabilizer [[] ‘ Password
Camera1 ] O pevess .
Camera2 [ O
GV-BX5300 | O

[ De-Interlace

Overlay's camera name and time

Overlay's POS
Figure 4-13
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Retaining Recoverable Block-out Areas

For recorded videos with Privacy Mask settings, by default, you can see the recoverable block-out
area(s) created in Main System when logging in with the administrator account. To retain the block-out
area(s) before exporting recorded videos, type a random ID and password in the fields or leave the

fields blank. For details on Privacy Mask, see Privacy Mask Protection in Chapter 3.

Camera Setting X
Camera name Defog Stabilizer (] D Password [{3
Cameral l:‘ l:‘ aaaaaaaaaaaaaa
Camera2 O 0O | e
GV-BX5300 O] N — S

De-Interlace
Overlay's camera name and time

Overlay's POS

Figure 4-14

Note: Only the administrator can set up the ID and password to retrieve or retain the recoverable
block-out area(s). To grant access right to Power Users and Users, see Granting Access Privileges to

Recoverable Areas in Chapter 3.
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4.1.6 Saving Images

You can take a snapshot and save the current camera view as an image file while the recorded video

is being played back.

1. Click from a camera channel on the ViewLog. The Save As dialog box appears.

[Stamp Text on the Image] Select to add text(s) to the image. Selecting Transparent Text will

create the stamps in transparent text.

[The image] Click on the image at the bottom to preview the stamp text. Click on the image again

to close the preview window.

2. Name the file, select a file format and assign the location to save the image file.

4.1.7 Printing Images

1. Right-click a camera channel on the ViewLog and select Print. This dialog box appears.

Page Setup >

Image Ratio and Position
[Juse Template

Mresenve aspectratiol
Width - | 132

Height: |132

] Align to center
PosX: & Pixels

PosY: [937 Pixels

prn
Print Setup Cancel

Text Stamp and Position
Print host name. ® ﬁ e} ﬁ
Print camera name.
[ Printimage date.

[ Printimage time. @] E o] @
[JPrint note

Set Font

Figure 4-15
[Image Ratio and Position] Adds a template or changes the size of the image and its position on
the page.
[Text Stamp and Position] Adds texts to the printed image. To include a note below the image,

select Print note and type a note in the blank space below, up to 64 characters.

2. Click OK to save the settings or Print to print out the page.
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4.1.8 Adjusting Distorted Views

When viewing videos on the ViewLog player, images may be curved near the corners. Correct this

distortion using the Wide Angle Lens Dewarping feature.

1. Click ViewLog '=! > Toolbar |-+ > Configure %} > Effect > Wide Angle Lens Dewarping.

Select the cameras to apply Wide Angle Lens Dewarping.
To adjust the degree of adjustment, click the {,Ej-}" button. This dialog box appears.

Wide Angle Dewarping Setting

e
e
s

'
'S
i=2
e

\ [

Original Image

Settings

Field of View Angle
D 84 degree

Figure 4-16
Move the slider to adjust the degree of warping. The adjusted view is shown on the right.
Select Apply All to apply the setting to all the cameras selected.

Click OK. The cameras are immediately dewarped.
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4.2 Object Search

Object Search allows you to define the regions of interest on recorded videos to search for missing
objects, unattended objects and motion events, as well as counting the number of objects entering and

leaving the defined regions.

1. Select ViewLog | =/, click the desired channel and select Toolbar ~ >Tools O > Object

Search. This window appears.

Just Key Frame

Event Type Sealrch ‘ Setting
| |

| |
Unattended Object v m )&

Event Playing Area

l a——

o o

Occurrence of Event Play / Pause Button Search Result Event Timeline

Figure 4-17

2. Define a time range for search. And click the Play button to display images of the defined time

range.
3. Select an event type from the drop-down list w .

4. Click Setting &
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5. Click on the image to add detection regions or define object sizes. You can also adjust the

sensitivity level of the added detection regions.

Setting
Option
O
OD
Sensitivity: 3 L}

| Concal |

Figure 4-18
6. Click Just Key Frame [ to search only key frames if necessary.
7. Click Search £ The search results are shown in blue on the timeline.

8. Double-click a frame or click the Play button to view the event.

“.I””” ' - - ””l”i
: i

3w s 3 a e 13310 S 53151000 28 114 s sie e e
I BN NN N e | M B || N D NN N B 0N | —_—— L B |
/%1830 8 W

Corresponding Search Result

Figure 4-19
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4.3 Advanced Log Browser

With the Advanced Log Browser, you can search for log data of events, system activities, user

activities, Object Countin

1. Click ViewLog | =

g events and more. For live system logs, see System Log in Chapter 1.

> Toolbar -« >Tools [ > System Log > Advanced. The Open

Database dialog box appears.

2. Specify a time range and click OK. All events within the specified range are displayed on the

Advanced Log Brow

ser.

Controls on the Advanced Log Browser

| Event §sts Frorh 2013/82/26 toP018/03/28 - Adyanced Log Browger - O X

Fil} Took Vieg Hel

e ST = 13 | n | o
5@V =3 G| @l Monitor ‘

ID Time Device Information Event Note LA

1 2018/02/27 10:49:53 Camerad Camera Connecti...

2 2018/02/27 10:49:55 Camera1 Camera Connecti...

3 2018/02/27 10:49:55 Camera2 Camera Connecti...

4 2018/02/27 10:49:55 Camerat Video Resume

5 2018/02/27 10:49:55 Camera2 Video Resume

6 2018/02/27 10:50:00 Camerad Video Resume

7 2018/02/27 10:50:05 Camera4d Camera Connecti...

g 2018/02/27 10:50:13 Camera4 Camera Connecti...

9 2018/02/27 10:50:22 Camera4 Camera Connecti...

10 2018/02/27 10:50:28 Camerad Camera Connecti...

Figure 4-20
No. Name Description
1  Open Opens an event log.
2 Reload Select Reload All Table or Reload Current Table to refresh loaded data.
3 Filter Defines the search criteria. See Filter Settings later in this chapter.
Select All Tables to back up all log data, or selects Current Table to back up
4  Backup the current log table you are at. By default, audio and video are enabled for
backup.
5 Print Prints the current log table.
Filtering / Only available when filtering starts. Click to cancel the filtering. After the

Cancel Filtering

filtering is complete, this icon appears dimmed.

7 Counter Table

Only available when selecting Counter as the Log Type. Click to display the

sums of the In and Out counting numbers of cameras with counting function.

8 Log Type

Select to display log of the following type: monitor, login, system, counter,

merge, delete, backup, I/0O, notifications, playback, CMS, and POS.
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4.3.1 Filter Settings

You can define filter criteria to search for the desired log data. You can also import pre-defined filter

settings for the log search, or save current filter settings for future use.

1.  On the toolbar, click the desired log type, click the Filter button (No. 3, Figure 4-20) > Default
Filter. This dialog box appears.

Monitor Filter ®
[v Device [v Informstion [v Event
[camera1 v | | | [mocuie 1 ||| wation =l
v Time
Coae C Tme @ oo
srseons v|ooomon I~ [ arsmons o|jemssss pe—
Al Meswy Cotmmancd | | Imgport | Export |
Time Device | Infarmation | Evert | DST
3502003 ~ 3502003 11:59:59 PM Camera 1 Module 1 Motion

4 »

Mote: all commands are operated by '"OR!

Figure 4-21
Define the filter criteria, such as a specific camera, an event and a time range.
To search for the log data recorded during Daylight Saving Time, select DST Rollback.

To add more filter criteria, click Add New Command and repeat Step 2.

o & e DN

Optionally click Export to save the current settings to another location, or click Import to apply
other filter settings.

6. Click OK to display the filter results.

Tip: Next time when you want to use the same exported settings, click the Filter button >

Favorites, and select the name of the export file.

Note: The default Export path is :\GV folder\Syslog_Favorites\Monitor. If you change the saving

path, the name of the export file will not be listed in the Favorites option.
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4.4 Remote Viewlog Service

You can retrieve the files from a remote GV-VMS through the network using the Remote ViewlLog

Service.

GV-Remote ViewlLog V2:

® supports most of the functions provided by the ViewLog, such as Backup, Save as AVI, Object
Search, Database Files Backup, described earlier in the chapter.

® s capable of disabling camera connections under heavy network load

® can back up recordings from a remote GV-VMS

Note: GV-Remote ViewlLog V2 has enhanced user interfaces compared to previous GV-Remote
ViewLog. Currently, not all the features in GV-Remote ViewLog are available on GV-Remote ViewLog
V2.

4.4.1 Retrieving Recorded Videos from GV-VMS

1. On GV-VMS, click Home L4 > Toolbar |-+ > Network &a > Control Center Server >
Remote ViewLog Service to allow remote access.

2. Download GV-Remote ViewLog V2 to a PC from GeoVision’s website.

3. Run GV-Remote ViewLog V2 and create a Remote ViewLog account. After creating an account,
the Add New Host dialog box appears.

4. Inthe Host Type, select DVR / NVR / VMS.
Type the Name (for reference), IP Address, Account and Password of GV-VMS. Only modify
the default port 5552 if necessary.

6. Click OK.

For details, see GV-Remote ViewLog V2 Guide.
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4.4.2 Retrieving Images of Object Index

The images of Object Index include the Object Index, Face Detection and Video Snapshot. With the
Remote ViewLog Service, you can retrieve all the Object Index images from a GV-VMS through the

network.

1. On the toolbar, select Tools > Search Object Index.

2. On the Object Index Search window, select the desired camera and file date for playback.

[
3. Click the Refresh button | ~* to refresh the date and time.

4. To play images with the ViewLog player, double-click the desired frame on Object Index List.

4.4.3 Recording Backup

Using the Remote ViewLog Service, you can back up files from remote GV-VMS. When the file

transfer is interrupted by a network error, you can even resume backup.

1. To back up the recordings, on the toolbar, select Tools = > Backup.

2. When the backup is interrupted, this message will appear: There are x file(s) couldn’t be backup.
Do you want to keep a log file and backup them later?

3. Click Yes. You will be prompted to save the partial backup file as *Iv format.

4. To resume backup, click the Resume button at the bottom of the Backup dialog box and locate the

partial backup file to continue.

For details, see Backing Up Recorded Files in Chapter 5.
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4.4.4 Exporting and Importing Host List

You can export and import the host list to and from another GV-Remote ViewLog. Click the Tools

button under Camera List to access these functions.

™ Camera List A

olmﬂﬁl-x I

= M DVR /NVR VIS

e 1-PC

Figure 4-22

4.4.5 Displaying Sub Stream

To reduce network latency when playing back multiple channels, you can choose to display the sub
stream of smaller image size from the connected hosts if the dual-stream recordings are available. To

do so, on the toolbar, click Display ## > Display Dual Stream First.

183



Q GeoUision:

4.5 Single Player

When backing up recorded files, you can choose to include the ViewLog player or Single Player (see
Backing up Recorded Files in Chapter 5). Compared to the ViewLog, the Single Player provides
simpler and easier playback functions. To play back the recorded videos using the Single Player, open

the backup folder and run GVSinglePlayer.exe.

4.5.1 The Single Player Window

Click Files > Open File to select the file you wish to play back. To play back multiple recorded files
together in up to 16 screen divisions, click Files > Open Folder to select the folder that collects

several camera recordings.

GVSinglePlayer

Open File :J—» '”: B Thvi Y ‘.47 Gl = — \- B ” V
L Ay b

Open Folder / / 5 . o S

Exit P, A it

Download y - 4 E * ‘ ’

7 “ Ao

Figure 4-23
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4.6 Specifications

Video Playback

Feature

Notes

Support for Defogging

Yes (64 channels)

Support for Stabilizer

Yes (64 channels)

Support for PIP View

Yes

Support for PAP View

Yes

Support for Panorama View

Yes (4 sets of Panorama View )

Videos Exported as .AVI Files Yes
Object Search Yes
Support for Fisheye View Yes
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Backup, Deletion and Repair

This chapter explains how to back up and delete video/audio files on the hard disk. Video files can be

copied to external storage media, such as CD-R, DVD, MO, or ZIP drives.

5.1 Backing up Log Data

Using the System Log, you can back up all log data or filtered data based on criteria.

v

1. Click ViewLog '=! > Toolbar |-+ >Tools [ > System Log > Advanced. The Open

Database dialog box appears.
2. Specify a time range and click OK. Events recorded during the specified range are displayed on

the Advanced Log Browser window.

3. Click Backup ;«Eﬁj on the toolbar. The Customer Database Export dialog box appears.
[Table Option] Select All Tables to back up all log data or Current Table for the log table you

are currently at.
[Export with Video/Audio data] Backs up video/audio attachments with log data.
4. Click OK. The Backup dialog box (Figure 5-1) appears.

5. In the Media section, select the method and destination to back up the log files and click OK to

back up.

Note:

1. To back up the filtered data, use the Filter function to define search criteria first. See Filter

Settings, Advanced Log Browser in Chapter 4.

2. To open the backup data, run EZSysLog.exe from the backup file.
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5.2 Backing up Recorded Files

1. Click ViewLog '=! > Toolbar |-+ >Tools [ > Backup. This dialog box appears.

Backup
IMedia Add time frame
) Using Hard Disk

CISIBKZ20141216\

Backup Folder Mame :

SIBK20141216

EN [ DV-W520GIM :470GB] v]

Burning Software :

]
) Using 05-Burning )
IMedia Information
-Usecl Size : 120.65 MB
Free Size: 458 GB Include Player
Total Size : 470 GB ['\."iewlog v]
Erase Rewritable Disc Add time frame ] OK
Figure 5-1

2. Select a destination media to back up files.
[Media]
B Using Hard Disk: Click the [...] button to select the desired hard disk.
B Backup Folder Name: Type a desired name for the backup folder.
B Using CD/DVD/BD: Click to back up files to the CD or DVD media using the third-party
software.

» Click the [...] button to assign the desired burning software (.exe file). After clicking OK
on the Backup dialog box (Figure 5-1), the system will ask you to paste the backup files
to the CDR-Writer program, and call up the assigned burning software for you to paste
and backup files.

» If Nero software of version 6.6.0.14 or later is installed, you can directly burn the files
onto CD/DVD without assigning the burning software and pasting the backup files to the
CDR-Writer program.

» If Nero software of version 7.0 or later is installed, you can directly burn the files to

blu-ray disc.
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Using OS-Burning: It burns files using the inbuilt software of the operation system onto the

DVD, CD or blu-ray disc. Note that your hard disk needs at least 1 GB buffer space.

[Media Information] Indicates free and used space on CD/DVD media or the local disk.

Click the Add Time Frame button to define a time period and which files to back up.

-

Select Backup Time

Time Period @ Information

S [V 42015 [v | - 00:00:00 . Status Search End
End Time : 1 42015 [[v - 235959 z jioialEvents 0
Total MDB : 0

Total Object Index : 0

Total Bookmarks : 0

Advanced Setting : Used Size : 0 Bytes
Select Camera(s) o ) |
™ Camera1 0+0 \

i

Video +Audio Event |

Cancel |
Figure 5-2

[Time Period] Specify the time periods for backup.

[Information] Indicates the number of backup files and their total size. (Total MDB refers to the

System Log files.)

[Advanced Setting]: Click to choose which files to back up:

B Database Files: Backs up the System Log files.

B Object Index Files: Backs up the Object Index files.

B Never-Recycle Events only: Only backs up the never-recycle events.

Unmark these events to be recycled after the backup is complete: After the backup is

complete, the never-recycle events will be unmarked for recycling.

Saving Time.

B Bookmarked files: Backs up the bookmarked files.
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[Select Camera(s)] Select the camera(s) for backup. The number of video and audio files of
each camera is indicated respectively, e.g. “Camera 1 1+0” means Camera 1 has 1 video file and

0 audio file.
B Video + Audio drop-down list: Select the types of video events for backup.
4. Click OK to add the schedule. You can repeat step 3 to create up to 10 periods of time.

5. Toinclude the player to the backup files, select Include Player at the right bottom of the Backup
dialog box and select ViewLog or Single Player. By default, ViewLog is selected. If no player is

selected, you can only play the backup files at the computer installed with GeoVision codec.

6. Click OK on the Backup dialog box to start the backup.

Note:

1. If you are unable to record a CD, make sure the CD recording is enabled in your CD burner:
open My Computer, right-click the CD Drive icon, click Properties, click the Recording tab,

and check Enable CD recording on this drive.

2. For details on the ViewLog player and Single Player, see Chapter 4 Video Playback.
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Deleting Recorded Files

1. To delete files using the ViewLog, click ViewLog |=| > Toolbar -+ >Tools [ > Delete. This
dialog box appears.
Delete
Time Pericd
Start Time : E-'21.-'2014 - |- 00:00:52 =
End Time : 10/21/2014 - - 235853 =
Select Camera(s) =0
Camera(s) Files Status
Camera 1 0+0 Ready
Camera 2 0+0 Ready
Camera 3 0+0 Ready
Camera 4 0+0 Ready
Camera s 0+0 Ready
Camera 6 0+0 Ready
['\."ideo +Audio Event -
[ Include Never-Recycle Event.
[T Include daylight saving rollback events.
Total Event 0
Total Size : 0 Bytes
Delete
Figure 5-3
2. Define the time period for file deletion.
3. Uncheck the cameras, which you don’t want to delete the files of.
4. Use the drop-down list to select the types of events to be deleted, e.g. video, audio or both
together.
5. To delete the never-recycle events, select Include Never-Recycle Event.
6. To delete the events recorded during Daylight Saving Time, select Include Day Light Saving
Time Rollback Event.
7. Click the Delete button.
Note:
1. To view the history of file deletion, click ViewLog =| >Toolbar |+ >Tools [ > System

Log > Monitor Table, and click the Delete tab.

2. To view the storage path and total file size of a camera, right-click the camera and select Event

View on the Delete dialog box.
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5.4 Repairing Damaged File Paths

Use the Delete function (see Deleting Recorded Files earlier in this chapter) to correctly delete video
and audio files. If you move or delete video files using Windows Explorer or Windows File Manager,
GV-VMS will not be able to detect this change. But as long as these files are still stored in the hard
drives and are detectable by Windows operating system, you can use the Utility to restore these
misplaced and missing recorded files back to their default paths. This Utility comes with the installation

of Main System. Follow these steps to repair the paths.

1. Go to Windows Start > All Programs > GV-VMS folder > Repair Database Utility.
2.  When the Select Camera for Repair Database dialog box appears, select the cameras that

require database repair and click OK. This dialog box appears.

% RepairDB - X

Default Path
D7Record\

(O Background repair
(® Immediately repair
[/ Reserve Never-Recycle Flag

[4 Rebuild all information(time requires is depended on the database size)

Use Default Path

Search Hard disk BExit

Figure 5-4

3. Select Background repair for a quick scan of the files needing repairs. This function allows the
utility to repair the files after the scan is completed while GV-VMS continues its operation. Select
Immediately repair to thoroughly repair your recorded files while GV-VMS is closed.

4. If your recorded files exist only in the predefined recording path, click the Use Default Path button

to rebuild the file path in the predefined recording hard drive only.

192



Backup, Deletion and Repair

5. For Immediately repair only: If your recorded files scatter across different hard drives, click the
Search Hard Disk button to allow more time to rebuild these file paths in the hard drives
connected to GV-VMS.

6. Click OK.

Note:

1. The repair and the search function will not apply to the files that have been renamed manually.

2. Use this Utility to repair your database if any of the following scenarios occurs in the ViewLog:
a. Aquestion mark appears right before a video file in the Video Event list.

b. When you select a file and click the Playback button, no video is displayed.

5.5 Repairing Damaged Video Files

If the computer has been shut down improperly, e.g. due to power failure, use this function to repair

damaged video files.

Tip: When a computer has been shut down improperly, the first thing you do before starting GV-VMS
is to run Repair Database Utility. After running the Utility, go to the ViewLog and check video
events. You should be able to play all video files at this step. However, if you see a question mark
after clicking on a file, the problem may be that its recording process was interrupted. To repair the

file, run the AVI Repair Utility and follow the steps below.

1. Double-click AVIRepairAPl.exe in the GV folder. This dialog box appears.

& A¥IRepair X

1. Select source file to repair.

Browse

Source File Path D:AGY1 480 cam1 7AD30MEvent2003030421 4623017 .avi

2. Select repair method.(AVI file only)

" Auto & Sianuak

Cornpression Type Resolution

MPEGA - 320 x [240

3. Click"Repait” to start

Repair
e |

Figure 5-5

2. Click the Browse button to find the damaged video file.
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3. If you know the codec and resolution of the file, select Manual, select Compression Type and
type Resolution. Alternatively, select Auto but it takes longer time to repair with this selection.

4. Click the Repair button to start.
You may see the distorted image or No Image on view screen if an incorrect codec and resolution

were chosen. Click No for the next combination until a complete image appears.

Distorted Image No Image Complete Image

e ®

b | ®
Resolution 320%240 Resolution 640x480 Resolution 320x240
Compression Type MPEG-4 Compression Type MPEG-4 Compression Type Geo MPEG4 (ASP)
Do you acceptthis video? Do yau accept this videa? Do you accept this video?
N No | Cancel | Yes ‘ No ‘ Cancel ‘ s No Cancel I
Figure 5-6 Figure 5-7 Figure 5-8

6. When a complete image is displayed, click the arrow button to preview the file.
7. Click Yes to start the repair.
8. Click Yes to overwrite or No to save this file to another path. Note if you choose No at this step,

remember to run Repair Database Utility again after exiting this program.
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I/0 Applications

6.1

This chapter discusses how you can set up and control the 1/0 devices connected to GV-VMS. I/1O

applications include these features:

Record videos, send e-mail notifications and trigger outputs upon input trigger

Move the PTZ camera to a preset location on input trigger

Support access control systems of Momentary and Maintained modes

Visual automation to intuitively trigger an output by clicking on the camera view

Setting up 1/0 Devices

To connect the I/O device to the computer of GV-VMS, you may need additional devices: GV-Net,
GV-Net Card, GV-NET/IO Card or GV-I/O Box. For details, visit GeoVision website.

To set up I/0O devices on GV-VMS, click Home H > Toolbar k&l > Configure L * SN
Accessories (if available) > 1/0O Device (if available) > I1/0 Device Setup. This dialog box appears.

1/0 Device Setup ===
[ add | [ Remove | [ moafy | o[s] mput1
Name
Module Device Description E=is
Signal Type
nNfo nNjc Latch Trigger
| output1
Mame
Enable ELEE
Signai Type
Njo N/ Toggle N/ Puise -
NiC N/C Toggle NjC Puse
[ oK ] | Cancel
Figure 6-1

Note: The Accessories option only appears when GV-Keyboard or GV-Joystick has been set up on

GV-VMS. The I/O Device option only appears after at least one 1/0O device has been added.

196


http://www.geovision.com.tw/products.php?c1=72

n /O Applications

6.1.1 Adding I/O Devices

To add an 1/O device to GV-VMS, click the Add button in 1/0O Device Setup dialog box.

L0 Device Setup
10BoX U58 )
" GV IP device
I0BOX (IF)

Figure 6-2

There are three ways to add an 1/O device:

I/0 Box (USB): Select if GV-VMS is connected to the GV-1/0 Box through USB connection.
1. Select the type of Device connected.
2. Select the COM port used to connect the device.
3. Assign an Addr. number to the device. Start by setting the first device to 1, and then assign a

different address for every new device added.

IP Device: GV-VMS can remotely control the 1/0 devices connected to GV-IP Devices through

network connection. Select the GV-IP Device with 1/0 devices installed and click the

button.

1/0 Box (IP): GV-VMS can remotely control the 1/0 devices connected to GV-1/O Boxes through
network connection.
1. Click the Search button to search for available devices under LAN or click the Add button to
manually type the connection information of the device.

2. Select the device and click the button. Type the User Name and Password if

needed.
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6.1.2 Setting up Input and Output Devices

After adding the I/O device, enable the input and output device. For GV-I/O Boxes connected through
USB, you can configure the signal type on GV-VMS. For GV-IP Devices and GV-I/0O Boxes connected

through a network, you will have to configure the signal type on the device’s Web interface.

[Input X] Click the Arrow buttons to select the input device and click Enable.

Sync Web U/
Se/el’ctI Input Apply to all Inputs
]

4 | Imput 1
Name F}

Input1 [@  [Menable

: Apply This -
Sigrie Type Apply Al e

Figure 6-3

B Name: Name each input pin. Click the left Arrow button and select Apply This to sync the name
of the specified input pin with that on the 1/0 device’s Web interface. Optionally select Apply All to

sync all names of the input pins with the ones on the I/O device’ Web interface.

B Signal Type: Select a signal type for your input device: NO (normally open), NC (normally close)

or Latch Trigger. For details on Latch Trigger, see Latch Trigger later in this chapter.

[Output X] Click the Arrow buttons to select the output device and click Enable.

Sync Web U/
Select Output Apply to all Outputs

LI I

1 v| Output 1

Name F:

' t1 0 — Force Output

[opt: | Apply This =

Signal Type Apphy Al 1
S I - ; Sec

C C Toggle I IC Pulse

Keep Last Toggle Status

Figure 6-4
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Name: Name each output pin. Click the left Arrow button and select Apply This to sync the name
of the specified output pin with that on the I/O device’s Web interface. Optionally select Apply All
to sync all names of the output pins with the ones on the I/O device’ Web interface.

Force Output: Click to test signal to the selected device.

Signal Type: Select a signal type: N/O (Normal Open), N/O Toggle, N/O Pulse, N/C (Normal
Closed), N/C Toggle, and N/C Pulse. For Toggle output type, the output continues to be triggered
until a new input trigger ends the output. For Pulse output type, the output is triggered for the

amount of time you specify in Sec field.

B Keep Last Toggle Status: See Keeping Last Toggle Status later in this chapter.

Note:

1.
2.

PTZ camera and I/O devices cannot be assigned to the same port at the same time.
To sync all input / output pin names with those on 1/O device’'s Web interface, right-click the I/O

device on the list and select Module Pin Name Sync with Web UI.

110 Dewvice Setup *

Add Remave Modify 4 v Inputl

Modue  Device Description Input1 hnebe

L 1f0Box (IF)  I0BOX-01(192. 168.5.

Module Pin Name Sync with Web Ul

]

+v| Output

Name F:
output 1 |§| [F]Enabie Force Output
signal Type ¥
|I Sec
N/C N/C Toagle NJC Pulse
——
Figure 6-5
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6.1.3 Latch Trigger

Instead of constant output alarm in N/O and N/C during the input trigger, the Latch Trigger option

provides a momentary output trigger.

Setting up Latch Trigger
In the 1/0 Device dialog box (Figure 6-1), select Latch Trigger.

(S0
»| Input 4
Name I
Input4 Enable
Signal Type %2
@no  One Erree

» | Output1

4
Mame I
QOutput1 Enable Force Output

Monitor Input

[¥|Rec. video: 30 Sec M
Signal Type Invoke Alarm:
©No  ON/OTooge B @NoPuke o Sec [¥] Invoke to Send Alerts:
EINjC (1 NJC Toggle ) NfC Pulse
Floutput Module:  [Mod.3  ~[pin.7 ]
( ox | [ concel [¥| Register Input Event
I/O Device Setup I/O Application Setting
Figure 6-6

Application Example

In the above scenario, Input 4 is set to N/O and Latch Trigger. When Input 4 is triggered:

® The camera starts recording for 30 seconds using the frame rate settings for Urgent Event and
stops itself when the next input triggers (see the Rec Video option in the blue box).
Computer Alarm sounds once (see the Invoke Alarm option).
The output (Module 3, Pin 7) is triggered simultaneously based on the Latch Trigger mode (see
the illustrations below).

The following illustrations can help you understand different output signals (see purple square in the

above dialog box) working with the Latch Trigger option.

200



n /O Applications

1. N/O (Normal Open) + Latch Trigger
Once the input triggers the output, the output will be triggered for a short moment and then turn off

itself.
N/C N/C N/C N/C
Input
Output
N/O N/O N/O N/O N/O N/O

2. N/O Toggle + Latch Trigger
Once the input triggers the output, the output will keep triggering until a new input trigger.

N/C N/C N/C N/C
Input
Output
N/O N/O N/O N/O
1st Input Trigger 2nd Input Trigger

3. N/O Pulse + Latch Trigger
Suppose you set the Pulse time to 60 seconds. Once the input triggers the output, the output will

remain ON for 60 seconds before turning off itself.
N/C N/C N/C N/C

60

60
sec

sec

Input
Output

N/O N/O N/O N/O
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6.1.4 Keeping Last Toggle Status

This feature can memorize the current output state when the monitoring is stopped or the system is

restarted. For example, if the output device is a light, the triggered light will remain ON when you stop
monitoring.

Setting up “Keep Last Toggle Status”
In the 1/0 Device dialog box (Figure 6-1), select N/O Toggle or N/C Toggle, and click the Arrow button
on the right to select Keep Last Toggle Status.

Signal Type F‘:
CINjO (@ NjO Toggle (71 NjO Pulse - o
CINfC (71 NJC Toggle v Keep Last Toggle Status |

Figure 6-7

Application Example

The following two illustrations explain how the input works with the output set to Keep Last Toggle
Status.

1. Input (N/O) + Output (N/O Toggle + Keep Last Toggle Status)

The triggered output remains ON even when you stop monitoring or restart the system.

N/C N/C N/C
Input
Output N/O N/O N/O
1st Input Trigger 2nd Input Trigger

Stop monitoring /
Restart the system
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2. Input (N/O + Latch Trigger) + Output (N/O Toggle + Keep Last Toggle Status)
When “Latch Trigger” works with “Keep Last Toggle Status”, the output only has a momentary trigger
but also needs to remain ON even when you stop monitoring or restart the system. Therefore under

the two conditions, the output turns off when a new input triggers.

N/C N/C N/C
Input
Output N/O N/O N/O
1st Input Trigger 2nd Input Trigger

Stop monitoring /
Restart the system
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6.1.5 Setting up PLC 1/0O devices

1. To connect a PLC I/O device to GV-VMS, click Home w > Toolbar Ifl > Configure # >
Accessories > PLC Device Setup. This window appears.

PLC List v - =X
PLC Device IP Address Port Status
Close J
Figure 6-8

2. Click the Add button to type the name, IP Address, Port, Password, M-Pin Range and select
the Connection Type of the PLC Device. The M-Pin Range supports up to 999999 pins

3.  To bind the M-pins, click Home W > Toolbar I:’:I > Configure # > Accessories, and
select I/O Device Setup, When the 1/0 Device Setup dialog box appears, select the PLC device,
click the Add button and select PLC 1/O.

1/0 Device Setup

alfv| Inputi{MQ)

Add Remave Modify
Mame F}
Module  Device Description Input 1 Enable
PLCI/O 192,168,5.212 (192, 168.5.21. .
Signal Type
NfO N/C Latch Trigger

4+ Output1(M16)

MName F:
Output 1 Enable Force Output
Signal Type
MO N/O Toggle MNfO Pulse
1 Sec
NJC N/C Toagle M/C Pulse

Cance

Figure 6-9
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4. Inthe PLC I/O Module Configuration Dialog, drag the pins on the left-hand side to the I/0O module

on the right-hand side.

Note: Every Input/Output module can only support up to 16 pins. To use other pins, add more 1/0

modules.

Device:

PLC 170 Medule Configuration Dialog

192.168.5.212 (192.168.5.212:4000,

MCTE: Use 'Drag-and-Drop' to bind the plc pins to the Ij0 module.
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M 0064 A & Tnput 9 (M 0040)
M 0065 &b Input 10 (M 0041)
M 0065 -2 Input 11 (M 0042)
M Oole7 -2 Input 12 |:M 0043:1
M 0088 &= Tnput 13 (M 0044)
M D083 &= Tnput 14 (M 0045)
M 0070 &= Tnput 15 (M 0046)
M 0071 4 Tnput 16 (M 0047)
M 0072 =-{@ Output

@ Output 1 (M 0048)
M 0073 | @ Output 2 (M 0043)
M 0074 /@ Output 3 (M 0050)
M 0075 y @ Output 4 (M 0051)
M NN7A [ e N L W Tt e 1]

Concel
Figure 6-10
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6.2 Advanced 1/O Applications

After adding 1/0O devices to GV-VMS, you can configure advanced I/O applications, such as setting
alarm notifications, defining a PTZ camera movement upon input trigger, setting momentary or

maintained mode, and deactivating alarm and alert settings.

Click Home M > Toolbar el > Configure # > Accessories (if available) > 1/0 Device (if
available) > I/O Application Setting. This dialog box appears.

1/O Application Setting E
=% Module 1 Monitor Input

e Tnputl [IRec. video: 5  Sec. [P Urgent Event
g IEEEtB [¥] Invoke Alarm:
% Inputd Invoke to Send Alerts:
&= Inputs
&= Tnpute Output Module:  |Mod. 1 +||Pin. 1 v
g EEEE; []Register Input Event

[%x

Input Overlay:

Preset Go by 1/0:

Preset Go by IfO - Alarm On Dwell Time: | 10 | Sec.

[INever Recycling Input - Triggered Events

1/0 Error Sound

[J1/o Error Alert

[] Deactivate notification when selected pinis ON ~ Mod. 1 Pin. 1 |E

(_)Momentary Mode  (®) Maintained Mode
[]5tart/Stop Camera Monitoring by /o Mod. 1 Pin. 1
[ start/Stop 10 Manitor by /0 Mod. 1 Pin. 1

”

Figure 6-11

Note: The Accessories option only appears when GV-Keyboard or GV-Joystick has been set up on

GV-VMS. The I/O Device option only appears after at least one 1/0 device has been added.
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6.2.1 Setting up Actions upon Input Trigger

You can set up the actions to take after the input device is triggered. Select an input on the left tand

clicking the Finger button will apply the same settings to all inputs.

I/O Application Setting

=18 Module 1 Monitor Input

----- &= Inputl [|Rec. video: 5 Sec. [P] Urgent Event

..... I t2

..... $ IEEEtB [V] Invoke Alarm:

""" <47 Inputt [ Invoke to Send Alerts:

----- &= Inputs

..... &= Inpute ¥ Output Module:  |Mod.1 v ||Pin. 1 v

i }EEEE; [_IRegister Input Event

Figure 6-12

[Monitor Input]

Rec Video: Select to record one or multiple cameras upon input trigger. Specify the recording
duration and click the Arrow button to select which camera to record upon input trigger. Use the
drop-down list to select whether to use the frame rate settings for Urgent Event or General Event.

For details on setting up Urgent and General Event, see Configuring General Setting in Chapter 2.

Invoke Alarm: Select to activate computer alarm when the input is triggered. You can select the

alarm sound from the drop-down list.

Invoke to Send Alerts: Select to send e-mail notifications when the input is triggered. Click the
first Arrow button to select the associated camera channel for video to be sent. Click the second
Arrow button to specify the recipient’s e-mail address. To attach video to the e-mail, it is required
to enable Attach Image Setup in the email setup. See Setting up E-Mail Notifications in Chapter
1.

Output Module: Triggers the specified output module when the input is activated. Use the
drop-down lists to select the output module and pin number.

Register Input Event: Registers the 1/O trigger events into System Log. Each event is labeled
with ID, time, device name (camera or I/O input), corresponding module of the device, and event

for later retrieval. For details on System Log, see System Log in Chapter 1.

Tip: You can also select one output device to set up the Invoke to Send Alerts function for sending

e-mail notifications upon output trigger.

207



Q GeoUision:

6.2.2 Moving PTZ Camera to Preset Points upon Input Trigger

This feature allows you to move the PTZ camera to preset points when an input is triggered. Select an

input number to be set up.

g EEEE; [T Register Input Event Preset Go by /O S5
PTZ.
[~ Input Overlay: [Pl Camerad -
Preset Go by I/0: +

Alarm On:
- ime: 10 .
Preset Go by I/O - Alerm On Dwell Time Sec [F'reseﬂ vl
[“I Mever Recycling Input - Triggered Events Alarm Off:
[¥]10 Error Sound [F"m" vl

[C]10 Error Alert

. oK l Cancel
[¥] Deactivate notification when selected pin is ON | | nee

Figure 6-13

B Preset Go by I/0O: Enable the option and click the Arrow button to select your PTZ camera from
the drop-down list.

B Alarm On: Moves the PTZ camera to a preset point when the input is triggered.

B Alarm Off: Moves the PTZ camera to a preset point when the triggered input is off.

B Preset Go by I/O - Alarm On Dwell Time: Specify the amount of time the PTZ camera stays at

“Alarm On” preset point, before returning to the “Alarm Off” preset point.

Note: Depending on the capability of the PTZ camera, up to 256 PTZ preset points (ranging from 1 to

256) and addresses (ranging from 0 to 255) can be programmed.
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6.2.3 Setting up Momentary and Maintained Modes

) Momentary Mode @ Maintained Mode
Start/Stop Camera Monitaring by I/O [Mﬂd- 1 "”Piﬂ- 1 ']
Start/Stop 10 Monitor by /O [Mod.1  ~|[pin.1  ~

Figure 6-14

[Momentary Mode] Push button switches that are normally open and stay closed as long as the

button is pressed. Momentary switches allow turn-on or turn-off from multiple locations.

For example, certain premises have a designated entry/exit door. When the staff enters the entry door,

the system starts monitoring. When the staff leaves from the exit door, the system stops monitoring.

[Maintained Mode] Push-on/push off button switches that stay open until thrown, and then stay closed

until thrown again. Maintained switches are convenient for only one switch location.

For example, in the business hour when the door is opened, the system stops monitoring; in the

non-business hour when the door is closed, the system starts monitoring.
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6.2.4 Deactivating Alarm and Alert upon Input Trigger

Preset Go by I/O - Alarm On Dwell Time: 10  Sec.

[ Mever Recycling Input - Triggered Events

[¥]10 Errar Sound

[C110 Error Alert

[¥] Deactivate notification when selected pinis ON  [Mod. 1 v”Pin. 1 -

i Ty
Deactivate Motification ﬁ

Trigger by: lMotiun v]

Deactivate Selected Notification
Output

Wave Alarm

Send Alert

oK H Cancel

Figure 6-15
[Deactivate notification when selected pin is ON] When an assigned input module is activated, all
designated alarms and alerts will be disabled. Assign an installed input module and a pin number for

the application.

[Deactivate Notification] Click the Arrow button to select the alert to deactivate.

B Triggered by: Select an alert condition from the drop-down list for the application. For example, if
you choose Motion, all designated alarms and alerts upon motion detection will be deactivated
when the assigned input module is activated.

B Deactivate Selected Notification: Select the alarms and alerts you want to be deactivated, such

as Output, Wave Alarm and/or Send Alert, when the assigned input module is activated.
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6.2.5 Other 1/0 Application Functions

In the 1/0 Device Application dialog box, you can also set up Input Overlay on live view, alert for I1/0

errors, and whether to recycle input-triggered events. Select an Input number to be set up.

I [¥] Input Overlay: I
[¥] Preset Go by I/O:

Preset Go by I/O - &larm On Dwel Time: 10  Sec.

[T Mever Recycling Input - Triggered Events
IO Error Sound

[C110 Error Alert

Deactivate notification when selected pin is ON IMOd- 1 '”Pin. 1 v]

Figure 6-16

[Input Overlay] Select to overlay the name of an input device on live video for alert or save the name

to video files upon the input trigger. Click the Arrow button to select the camera to overlay input name.

To overlay the name of a triggered input on live video, click Home u > Toolbar > Configure 'n' >
Video Process. In the dialog box that appears, select Text Overlay in the Video Analysis drop-down

list, select the camera, and click Setting. Select Print on screen (Only for I/O alarm) and/or Print on

video file. Up to 5 input names can be stamped on one camera channel when inputs are triggered.

[Never Recycling Input-Triggered Events] When selected, the files recorded upon input trigger won’t

be recycled by the system when disk space is full.

[IO Error Sound] When enabled, the computer alarm will sound when GV-VMS fails to detect the

connected I/O device.

[IO Error Alert] When enabled, an e-mail notification will be sent when GV-VMS fails to detect the

connected I/O device. For e-mail alerts, see Setting up E-mail Notifications in Chapter 1.
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6.3 1/0 Devices in Content List

When an 1/O device is added to the system, the I/O device will appear in the Content List.

> X7 |
1. To display the Content List, click Home ﬂ > Toolbar > Content List HH.

2. Click I/O Device to see the I/O devices added to GV-VMS. When an input or output is triggered,

its icon will light up in the 1/0 Device list.

® Content List

= £\ Module 1 = A Module 1
= 4\ mput (8) RH Input (8)
kMY Input1 = N\ output (8)
kM Input2 & output1
oA
Input3
&\ Module 1 B tnp & output2
Ed module 2 kM Input4 [ outputa
Figure 6-17

3. You can force the output device to be triggered by clicking its icon & Another way to trigger an

output is to select an output and click the Force Output button -!-.

4.  To manually turn off a triggered output, right-click the triggered output in the list and click Reset.
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6.4 Visual Automation

The Visual Automation helps you automate any electronic device by triggering the connected output.
You can then intuitively click on the image of the electronic device, a light for example, to change its

current state, e.g. turning the light on.

1. On the main screen, click Home > Toolbar E > Configure # > Accessories (if
available) > I/O Device (if available) > Visual Automation Setting. This dialog box appears.

Visual Automation SetUp X

M Enable

Camera7 v |

Set Color

Delete All Sets

| cancel

Figure 6-18

Select a camera from the drop-down list, and select Enable.
Drag a region on the camera view. A dialog box appears.
Select the connected module and output device. Type a Note to help you identify the device.

To change the frame color of the set region, click the Set Color button.

o o &~ w N

To test the output trigger, click the region on the camera view drawn in Step 3.

On the main screen, move the cursor to the camera view with the Visual Automation settings, click

Tools % > 1/O Automation. Next, click the region you set to trigger the connected output device.
You can right-click the camera view and select Show all to see all Visual Automation regions if

needed.

Figure 6-19

213



214

Chapter 7

Remote Viewing...ccccrmmmnmmsnmmsnmssnnssnnssnnnnnnnsns 219

7.1 Remote Viewing Using a Web Browser......................ccconnnn 216
7.2 WebCam Server Settings ..., 219
7.21 General Settings ... 219
7.2.2 Server Settings...........coooiiii 220
7.2.3 Video Settings.............coo o 221
7.2.4 Audio Settings............ccooiiiiiii 222
7.2.5 JPG Settings ..o e 223
7.2.6 UPNP Settings .........coooiiiiiii e 224
7.2.7 Network Port Information......................oo 225
7.2.8 MODIle S@rviCe ............cooiiiiiiii e 226
7.3 Single VieW VI@WEr ...ttt 227
7.3.1 Adjusting Video Quality ..................ccooiiiiiii 229
7.3.2 Control Panel ... 230
7.3.3 Configuring Single View Viewer Options...................ccccocciiiiiniiennnn 231
7.3.4 PTZControl Panel...................ooii e 234
7.3.5 Visual PTZ Control ... 235
7.3.6 1O CoNtrol ... e 236
7.3.7 Visual Automation ... 237
7.3.8 Picture-in-Picture VieW..................ccciiiiiiiii e 238
7.3.9 Picture-and-Picture View ... 239
7.4 Multi-Window VieWer...............cccooiiiiie e 240
7.5 JPEGIMAge VICWE ..ot 241
7.6 Playing Back Events.........................iie e, 242
7.6.1 EVeNt LiSt QUEeIY ...t 242
7.6.2 Remote Playback ... 243
7.7 Remote VIieWLOQg ... 244
7.8 Download Center.................oooiiiiiiiii i 245
7.9 GV-Edge Recording Manager ..................ccccociimiiinniiiiiiiininnninnnnnn. 246
7.10 Mobile Phone Applications ..................ccccciiiiiiiiiiiiiis 247
7.11 Web Browsers on Smartphones ...................cccccooviiiiiiiinnnnnn, 247



Remote Viewing

With a Web browser, you can remotely view live video, download and play back video files, as well as

controlling PTZ cameras and I/O devices, through the WebCam Server.

The remote computer used to access live video must meet the following minimum requirements:

(O] 64-bit Windows 8/8.1/10/ 11/ Server 2012 R2 / Server 2016 /
Server 2019

CPU 4t Generation i5-4670, 3.4 GHz

Memory 8 GB RAM

Hard Disk 80 GB

Network TCP/IP

Web Browser IE 7.0 or later

Chrome V38.0.2125.111 or later
Firefox 30.0 or later
Edge V20 or later

DirectX

9.0c

Note: Some remote functions may not be supported by non-IE browsers. However, users can

download the Web Viewer from non-IE browsers to access the full functions of the WebCam Server.
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7.1 Remote Viewing Using a Web Browser

GV-VMS has a built-in WebCam Server that allows you to remotely view and manage the camera

images from GV-VMS using a Web browser. Different browsers have slightly different user interfaces.

Note:

1. For Internet connection, GV-VMS must have an IP address or domain name from ISP. If the IP
address is dynamic, you may use the DDNS service to directly change IP addresses to

GV-VMS. For the service, see Dynamic DNS in Chapter 9.

2. Make sure the remote PC used to access GV-VMS meets the recommended system

requirements mentioned above.

3. If arouter or firewall is installed with the GV-VMS system, ensure the following communication
ports required by the WebCam Server are open: Command Port (4550), Data Port (5550),
Audio Port (6550) and HTTP Port (80).

1.  To enable the WebCam Server on GV-VMS, click Home dl > Toolbar 4 > Network &8 >
WebCam Server. The Server Setup dialog box appears. You can click OK to close the dialog

box for now and modify the default configurations later.

2. On aremote computer, open a Web browser and type the IP address or domain name of

GV-VMS. The Webcam Login dialog box appears.

Note: If the default HTTP port 80 has been changed, type a colon and the port number after the IP
address, for example, Http://192.168.3.199:81/.

3. Type a user ID and password created on GV-VMS.
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4. Click Login. When accessing the remote view for the first time, you may need to download and

install different files for different browsers:

a. Forlinternet Explorer, download and install the plugin from the pop-up window.

Component Downloader - Install_OCX.cab

Figure 7-1

b. For Google Chrome, Microsoft Edge or Mozilla Firefox, download and run Web Viewer
from the link below the live view window. After the connection to GV-VMS is established

using the Web Viewer, you can enjoy complete functions of the WebCam Server.

Live View
O1
B Mut

Camera List Camerall v

‘Camera adjustment

Brightness:
Contrast

Saturation

Hue: —

Download

jI PTZ

If you can't see live views, please ask your System Administrator to enable Mobile Service.

Figure 7-2
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WebCam Server Features

Name

Description

Live View

Accesses different types of live view viewers. See Single View Viewer,

Multi-Window Viewer and JPEG Image Viewer later in this chapter.

Remote Playback

Accesses remote playback options. See Playing Back Events later in this

chapter.

Remote ViewlLog

Accesses the Remote ViewLog. See Remote ViewLog later in this chapter.

Remote eMap

Accesses E-Maps remotely set up at GV-VMS. See E-Map Application in
Chapter 8.

Download

Accesses the Download Center. This function offers optional viewing programs

to be downloaded to the local PC. See Download Center later in this chapter.
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7.2 WebCam Server Settings

To enable and configure the built-in WebCam Sever, click Home dl > Toolbar k&4 > Network &@
> WebCam Server.

7.2.1 General Settings

ﬁQSemerSetup X
General Server Video Audic  JPG

WebCam Options

[[] Enhance network security @
Enable AES

[JEnable Remate Control
Run Viewlog Server
Run Bandwidth Control Server

[ Run Mobile Senice

Cancel Default

Figure 7-3
B Enhance network security: If enabled, a word verification step is required for each WebCam
Server’s login.

© Enable AES: Select to add an additional security protection for live streaming between
GV-VMS and WebCam Server.

B Enable Remote Control: Select to remotely configure the I/O devices through the WebCam

Server.
B Run Viewlog Server: Select to remotely play back video files through the WebCam Server.

B Run Bandwidth Control Server: Select to enable the Bandwidth Control Server. For details,

see Bandwidth Control Application in Chapter 9.

B Run Mobile Service: Select to enable the mobile function to connect to GV-Eye and GV-Edge

Recording Manager (MAC Version).

Note: When Enhance network security is enabled, JPEG/Mobile applications will be disabled.
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7.2.2 Server Settings

ﬁQSewerSetup >
General Server Video Audio JPG

HTTP Port
Command Port
Data Port
[]Enable S5L

Port 442

Certificate file
Private key file

Password

Enable TLS1.0

Detect UPNP

Cancel Default

Figure 7-4
B HTTP Port: Used to access the Internet. By default, it is 80.
B Command Port: Used to access WebCam. By default, it is 4550.
B Data Port: Used to transfer data over the Internet. By default, it is 5550.

B Enable SSL: Enable the Secure Sockets Layer (SSL) protocol to ensure the security and privacy
of Internet connection. To use your own generated Certificate and Private Key or ones verified by
SSL authority, click the [...] buttons and select the files stored at your computer. Note that the
system will enable both SSL 2.0 and SSL 3.0 as its default; to further enable TLS 1.0 protocol
when using SSL protocol, select Enable TLS 1.0.

B Detect UPnP: For details, see UPnP Settings later in this chapter.

Note: If you want to enable SSL 3.0 on a computer running Windows Vista, it is required to upgrade

your system to Service Pack 1 or Service Pack 2.
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7.2.3 Video Settings

E@ Server Setup

General Server Video  Audio PG

Max. Channel 120
Max. Image size Mormal
PTZ

Allowed PTZ camera

Cancel

Default

Figure 7-5

Remote Viewing

B Max. Channel(s): Specify the number of channels allowed to access the WebCam Server, with

the upper limit of 200 channels.

B Max. Image size: Select a maximum resolution allowed for remote access. The default resolution

on the WebCam is Normal (320 x 240). The other options are Large (640 x 480 or 704 x 480) and

the Actual Size of that IP camera.

B Allowed PTZ camera: Controls PTZ cameras at a remote computer. Click the button and select

the desired PTZ cameras to allow for remote access.

Note: To specify the time length allowed for a guest user to access the WebCam Server, click the

account ID at the top of the main page, click Password Setup, and select Local Account Edit. In the

WebCam tab, select the Limit Connection Time option and specify the time length. The time range is

between 10 and 3600 seconds.
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7.2.4 Audio Settings

Connecting Audio Devices
Through the WebCam Server, you can access live audio at a remote site and talk to the server site

when necessary. Before using this feature, make sure all the necessary hardware are in place:

1. To record audio, check the connected IP camera has built-in audio function or an external
microphone connected.

2. Check your sound card is already inside the computer. Connect a multimedia speaker to the audio
output of your computer’s sound card for receiving audio from the remote site.

3. Connect a desktop microphone to the input of the audio extension card (or cable line) for sending

audio to the remote site.

Audio Setup

B2 Server Setup x

General Server Video Audio  JpG

[ server to Client

Max. Channel

Clientto Server

Max. Channel
Port 6550
Cancel Default
Figure 7-6

[Server to Client] Allows a remote computer to access live audio from GV-VMS.

B Max. Channel(s): Enter the maximum number of channels allowed to access live audio, with the

upper limit of 40 channels.
[Client to Server] Allows a remote computer to speak to GV-VMS.

B Max. Channel(s): Enter the maximum number of channels allowed to speak to the server site,

with the upper limit of 20 channels.

B Port: The default audio port is 6550.
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7.2.5 JPG Settings

These settings allow you to send JPEG or GIF files over the Internet.

% Server Setup *

General Server Video Audio PG
[ Create JPEGIGIF file(s)

JPEG Quality

P [

Cancel Default

Figure 7-7

B Create JPEG/GIF file(s): You can access the JPEG images through the WebCam Server, and

adjust the image quality. Bigger number results in better image quality and bigger image file size.
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7.2.6 UPnNP Settings

The WebCam Server supports UPnP technology (Universal Plug and Play) to allow automatic port

configuration to your router. UPnP must be enabled both on your operating system and your router.

Enabling UPnP on the WebCam Server:

1. On the main screen, click Home dl > Toolbar k&l > Network && >WebCam Server. The
Server Setup dialog box appears.

2. Click the Server tab and click Detect UPnP. This dialog box appears.

Port Mapping
UPnP-based Router
Realtek RTL&168C(P) /811 1C(P) Family PCI-E Gigabit Ethernet NIC (NDIS 6.20) IP[192.168.4.177]
Mame Port IP Address NOT =
I HTTP 85 192.168.4.177
I COMMAND 4550 192.168.4.177 L
I DATA 5550 192.168.4.177 1
I AUDIO 6550 192.168.4.177
' Mobile 554 192.168.4.177
\_~ Mobile Stream 56000 192.168.4.177 i
<[ m ] b
Figure 7-8

3. Click Searching to search the UPnP-enabled routers.
4. If your server is installed with multiple routers, select one from the UPnP Router drop-down list.

5. If you server is installed with multiple network adapters, select one from the drop-down list under

the Searching button.

6. Click Configure to automatically configure the communication ports on the router.

Note: If you don’t use the default ports, modify the related ports in the Server Setup dialog box
(Figure 7-4) and then click OK. Re-open the dialog box and follow the above steps to configure your

router.
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Remote Viewing

The Network Port Information is designed for users to view and manage all network ports of remote

applications.

On the main screen, click Home W > Toolbar I.’:I > Network i?i > Network Port Information.

This dialog

000

box appears.

aaQ

o
ol
0l

Al

F F F

| Port SzIrtings
12y EL&L;‘” @

I 8 WebCam Server,

= Http Port - 80

% Command Port - 4550
=% Data Port - 5550

=% Audio Port - 6550

% SSL Port - 443

Mobile Service

CenterV2

Control Center Server
UPnP

Figure 7-9

The controls on the Port Settings:

No. Name Description
1 Modify Changes the port settings.
2 Save Saves the port settings.

3 Port Mapping

Employs UPnP technology (Universal Plug and Play) to allow automatic

port configuration to the router.
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7.2.8 Mobile Service

Mobile Service allows remote connection and video streaming from GV-VMS by other applications,

namely GV-Eye, GV-Edge Recording Manager — Mac version and the multicast of GV-Control Center.

You can also add additional security protection for live streaming between GV-VMS and the connected

application using AES Encryption.

For details on configuring multicast on GV-Control Center, see Multicast Setting, Chapter 9, in

GV-Control Center User’s Manual.

To add AES Encryption:

1. After connecting to GV-Edge Recording Manager / GV-Control Center / GV-Eye, on the main

screen of GV-VMS, click Home Ldl > Toolbar -.’u > Network & > Mobile Service.
2.  Select Enable AES Encryption.

Mobile Server Lite

Server Port

56000
Enable Multicast
Multicast Address
224.0.0.0

Multicast Port Start
1000

TTL

5

Interface Address

[Local Area Connection 2(152.168.4 222)

|:| Enzble AES Enctyption |

[ [ ]

Figure 7-10

Note: The AES Encryption function is only compatible with

e GV-Edge Recording Manager V1.3.0.0 or later
e GV-Control Center V3.5.0.0 or later

e GV-Eye V2.5 or later

e GV-VMS (WebCam Server) V17.1 or later
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7.3 Single View Viewer

After logging into the WebCam Server successfully, you can see the single live view from GV-VMS.

« Information
= Version
1410

= | ocal time
2014}07415 03:47:49

= Host time
2014}0715 03:47:49

= Online count
1

= OCX Registration Path
CAWindows\GeoOCXiWebC...

» + 5

—

Figure 7-11

The controls in the Single View Viewer:

No. Name Description

Right-clicking on live view allows you to instantly access some useful
1 Live Video functions. The Resolution option can display a resolution indicator at the

bottom right corner of the video.

2 Control Panel See Control Panel later in this chapter.

3 Options See Alarm Natification, Video and Audio Configuration, Server List,
Show Camera Name and Image Enhancement later in this chapter.

4 Change Camera Selects the desired camera for display.

5 PTZ Control See PTZ Control and Visual PTZ Control Panel later in this chapter.

6 I/0 Control See I/0 Control later in this chapter.
Switches to full screen view. The maximum video resolution configured

7 Full Screen on the WebCam Server will be applied. See Video Settings in WebCam
Server Settings earlier in this chapter.

8 File Save Saves video to a local computer in AVI format.
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9 Change Quality See Adjusting Video Quality later in this chapter.

10 Snapshot Takes a snapshot of the displayed live view.

11 Speaker See Video and Audio Configuration later in this chapter.
12 Microphone See Video and Audio Configuration later in this chapter.
13 Stop Terminates the connection to the remote GV-VMS.

14 Play Connects to the remote GV-VMS.

Displaying Full-Screen Live View on Other Monitors

Using the IE browser, you can display up to 10 full-screen channels with multiple monitors installed.

Right-click the live view and select a designated monitor to bring full-screen live view. The full-screen

live view appears on the designated monitor immediately.

Note: The full-screen display closes at the designed monitor if its Web interface window is

minimized.
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7.3.1 Adjusting Video Quality

To adjust the live view quality to have megapixel resolution in the Single View Viewer:

1. Select Actual Size on GV-VMS. Click Home [ © Toolbar nﬁ > Network &8 > WebCam
Server > the Video tab > select Actual Size in the Max. Image Size option.

@ Server Setup @

General[ Server | Video | Audio |JPG

Max. Channel 120

Max. Image size Actual Size -

Figure 7-12
2. On the Single View, click the Change Quality button (No. 9, Figure 7-11). You will have the

option of megapixel resolution now.

Note:

1. Streaming live view in Actual Size requires a lot of bandwidth. It is highly recommended to enable
this function in a LAN environment.

2. To have fisheye dewarping view, you must first follow the steps above to set fisheye camera to
megapixel resolution. Next, right-click the camera view and select Geo Fisheye. For details on the

fisheye settings, see Fisheye View in chapter 3.
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7.3.2 Control Panel

A control panel can be opened next to the live view by clicking the Menu button and selecting any of
the options. To change the pages of the control panel, use the right and left arrow buttons on the panel,

or click the Menu button to directly make selection.

Information

v Information

Video

Audio

Preset Go

/O control

Alarm Notify

Camera adjustment

POS / Wiegand

People Count

= OCX Registration Path

C:\Windows\GeoOCX{WebC...
no &
Figure 7-13
Name Description
nformation Displays the current version, local time, host time and number of channels
currently accessing WebCam.
Video Displays the current video codec, resolution and data rate.
) Displays audio data rates when the microphone and speaker devices are
Audio enabled.
Preset Go Allows you to remotely move the PTZ to the preset points.
I/0 Control Provides a graphic display of the input and output devices from GV-VMS.
Alarm Notify Displays the captured images by sensor triggers and/or motion detection.

See Alarm Notification later.

Camera Adjustment Remotely adjusts image quality by moving the slider to the desired values.

POS/Wiegand Not functional.

Views the counts of Object Counting along with live view. Once the counts are
People Count logged into GV-VMS, In and Out counts will become zero and the system will

start counting those numbers again.
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7.3.3 Configuring Single View Viewer Options

To access the Single View Viewer options, click the Option button located on the right of the live view.

Alarm Notify
Video and Audio Configuration
Change Server

Show camera name

Image Enhance

Figure 7-14

Alarm Notification

Up to four captured images can be shown in the control panel upon motion detection or input trigger.

00:30:37 m « Alarm Notify

2014/07(16 201407116
00:30:21  00:30:26
Motion Motion

% “' Captured

Images

ClearAll

Figure 7-15

1. Click the Option button, and select Alarm Notify. The Alarm Notify dialog box appears.
B Motion Notify: The captured images are displayed in the control panel of the Single View
upon motion detection.
B 1/O Alarm Notify: The captured images are displayed in the control panel of the Single View

upon input-triggered detection.
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Alert Sound: Activates the computer noise alarm on motion and input-triggered detection.
Auto Snapshot: The program will take a snapshot every 5 seconds on motion and
input-triggered detection.

B File Path: Assigns a path to save the snapshots.

2. Click OK to apply the above settings.

Video and Audio Configuration

To change the video and audio configurations of the connected camera, click the Option button, and

select Video and Audio Configuration.

Video and Audic
Camera Audio Configure |

4)3 ™ Enable

Mormal hd
2‘ I~ Enable

Video Codec |Geo MPEG4
Resolution |320a240

Video and Audio

Camera | Audio Configure ]

Quality | Best quality

Cancel

Frame Rate

Figure 7-16

[Camera] Change the video codec, quality and frame rate. The resolution options depend on the
maximum image size set on the connected GV-VMS. For details, see Video Settings in WebCam

Server Settings earlier in this chapter.

[Audio Configure] Enable the microphone and speaker for two-way audio communication. Select
Speaker to access live audio from the server site, and select Microphone to speak to the server site.
Ensure the speaker and microphone are properly installed in the local computer, and the audio settings

(Figure 7-6) are activated on the WebCam Server too. There are three options for audio quality:

B Real Time: Transmits simultaneously audio and video but may create sound interruption,

depending on your network condition.
B Smooth: Has a smooth sound quality but without audio and video synchronization.

B  Normal: The default value which has the audio and video effects between Real-Time and Smooth.
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Server List

You can add the connection information of multiple GV-VMS systems to the WebCam Server for quick

access later. Click the Option button > Change Server to display the following dialog box.

Change Server E

Host

Default J Default ‘ New Delete |

Host Name |New Sernver

|P Address |

User Name ||

Passwaord |

Command Port

Data Port
Audio Port

Figure 7-17

To add a GV-VMS system to the drop-down list, click the New button and type its connection
information. Leave all port settings as defaults at 4550, 5550, and 6550 respectively unless otherwise

necessary. Click the OK button. Then the created GV-VMS will appear in the Host drop-down list.

Show Camera Name

To show camera name on top-left corner of the live view, click the Option button and select Show

Camera Name.

Image Enhancement

To enhance the image quality of live view, click the Option button and select Image Enhance.
B De-Interlace: Converts the interlaced video into non-interlaced video.

B De-Block: Removes the block-like artifacts from low-quality and highly compressed video.

B Enable DirectDraw: Enabled by default to enhance image quality. Some graphics cards might
not support DirectDraw and can produce distorted frames. In this case, disable the DirectDraw

function.
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7.3.4 PTZ Control Panel

Click the Camera Select button to select one PTZ camera, and click the PTZ Control button (No. 7,

Figure 7-14) to bring up the PTZ control panel.

Single View PTZ Control
Viewer Panel

Figure 7-18

One PTZ camera can only be controlled by one user at a time. If several users are trying to control the
same PTZ camera at the same time, the Single View viewer will give the priority to the first logon user

and then to the next user in queue.
Each user will be given 60 seconds to control the PTZ camera. The Timer at the upper right corner

informs the user of the remaining time of control or the total waiting time. The supervisor is given 666

seconds, which the highest priority to control the PTZ camera.

Click the

button to access additional PTZ functions. The functions available vary, depending

on the PTZ models.

234



Remote Viewing

7.3.5 Visual PTZ Control

Other than the PTZ control panel, you can enable the Visual PTZ Control functions. Right-click the live
view and select Visual PTZ. Next, click the green PTZ button on the top left corner of the PTZ control

window to have these options:

B Random Move: You can move the camera view to any direction by clicking on a desired direction.
When you place the mouse cursor on the live view, a circular PTZ control panel appears. See

PTZ Control Panel and Auto Functions in Chapter 1 for details on the circular PTZ control panel.

Figure 7-19

B Center Move: Only for GV-SD220, you can zoom in and out using the mouse scroll or by drawing

a block directly on the live view.
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7.3.6 1/0 Control

The I/O control panel shows the I/O status and alarm event. Additionally, you can force output, as well
as enable and disable 1/0 devices to the remote GV-VMS. Click the I/O Control button at the right of

the live view to bring out the 1/0O control panel.

ALARM LIST w Enable/Disable 110

ALARM LIST
=R 201400716 Timer

o 01116:28 e —
o-£F- 01:16:29

£ (Module 01)input2 ‘

110 DEVICE

1% Module 1 -
=4 [
&= Inputl
&= Input2
#= Input3
&= Inputd
&= Inputs
#= Inputh
&= Input?
&= Inputd
=@ Output
@ Outputi
. @ Output2
Slngle @ Output3
View (@ Outputs
Viewer |© Outputs
@ Outputd
@ Output?

Camera
'EH Cameras

I/0O Control Panel

Figure 7-20

The alarm status shows the triggered inputs. Clicking the Reset button will clear the alarm list.

To force to trigger an output device, click the Enable button, highlight an output and then click the
Output button. The Timer functions the same as in the PTZ control panel. Each user will be given 60
seconds of control time while the supervisor has 999 seconds. Clicking the Stop button will stop the

operation and turn over the control privilege to the next user waiting online.

If you want to enable or disable I/O devices connected to the remote GV-VMS, click the
Enable/Disable 1/0O button. Note that the Enable Remote Control option must be enabled beforehand

in the WebCam Server Setup dialog box (Figure 7-3)

236



Remote Viewing

7.3.7 Visual Automation

If the Visual Automation function is enabled on GV-VMS, you can remotely trigger the connected
output by simply clicking on a designated spot on the live view. For details on setting up Visual

Automation, see Visual Automation in Chapter 6.

1. To access this feature, right-click the live view and select Visual Automation. A green I/O icon
appears in the corner.
2. To see where the designated visual automation spots are located, right-click the live view again,

select Visual Automation and select Show All.

3. Click the alert areas on the image to force the outputs to be triggered remotely.

15:31:39 Play
170 RERR . /o

Figure 7-2
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7.3.8 Picture-in-Picture View

With the Picture in Picture (PIP) view, you can crop the video to get a close-up view or zoom in on the

video. This function is useful in providing clear and detailed images of the surveillance area.

1. Right-click on the screen and select PIP. An inset window of the camera view appears in the live

view.

Navigation box

Inset window

Figure 7-22

2. Move the navigation box around in the inset window to have a close-up view of the selected area.
You can adjust the size of the navigation box if needed.
3. Drag the inset window to adjust its location on the live view if needed.

4. To exit the PIP view, click the camera name and click PIP View again.
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7.3.9 Picture-and-Picture View

With the Picture and Picture (PAP) view, you can create a split video effect with multiple close-up views
on the image. A total of 7 close-up views can be defined. This function is useful for megapixel

resolution that provides clear and detailed images of the surveillance area.

1. Right-click on the live view and select PAP. A row of three inset windows appears on the bottom of
the screen.

2. Draw a navigation box on the image, and this selected area is displayed in one inset window. Up to
seven navigation boxes can be drawn on the image. You can adjust the size and the location of the

navigation box if needed.

‘ \‘

Figure 7-23

3. To exit the PAP view, right-click the live view and select PAP again.
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7.4 Multi-Window Viewer

The Multi Windows displays up to 16 channels at a time and supports up to 64 channels.

To access the Multi Windows, click Live View on the left panel of the Webcam Viewer page, and select

Multi Windows.

Live View > Multi Windows

Live View
4

Remote Play Back

Remote ViewlLog

i’

Download Sodgih |

Figure 7-24
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7.5 JPEG Image Viewer

JPEG Image Viewer is a cross-platform viewer, compatible with Mac OS and Microsoft IE browsers.
Continuously receiving JPEG images from GV-VMS and limited to a single camera view, the viewer is

an ideal tool for the users with limited Internet bandwidth.

Note: To enable the JPEG Image Viewer, Java needs to be installed on the local PC.

To enable the viewer:

1. Click Home M >Toolbar I.':I > Network -E?i!- > WebCam Server.

2. Disable Enhance Network Security under the General tab (Figure 7-3), and enable Create
JPEG/GIF File(s) under the JPG tab (Figure 7-7).

3. Access GV-VMS using a Web browser.
4. On the left panel of Singe View page, click Live View and select JPEG Image Viewer. The JPEG

Image Viewer appears.

Live View > JPEG Image Viewer

Saisiso " Camera List [ECEERY i
D 1 v'-"‘-'”‘i :j [: ‘~I-

Remote Play Back

Remote ViewlLog

Remote eMap

Download

Figure 7-25
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7.6 Playing Back Events

7.6.1 Event List Query

The Event List Query function on the WebCam Server allows you to remotely search for an event by
defining event type and time. The search results can be displayed in text form or in a chart. You can

also play back events instantly from the search results.

To allow remote access to GV-VMS and remotely play back events,

® Ensure the WebCam Server with the Run ViewLog Server function (Figure 7-3) is activated on
GV-VMS.

1. On the left panel of the Single View page, click Remote Play Back and select Event List Query.
The Query window appears.

2. On the top, select one of the following search categories: Monitor, System, Login, Counter,
POS, Merge, Backup, Delete, Notification, I/O, Playback, and CMS. Note that these categories

are based on those of System Log in the Main System.

3. Define the search criteria such as Event Type, Device, Information, Date and etc. The selection of

search criteria may vary, depending on search categories.
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4. Click the Query button n The search results are displayed.

Search categories Video icon

DST
Rollback

ID Event Device Information Note

45 Motio

Figure 7-26

5. To play back the attached video, click the Video icon. For more playback features, right-click on

the video image.

6. To graph the search results, click the Chart button .

7. To export the search results, select one of the formats and click the Export button .

7.6.2 Remote Playback

With the Remote Playback (RPB) function on the WebCam Server, you can play back the recorded
files of the connected GV-VMS.

1. To allow remote access to GV-VMS, ensure the WebCam Server with the Run ViewLog Server

function (Figure 7-3) is activated on GV-VMS.

2. On the left panel of the Single View page, click Remote Play Back and select Remote Play Back.
The Remote Play Back appears.

3. Select the desired camera, date and time-segment file.
4. Click the Play button to start.

5. For additional playback features, right-click on the image to have the options of Play Mode,

Render and Tools.

243



Q GeoUision:

7.7 Remote ViewlLog

Through the WebCam Server, you can remotely play back the recorded files by using the ViewLog

player.

1. To allow remote access to GV-VMS, ensure the WebCam Server with the Run ViewLog Server
function (Figure 7-3) is activated on GV-VMS.

2. On the left panel of the Single View page, click Remote ViewLog. Remote ViewLog will be

installed on your PC if it is not already.

Remote ViewLog

Live View

Remote Play Back

B event Installing
W Remo

Remote ViewlLog

Remote eMap

~
Download
56K/Modem 780sec
64K/ISDN 680sec

512K/ADSL 90sec

Figure 7-27

3. Execute GV-Remote ViewlLog and create a Remote ViewLog account on the Add Remote Viewlog

Account dialog box.
4. After creating an account, the Add New Host dialog box appears.

5. Inthe Host Type, select DVR / NVR / VMS. Type the Location Name, IP Address, Account and
Password of GV-VMS. Only modify the default port 5552 if necessary.
6. Click OK. The events available will be listed in the Event List.

For details on ViewLog player functions, see Chapter 4.
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7.8 Download Center

The Download Center allows you to download Remote ViewLog, Remote eMap and GV-Edge

Recording Manager.

1. Click Download in the left panel of the Single View page. This page appears.

VE= Resolution File Size Download

Remaote Viewlog n

ad
>

e Remote eMap

-
:r"' GV-Edge Recording Manager

File Size

Figure 7-28

2. Check the desired programs. The File Size field will display the total file size of the selected
programs.
3. Click Download and follow the on-screen instructions to install the programs. When the installation

is complete, the message “Install Complete” will be displayed.
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7.9

GV-Edge Recording Manager

GV-Edge Recording Manger is designed for remote live viewing and playback of GeoVision IP devices

and software. GV-Edge Recording Manger brings live view and allows remote control of GV-IP Camera,

GV-Video Server and GV-SNVR, as well as GV-DVR / NVR / VMS and GV-Recording Server, together

under one management interface.

For details on GV-Edge Recording Manager, visit our website:

GV-Edge Recording Manager (Windows Version)

GV-Edge Recording Manager (MAC Version)

GV-Edge Recording Manager (Windows Version): Make sure that Control Center Service and
Remote ViewLog Service are enabled on GV-VMS.

GV-Edge Recording Manager (MAC Version): Make sure that Webcam Server and Mobile
Service are enabled on GV-VMS.

=

WebCam Server (W) ~ WebCam Server (W)

Mobile Service ~ Mobile Service

Connect to Centerv2 (V) Connect to Centerv2 (\)

Connect to VSM (G) Connect to VSM (G)

Failover Plugin Failover Plugin

Control Center Server > Control Center Server >

Stop All Network Server Stop All Network Server

Network Port Information Network Port Information

Network failure detection Network failure detection
Win version MAC version

Figure 7-29

Note:

Mobile Service has the same function as Run Mobile Service (WebCam Server > General
Tab).
To add additional security protection of the live streaming between GV-VMS and GV-Edge

Recording Manager through AES encryption, see Mobile Service earlier in this chapter.
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Remote Viewing

7.10 Mobile Phone Applications

With a smartphone, you can access live view and play back recordings from GV-VMS using GV-Eye

mobile app. GV-Eye can be downloaded from App Store or Android Market.

For details, see GV-Eye Installation Guide

7.11 Web Browsers on Smartphones

Using the browser on your smartphone, you can watch live view, control PTZ live views, and play back

recordings from GV-VMS. By connecting to the WebCam Server, no extra application is required.

Note:
1. Make sure the Mobile Service is enabled on the WebCam Server.

2. Live view control is only available for supported PTZ cameras.

In the following steps, we use the Android smartphone as an example to log onto GV-VMS:

1. Open the browser on your Android device and type the IP address of GV-VMS to log on.

192.168.0.81/Mobile/m... )

Webcam Login

B

Remember My ID and
Password

Login

Figure 7-30
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2. Click Login. The cameras on GV-VMS appear.

192.168.0.81/Mobile/m... ()

ID: 1 Home

Live View

Streaming Type: H264 JPEG

Camera

List Best Quality Low Quality

Cameral
Camera2

Camera3

Figure 7-31

3. To watch live view, keep H.264 as Streaming Type, and tap a video icon @ Stream 1 will be
displayed when Best Quality is selected and Stream 2 will be displayed when Low Quality is

selected.

4.  To access the PTZ functions, tap JPEG as Streaming Type. This page appears. You can control

the live view with the direction arrows, zoom in/fout and home position buttons.

Live View

Streaming Type: ® H264 © JPEG

Hn

1 |l'j' 34

Figure 7-32
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E-Map Application

The E-Map displays the monitoring area on an electronic map, by which the operator can easily locate

the cameras, sensors and alarms triggered by motion or I/O devices.

The application is available through two programs: E-Map Editor which comes with the installation of

GV-VMS, and E-Map Server applicable on a designed server.

8.1 The E-Map Editor

The E-Map Editor allows you to import a floor plan in BMP, GIF or JPEG formats, and use the icons of

cameras and I/O devices to customize a map.
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8.1.1 The E-Map Editor Window

The E-Map Editor comes with the installation of GV-VMS. Click the Windows Start menu, find

Programs, select GV folder and click E-Map Editor. The E-Map Editor window appears.

g ap| Ho
LRI EY I
Map View x 7
=-Q New Map =
& [
Q VMs2 L ]
R £ D
S| . ’ v |
i) o @1 (Tl i} 1) [} ‘ : 2 g
@ e ’ LAl 4
* — - | |
P\ comerat | ] (i) ] (] 5] VB (] = =
OV (=] lt.‘"
[0} liu@ ] (s} (] (1] (TiaT} | B 'w:
Y = =
[l N o i) (i} i) (] [[i4] ] i) ‘ [[&] 18
o |
Uy
N 2 1= ik
il @1 (=] = e BN i y
Host View x @ - = || - - .
=1 TEST-226-PC f (0] 1 RS = e — (S e
&)-aly Cameras [.‘:A‘I l‘&(
(-8 /O Devices @ = [ — ‘ 'g F:::'
g o e e [ i g g || o [T
-4 /O Devices . ! ] ;- o = i = : e
File Type: VMS
Figure 8-1
The controls in the E-Map Editor window:
No. Name Description
1 Up Returns to the previous E-Map file.
2  Add Map Adds an E-Map file.
3  Add Host Adds a host folder in the Host View.
4  Load Map Imports a floor map.
5 Rename Renames an E-Map file and/or folder.
6 Delete Deletes an E-Map file and/or folder.
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No. Name Description

7 & 8 Zoom In/ Out Enlarges / Diminishes the Map View.

9 Fit to Screen Adjusts the Map View to fit the current size of the window.
10  Actual Size Displays the actual size of the imported graphic file.

11 Floor Plan The view of imported graphic file.

12 Map View Tree view of E-Map files.

13  Host View Tree view of hosts

8.1.2 Creating E-Map

1.  To create an E-Map, click Add Map ‘% on the toolbar. A New Map file is created in Map View
and the Floor Plan window separately.

K’ E-Map Editar
File Edit Map Host Wiew

| wE | E D% 6 e EE

Map View =
- Mew Map Q
Figure 8-2

2. Click the New Map file in Map View, and click the Load Map button (No. 4, Figure 8-1) to import a
graphic file. The file opens in the Floor Plan window.

3. Drag and drop the icons from Host View (No. 13, Figure 8-1) onto the map in the Floor Plan
window.

4. To change the orientation of the default camera icon, right-click the camera from the Host View,
and select an orientation.

5.  To change the camera / 10 icon to your own, right-click the camera / IO from the Host View, and

add your own icon.

Note: Make sure the icon file is of 32 x 32 pixels or smaller.
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Define the condition that the icon appears by selecting No Event or Event and select the
icon orientation using the drop-down list. You can set different icons for an event and
no-event situation. In this example, the icon of IPCam.jpg appears on the map when no
event occurs and when an event occurs, the icon changes to the default one.

Change Icon ]
east event east southeast event south -
southeast
7] > > 2 >
event south  southwest event west event west
southwest
X o @ @
northwest event ptz event ptz input =
northwest
& @ @ (@]
event input output eventoutput | [HEELFEE 5
lcon Type Preview
I E v l
© No Event IPCam jpg Cﬂ
e
(©) Event Defautt lcon
Addlcon.. | [ Deletelcon | [ ok ][ cancel
Figure 8-3

6. Click File in the window menu and select Save to Al Guard to save the file to the GV-Al Guard

folder, or select Save to File to save the file to a desired path.

Advanced Settings

Optionally, you can have the following settings on your created E-Map.

Note: The changes in the orientation of camera icons will not be reflected on the 3D E-Map.

A. View Zone

The View Zone function illustrates the monitored area of each camera on the E-Map.

1.  Inthe E-Map Editor window, click to highlight a camera icon, and select Edit View Zone. A

fan-shaped view zone appears.

=
.

JE— —
Bl | Ch

Figure 8-4

2. Move the mouse to adjust the size and direction of the view zone.
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3. Right-click the map and select Finish to finalize the zone.

4.  You can also adjust the property of the view zone from the Property menu.

Property *
”Name Camera 1 |
Direction - v

View Angle[Degree] 30

View Radius[Pixels] |222

Figure 8-5

B. Polygonal Map

The Polygonal Map function helps you quickly locate a triggered device. Draw an area on the map and

it will flash when any device within the area is triggered.

1.  Inthe E-Map Editor window, click to highlight a map, and select Edit Polygonal Map or Edit
Polygonal IO.

2. Click on the map to start drawing a polygonal shape, indicated by a yellow dotted line.

I\

3.  After closing the shape, right-click the map and select Finish.

Unitus
guilding

Science
and_

Educat\()“

Center

\ SW GRANT

Figure 8-6

The enclosed area will be colored in blue. When a device placed within the polygonal map is triggered,

the blue area will flash in blue and red.

The enclosed area is colored in blue. When any device within the area is triggered, it will flash red.
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8.1.3 Creating E-Map for a Remote Host

Aside from for the local host (GV-VMS), E-Maps can also be created for remote host(s). Through the
Remote E-Map function, these E-Maps can be accessed and monitored through a Web browser. For

how to remotely access E-Maps, see Accessing E-Maps of Multiple Hosts later in this chapter.

Note: The supported hosts for E-Map include GV-DVR / NVR / VMS, GV-IP Devices, GV-Video Server
and GV-Compact DVR.

1. Click Add Host =y on the toolbar and select the type of host. Anew host is added in Host View.
2. Right-click the created host and select Host Settings. This dialog box appears, which varies

depending on the host.

' Host Settings g|
Location Mame: |New Host | [ 0K |
Address: |emap.dipmap.com | [ Cancel ]

# of Camneras: ‘wiebcam

4 of Moo Cormmand Port:
Madule 1 h | Data Port:
# of Inputs: 16 S
# of Outputs: Audio Fort:

Figure 8-9
3. Type the necessary information, such as IP address and the number of cameras, and click OK.

4. Follow the instructions in Creating an E-Map earlier in this chapter to create an E-Map for the

remote host.
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8.2 Starting E-Map

After an E-Map is created, you can start the E-Map on GV-VMS and monitor through the E-Map. When

any camera and/or I/O device on it is triggered, the corresponding icon will blink as an alert.

1. On the Content List of GV-VMS, expand the E-Map folder and drag the created E-Map to the live

view grid. The E-Map is displayed.

Figure 8-10

2. When any camera or /O device on the E-Map is triggered, its corresponding icon will blink red.

Hover the cursor over the icon to see a live image of the event or click the icon to see the full view.

Move cursor on the
cameraicon to have a
live image

Triggered camera with
blinking icon

Figure 8-11

Note: If you have created the E-Maps for multiple hosts, you can also see these map files in the
Content List. However, these map files won’t function on GV-VMS but only work on Remote WebCam

through a Web browser. See Accessing E-Maps of Multiple Hosts later in this chapter.
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8.2.1 Setting up Popup Map

When multiple E-Maps are being monitored simultaneously, the popup function can be enabled for
monitoring convenience. Once any camera or I/O device is triggered, its corresponding E-Map will pop

up, replacing the current E-Map.

1. In the Content List, click the Configure button under E-Map.

< Content List

Figure 8-12

2. Select the desired cameras and input devices for the application, and specify Interrupt Interval
for the duration between event triggers. Any event trigger will be ignored by the system during the

interval to avoid frequent map popup.

3. At the bottom of the E-Map grid, click E-Map Auto Pop-up #* {0 enable the function.

IV New vap 1st floor
N campus
J4p 1st floor
'.’ 2nd floor

& == 2 %

Figure 8-13
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8.3 3D E-Map Display

Note the 3D E-Map function are only applicable to GV-VMS V16.10.3.0 or later.

8.3.1 3D E-Map Display

The E-Map can display the monitoring area in 3D view, meaning you can zoom in and out with the

mouse wheel, and rotate the view as you wish.

1. Create an E-Map by following the instructions in Creating an E-Map earlier in this chapter. To build

multiple layers of maps, create another subfolder under the E-Map folder, as illustrated below.

File Edit Map Host View

LB E4+rDR GQEEE D
Map View x
B& MNew Map

----- @ campus
i @ 1stfloor

Figure 8-14
After creating an E-Map, click Home > Toolbar > Content List on GV-VMS.
Expand the E-Map folder and drag the created E-Map to the live view grid
To zoom in / out of the monitoring area, simply scroll the mouse wheel up or down.

To adjust the angle of view, click and hold on the E-Map and move in any direction as desired.

o o b~ w N

To move up or down the building view (No 2, Figure 8-15), right-click on the E-Map and scroll the

wheel.
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8.3.2 Utilizing 3D E-Map Icons

The 3D E-Map display comes with a set of icons for settings and control. Place the mouse cursor on the

E-Map to see the icons below.

campus

Q@ = = 2 ¥
Figure 8-15
No | Icons Functions
1 Move Up @& Move to the main folder of the current E-Map.
2 Building View = Switch the floor plan to 3D view mode of the building.
3 | Map List = Display the E-Map list.

4 E-Map Auto Popup »* | Enable this function to automatically pop up the related map whenever
any device on it is triggered. See Setting up Popup Map earlier in this

chapter.
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5 | Tools 7% Includes the following options:
B Auto Rotate: Automatically rotates the E-Map anticlockwise.
B |con Options:

»  Always Show Live Video: When selected, the
received camera live view will always be displayed on
the E-Map.

»  Show Device Name: Display the device name on the

E-Map. This option is enabled by default.

»  Large Icons: Change to large icons of cameras. By

default, the large icons are used.

»  Small Icons: Enable this option if you want to use

small icons.

B Properties: Show the E-Map name on the upper-left corner

and change the font size of the E-Map name.

B Close: Remove the E-Map display.

8.4 Remotely Accessing E-Map

You can remotely access and view E-Maps with a Web browser.

1. To remotely access E-Maps through a Web browser, click Home M > Toolbar l.’n.- >
Network &a > WebCam Server on GV-VMS. The Server Setup dialog box appears.
2. Click OK to start the WebCam Server.

3. Open the Web browser and type the address of GV-VMS. Once the connection is established, the
Single View page appears.

4. On the left panel, click Remote E-Map. The Login dialog box appears.

5. Type the login info of GV-VMS and click @ The Remote E-Map window is displayed.
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The Remote E-Map Window
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Figure 8-16

The controls in the window:

n E-Map Application

No. Name Description

1 Login Logs up to 500 hosts.

> Host Views the information of incoming events upon motion detected and 1/O devices
Information triggered.

3 Previous

Goes to the last selected E-Map file.

4 Home Goes back to the top of the tree view.
5 Next Goes to the next E-Map file.
. Accesses the Remote ViewLog function. For details, see Remote ViewLog
6 ViewLog SR
Service in Chapter 4.
7 Configure Configures the advanced settings.
8 Tree List Displays all created E-Map files and folders.

9 IP Address

Displays the IP Address of the connected host.

10 Output Icon

When events occur, the corresponding icons will blink red.

to open a control panel for the camera.

Camera / Input / Camera icon: Move the cursor over the icon to view a live image. Click the icon

Output Icon: Click the icon to manually trigger the output device. .
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Note: By default, E-Maps opened with Remote E-Map are displayed in 3D. To display the E-Maps in
2D view, click the Configure button (No. 7, Figure 8-16) and select Disable 3D eMap.

The controls in the Camera Icon

Click the cameraicon to
open the control panel

Move the cursor on the
cameraicon to have a
live image

Figure 8-17

8.4.2 Accessing E-Maps of Multiple Hosts

If you have created E-Maps for multiple hosts, you can monitor these E-Maps remotely through a Web

browser. Up to 500 hosts can be accessed at a time.

1. To start, click Login on the Remote E-Map window. The Login window appears.
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2. Select a host on the right panel and click Login. You are prompted for the required login info.

[ 2 Login

Host Login Host Logout

e =)

Fosiame | o Legn

TEST228PC [ Building B
Building C

Figure 8-18

3.  Click OK to return to the Remote E-Map window. Now you can select the corresponding E-Map for

the new host for monitoring.

8.4.3 Configuring the Remote E-Map

Click Configure M on the Remote E-Map window. The Configure window appears.

e SRR B ==

y |
[

T
| j |

C\Remote-EMapires\buzzerwav C\Remote-EMap\res\buzzerwav

Browse Browse

Figure 8-19
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[Download E-Map files] Download E-Map files from the local server to the client PC. This option can

reduce network loading if you wish to view the E-Maps of multiple hosts.

Use local E-Map files: After downloading E-Map files to the client PC, you can select and use

these E-Map files for connection.

[Motion] / [I/O Input]

Alert Sound: Assign a .wav file to alert the operator when cameras or 1/O devices are triggered.

Camera Blink, I/0 Blink: When cameras or I/O devices are triggered, their icons on the E-Map

flash. Deselect this option to stop the icons from blinking.

E-Map Auto Popup: When cameras or I/O devices are triggered, the related map will pop up on

the screen instantly when the Remote-E-Map window is minimized.
Show Event: Display motion or I/O triggered events on the Host Information window.

I/0 Trigger Camera: When input devices are triggered, the related camera views will pop up. To
enable this function, you must map input devices to cameras on GV-VMS first. See Popping up Live
View in Chapter 1.

Hide Tree List: Check to hide the tree list.

Enable DirectDraw: By default, DirectDraw is enabled to speed up graphics rendering. Some VGA
cards might not support DirectDraw and can produce distorted frames. In this case, disable the
option.

Use Small Icon: Enable for devices to be displayed by smaller icons.

Retry in the Background: When the Remote E-Map is disconnected from GV-VMS, a warning
message will pop up every 30 seconds. Select to hide the message and retry the connection in the
background.

Disable 3D eMap: E-Maps on Remote E-Map are displayed in 3D by default. Select to view the
E-Maps in 2D view.

Loop alert sound: When Alert Sound is enabled, the assigned .wav file will be played repeatedly

until it is turned off by the operator.
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8.4.4 Viewing Event List and Playing Back Videos

You can see a list of triggered events on the Host Information window and play back the desired

video(s).

1. Click Host Information @1 on the Remote E-Map window. The Host Information window

appears.

# Host Information E‘Eﬂ
/] Building B Host Name Date Time Event Type Cam_  Mod e} Name o
2 Building C ; 00

Building B 2000001/ 11:00:36 Mation MiA MiA Camera 1

ﬁ TEST-226-PC
% "4 Camera(3)-Motion Det
(% Camera(1}-Motion Det,

m_ |

TEST-226-PC 2002/04/... 06:00:00  Motion
TEST-226-PC 2002/04/... 06:08:59  Motion

NIA NIA Camera 3
NIA NIA Camera 1

Building B 2000/01/.. 10:59:48 Motion MIA MIA Camera 1
Building B 2000/04/.. 10:59:37 Motion MIA MIA Camera 1
TEST-226-PC 2002/04/.. 06:08:01 Motion MIA MIA Camera 3
Building B 2000/047.. 10:59:22 Motion MIA MIA Camera 1
Building B 2000/017.. 10:59:05 Motion TNIA TNIA Camera 1
Building B 2000/01/ 10:58:58 Motion TNIA TNIA Camera 1
Building B 2000/01/ 10:58:50 Motion TNIA TNIA Camera 1
Building B 2000/01/ 10:58:25 Motion

NIA NIA Camera 1
MiA MiA Camera 3 I
MiA MiA Camera 1
MIA MIA Camera 1
NIA NIA Camera 3
NIA NIA Camera 1
NIA NIA Camera 1
MIA MIA Camera 1
MIA MIA Camera 3

TEST-226-PC 2002/04/.. 06:06:32 Mation
TEST-226-PC 2002/04/.. 06:06:25 Mation
Building B 2000/01/7.. 10:58:00 Motion
TEST-226-PC 2002/04/.. 06:08:24  Motion
TEST-226-PC 2002/04/.. 06:08:10 Motion
TEST-226-PC 2002/04/.. 06:06:08 Motion
Building B 2000/04/.. 10:57:34 Motion
TEST-226-PC 2002/04/.. 06:05:58 Motion
TEST-226-PC 2002/04/.. 06:05:44  Motion MIA MIA Camera 3

TEST-226-PC 2002/04/. 06:05:18 Motion TNIA TNIA Camera 1 A%
| m | 3 KN m | »

Reset I Reset I

= —— = =

T e N O U U 0 SO OO FC SNPGRS Y

Figure 8-20
2. For event playback, double-click any motion event on the left panel. The player appears.

3.  Optionally right-click the image to access the advance functions of the player.

8.5 E-Map Server

The E-Map Server is an independent program designed to create E-Maps for different hosts. With the
E-Map Server, you can monitor different sites on electronic maps through any computer accessible to

the network.

8.5.1 Installing E-Map Server

You can install GV-E-Map Server from the GeoVision Website.
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8.5.2 The E-Map Server Window

Go to Windows Start, find Programs, select eMapServer and click E-Map Server. This window

appears.

LBX

Mame = Size
Cleopl e FATKE,
o emap2 0,00 KB
Figure 8-21
No. Name Description
1 Start Service Starts the E-Map Server.
2 Stop Service Stops the E-Map Server.
3 New Creates a new E-Map file.
4 Rename Renames the E-Map file.
5 Delete Deletes the E-Map file.
6 Refresh Refreshes the E-Map Server window.
7 Accounts Creates user accounts of the E-Map Server.
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8.5.3 Setting up E-Map Server

Before starting the E-Map Server, you must create E-Map files and user accounts.

® To create E-Map(s), click New (No. 3, Figure 8-21). See Creating an E-Map earlier in this chapter.

® To create a user account for the server, click Accounts (No. 7, Figure 8-21).

8.5.4 Connecting to E-Map Server

With E-Map Server, you can monitor different sites on electronic maps through any computer accessible

to the network.

1.  Open the Web browser and type the IP address of the E-Map Server.
2. Type the login info of the E-Map Server. You are prompted to select an E-Map (.emp) file.

3. Click OK. The Remote E-Map window appears (Figure 8-16).

4. Click Login to log into the desired host(s). For details, see Accessing E-Maps of Multiple
Hosts earlier in this chapter.

Note: To log into GV-VMS, make sure the WebCam Server is enabled. See Remotely Accessing

E-Map earlier in this chapter.

267



Chapter 9

Useful UtilitieS cccccceeerrnnnssnnsssssnsssssnssnnnnnsnnnnn 2 7 0

9.1 Dynamic DNS ... 270
9.1.1 Running Dynamic DNS ... 271
9.1.2 Registering Domain Name with DDNS ..., 271
9.1.3 Starting Dynamic DNS ... 272

9.2 Watermark VIeWEer ... 273
9.2.1 Activating Watermark Protection ..., 273
9.2.2 Running Watermark Proof ... 273
9.2.3 The Main Window ... e s 274

9.3 WINdoWS LOCKUP............cooiiiiiii e 275
9.3.1 The GV-DeSktop SCreen.............ooooiiiiiiii it 275
9.3.2 GV-DeSktop FEatUres ..............coo oo 276
9.3.3 Token File for Safe Mode....................cco i 278

9.4 Authentication Server..................ccci 279
9.4.1 Installing the Server ... 279
9.4.2 The Main WINdOW..............coooiiiiiii e seee s 280
9.4.3 Creating Clients..................coii s 281
9.4.4 Creating User ACCOUNES ...t 282
9.4.5 Importing Groups and Users from Active Directory............................ 285
9.4.6 Starting the Server................oo 288
9.4.7 Connecting GV-VMS to the Server..................ccooiiiiiii e, 290
9.4.8 Remote Access from Control Center and Remote E-Map.................... 292

9.5 FastBackup and Restore.............................o, 295
9.5.1 Running the FBR Program......................iii e 295
9.5.2 Plugin Component.. ... 296
9.5.3 Customizing the Features ....................cocooiii e 297
9.5.4 Backing up and Restoring Settings .....................cccci, 298

9.6 Bandwidth Control ...................... 301
9.6.1 Installing the Bandwidth Control .........................., 301
9.6.2 The Main WIndoW...............cooiiiiiii e 302
9.6.3 Allowing Remote Control ... 303
9.6.4 Connecting to WebCam Server ... 304
9.6.5 Controlling a Specific WebCam Server .................cccoooiiiiiiiiiiiice, 305

268



9.6.6 Settingup Bandwidth....................... 306

9.6.7 BlOCK LiSt S@tUP ... 307
9.6.8 General SetUP ... e 308
9.7 Language Setting ... 309
9.7.1 Installing the MultiLang Tool ..., 309
9.7.2 Revising the Translated Text .................cccc i, 310
9.7.3 Setting up the Ul Language to English ... 313
9.8 GV-SD Card Sync Utility ..., 314
9.8.1 Installing GV-SD Card Sync Utility ..., 314
9.8.2 Setting up GV-SD Card Sync Utility ..., 315
9.8.3 The Main WindOW.............oooii e 318
9.9 Media Man ToolS ... 319
9.9.1 The Media Man Tools Window ..., 319
9.9.2 Viewing Disk Drive Status ..., 320
9.9.3 Adding @ DisSk Drive ..o 322
9.9.4 Removing aDisk Drive ...............cco o 323
9.9.5 Logging in Automatically at Startup ... 324
9.9.6 Settingup LED Panel ...................oo e 324
9.10 Alert Notifications through SNMP Protocol ......................... 327
9.11 Localand Remote Backup ...............ccccoooiiiiiiiiiiiiii e, 328
9.11.1 Remote BacCKUP ... 328
9.11.2 LocCal BAcCKUP ..o s 328
9.11.3 Advanced Settings ... 330
9.11.3.1 Advanced Settings for Local Backup.....................c.ccooiiiiniiinnen. 330
9.11.3.2 File Transfer Settings for Local Backup ..., 332
9.12 Report Generator ...................ccoooii i 334
9.13 GV-Cloud Center...............ooo oo 334

269



Useful Utilities

GV-VMS supports some advanced utilities to enhance the system performance in a security network.

9.1 Dynamic DNS

GV-Dynamic DNS provides domain name registration, making your dynamic IP address point to your
GV-VMS server. The GV-Dynamic DNS will update the server’s IP address to DNS Server every 10
minutes. Even if your server’s IP address changes, you can still locate it by using the registered

domain name.

Note: GV-Dynamic DNS uploads IP addresses over the Internet through ports 80 and 81. If your
GV-VMS server is connected behind a router or firewall, make sure ports 80 and 81 are enabled.
GV-Dynamic DNS will only upload global IP addresses. If your GV-VMS server is using virtual IP, NAT
port mapping should be done first.

IMPORTANT: The DDNS service simplifies the process of trying to connecting an IP video device to
the network. However, GeoVision does not and cannot warrant that the DDNS service will be
uninterrupted or error free. Please read Terms of Service carefully before using the service. Besides
GeoVision, you can also obtain the free DDNS service from these providers: DynDNS.org and

No-IP.com.
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9.1.1 Running Dynamic DNS

GV-Dynamic DNS Service is included in the installation of GV-VMS. Go to Windows Start >
Programs > GV-VMS > DNS Client V2. The DNSClient V2 dialog box appears.

9.1.2 Registering Domain Name with DDNS

1. Click Register on the DNSClient V2 dialog box. The registration page appears.
6 DNSClient V2 == ==

Hostname:

[Ex: xoo0oa.gvdip.com)
Please ensure your hostname which may be
-gvdip[xx].com. xx may be from 01 to 99.

Password;

@ Qbtain an IP address automatically
(1 Uge the following IP address

127 . 0 o 0 o 1

Run at startup

EMail Setting ] ’ Save

IRegister

Figure 9-1

2. Type a username and password and the Word Verification code. The password must be at least 6
characters.

3. Click the Send button. The following message appears.

Hosmame: julia gvdip.com

IP Address: 114.32.17.31

Your hostname will be activated in 2 minutes.

Your hostname will be deleted if vou don't update your host address for 30 days.

Figure 9-2

B Hostname: Made by registered username and “gvdip.com”. In this example, the hostname is

“http://julia.gvdip.com”. This will be the domain name used to log into your server.

B |P Address: Your server’s current IP address. This IP address is updated every 10 minutes.

Note: The domain name .gvdip(xx).com may vary with xx from 01 to 99.
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9.1.3 Starting Dynamic DNS

After registering a domain name with GV-Dynamic DNS, enable the DDNS function on your server.

Run DDNS Client V2 (Figure 9-1) and be sure GeoVision software is also enabled at the background.

After typing the Hostname and Password used to enable the Dynamic DNS service, complete the

following settings:

m  Obtain an IP address automatically: The DDNS server will use any available IP address from

the server or the router.

m  Use the following IP address: If your server or router has more than one IP address, you can
assign one |IP address to connect between the DDNS server and GV-VMS. It is highly suggested
to assign a fixed IP address instead of a dynamic IP address, which will not be accessible for the
DDNS when the IP address is changed.

[ Run at startup: Select to automatically run the DDNS service at Windows startup.
m  E-mail Setting:
o Scheme: Select a given situation to receive e-mail notifications.
o Sender: Type the name, e-mail address, username and password of the sender.

o Receiver: Type the recipient’s e-mail address(es). For multiple recipients, add a semicolon

between each e-mail address.

o Mail Server: Type the host name or address of your mail server. Keep the default port 25 or
modify if the mail server uses a different port. Select SSL if your e-mail server requires the

SSL authentication for connection.

o Click the Test button to send a test e-mail to confirm if the settings are correct.

Click Save. The connection information will be displayed.

Note: The DNS Client will not upload the IP address unless the compatible GeoVision software is
running such as GV-VMS. If the IP address of your server is not updated for more than 30 days, your

host name will be deleted automatically.
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9.2 Watermark Viewer

GV-VMS can embed digital watermarks in video streams for authentication purposes. The watermarks
are encrypted with digital signatures in video streams during the compression stage, ensuring that
images are not edited or damaged after they are recorded. In addition, you can apply the Watermark
Proof, a watermark-checking program included in the installation of GV-VMS, to further verify the

authenticity of the recording.

Note: To run the Watermark Proof application in the backup file on your PC without GV-VMS, you
must register the GeoVision Video Codec manually (go to the recorded files’ location >

GeoCodecReg folder > double-click GeoCodecReg).

9.2.1 Activating Watermark Protection

To enable the watermark protection, click Home M > Toolbar l’nh > Configure Q > System
Configure > Record Setting. Select Use Digital Watermark Protection and click OK. GV-VMS will

digitally sign videos during the recording.

Record Setting

Wideo Record Databhase Folder

Max Video Clip: -u Min. V] Recycle DAGYYMEICameraDBs E
[C] Post-Ree: 3 | e [T Register Event

I [ Use Digital Watermark Protectionl StaryLine

[C]Pre-Rec: 1 video Clips
[¥] Keep Image Ratio

Resolution: |1280%1024 hd

EelE ey Path:  CiProgramDatalGeovisiont D

Video Clips & Sec.

[Urgent Event v]

Figure 9-3

9.2.2 Running Watermark Proof

1.  Go to the GV-VMS folder and run WMProof.exe. The Watermark Proof window appears.

2. Click File from the menu bar, select Open, locate the recorded file (.avi) and click Open. The
selected file is listed on File List (No. 9, Figure 9-4). Alternatively, you can directly drag the file

from the storage folder to the window.

« If the recording is unmodified, a check mark will appear in the Pass column.
« If the recording is modified or does not contain watermark during recording, a check mark will

appear in the Failed column.

3.  To play the recording, double-click the listed file on the window.
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9.2.3 The Main Window

Similar Rate
100 %

Qriginal Extracted

¢C ¢—o

File Name Pass | Failed | Similar Rate
1|DAGY-14801cam0A02021Event20100203173801009.a, | I Pass ) _9
778/1085(CurrentTotal frame) 12/3/2010 17:38:27.919
Figure 9-4
No. Name Description
1 Open File Opens the recorded file.
2 First Frame Goes to the first frame of the file.
3 Play Plays the file.
4 Previous Frame Goes to the previous frame of the file.
5 Next Frame Goes to the next frame of the file.
6 Previous Watermark Frame Goes to the previous frame that contains watermark.
7 Next Watermark Frame Goes to the next frame that contains watermark.
8 Original vs. Extracted The Extract_eq icgn should be idel_'ltical with the Original
icon. If not, it indicates the recording has been tampered.

9 File List Displays the proof results.
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9.3 Windows Lockup

The GV-Desktop helps you secure your computer while away from your workstation. You may lock up

the Windows desktop while launching a customized GV-Desktop. In the GV-Desktop, users are limited

to run GV-VMS and selected programs.

9.3.1 The GV-Desktop Screen

The GV-Desktop is included in the installation of GV-VMS. Go to Windows Start > Programs >
GV-VMS > Key Lock Utility. The GV-Desktop screen appears.

Figure 9-5

No. Name

Description

1 Programs

Accesses programs.

2  Settings Adds programs to the Programs menu.

3  Log Off Logs off GV-Desktop.

4 Shut Down Shuts down the computer.

5  Task Manager Views the tasks currently running on your computer.
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9.3.2 GV-Desktop Features

Programs

Click the Programs button (No.1, Figure 9-5) to see the program menu. The default programs are
Video Management System (GV-VMS), Repair Database Utility, eMap Editor and Control Center
Service. To add or remove new programs to the menu, see the Settings section later in this chapter. In

the example below, Paint is a new program added to the menu.

* ‘fideo Management System
%l Repair DataBase Utiity
B etMap Editor

<) Control Center Service

W aint
B =

|
Figure 9-6
Settings
Click the Settings button (No.2, Figure 9-5) and type the valid ID and password. This window appears.
Settings le
I0: 1 [ Paszword... ] [ Export Token... ]
Swstem menu

L Video Management System

g Repair Datab aze Uiy

Customize meru

£ snap Dwr

[ ad. | [ FRemoe | [ Edt. |

Administrative Tools
>

Add... Remaove Edi...

[esktop Type

| indows -

Figure 9-7

[Password] Change the password. For the Allow Removing Password System option, see Account
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and Password in Chapter 1.
[Export Token] See Token File for Save Mode later in this chapter.
[System Menu] Select a desired program and click the Edit button to change its name.

[Customize Menu] Set up the Programs menu as desired. To add a program, click the Add button. In
the Shortcut dialog box, type the program name, click the button next to the field to assign a path and
click OK.

[Administrative Tools] Set up the Programs menu as instructed in Customized Menu option. To run
the added programs configured in the Administrative Tools field, the administrative ID and Password

are required.

[Desktop Type] Select Windows or GV-VMS from the drop-down menu. The selected desktop will

launch the next time when you log into the computer.

Log Off
Click the Log off button (No.3, Figure 9-5) to log off GV-Desktop with a valid ID and password.

Shut Down
Click the Shut Down button (No. 4, Figure 9-5) to shut down your computer with a valid ID and

password.

Task Manager
Click the Task Manager button (No. 5, Figure 9-5) to view the programs which are currently running on
your computer. When you minimize a program, it will be hidden and under operation in the background.

To bring the program back to desktop, double-click the program listed in Task Manager.

Task Manager §|

ﬁ HyperSnap 7 - [desktop - enter token.prg]
Y deskiop.PNG - Paint

1.j urtitled - Paint

) Common

Figure 9-8
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9.3.3 Token File for Safe Mode

This option in the Settings section lets you export a token file. In case you enter safe mode and are in
the status of the GV-Desktop, this token file allows you to exit from the GV-Desktop and enter the

Windows desktop. To export a token file, follow the steps below.

Exporting the Token File
1. Click the Export Token button (Figure 9-7). The Enter Token Code appears.
2. Type a code in the Token Code field and click OK.

3. Inthe Save As dialog box, locate a path, type a desired name in the File Name field and click

Save to save the file.

Switching from GV-Desktop to Windows Desktop
1. Click the Settings button on the GV-Desktop. You will be prompted to locate the stored token file

and type the configured token code.

2. When the Settings window (Figure 9-7) appears, select Windows in the Desktop Type field and

exit from the window.

3. Click the Log Off button to log off the GV-Desktop and run the Windows desktop. You need to

locate the stored token file and type the configured token code again.
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9.4 Authentication Server

GV-Authentication Server is a password and account management system for multiple GV-VMS

systems. Through the Authentication Server, the administrator can create the accounts with different
access rights to a group of GV-VMS systems. Once any GV-VMS is connected to the Authentication
Server, the previous password settings in local GV-VMS will be invalid. Local GV-VMS will submit to

the full control of the Authentication Server.

Note:

1.  In addition to GV-VMS / DVR / NVR where the Authentication Server acts as a password and
account management system, the Authentication Server also supports E-Map Server,
GV-Control Center, GV-Edge Recording Manager and GV-Eye app to allow users to access a
specified group of GV-VMS / DVR / NVR hosts through an Authentication user account.

2. GV-Eye V2.8.0 or later and GV-Edge Recording Manager V2.1.0 or later support multiple

GV-Authentication Server connections at a time.

9.4.1 Installing the Server

You can install GV-Authentication Server from Utilities in GeoVision Website.
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9.4.2 The Main Window

Go to Windows Start > Programs > AuthServer > AuthServer. This window appears.

haaand

6,7 8,9 10
| |

[2=Y

%I‘errceTawer-- Online éééﬂ&&
[EEx o5 o
faw [ Cient Hame Client IP 1
O EM::sServer List VMS 192.168.1.1
=\ Client List
BX Eye
Client Name: +
Client IP:
Client Tel:
Client FAX:
Client Address:
Login Time:
Status: [ Client: 1 /2]
Figure 9-9
No. Button Description
1 Add An Area Creates an Area group.
2 Add A Client Creates a client account.
3 Delete An Area / Client Deletes an existing group or client.
4 View/Edit A Client Select a client from the Client List, and click to view / edit it.
5 Find A Client Finds an existing client.
6 Start/Stop Service Starts/Stops the Authentication Server.
7 Server Setup Configures the Authentication Server.
Configures passwords and grants permissions to clients. Imports
8  Account Setup ) .
groups from Active Directory.
9 Log Sets up the Authentication Server Log and opens the log browser.
10 Exi Exits this window; Logs out Administrator; Changes
Xi
Password, imports or exports account information.
) ) Lists the connected clients: GV-VMS / DVR / NVR, E-Map Server,
11 Connected Client List )
GV-Control Center, GV-Edge Recording Manager and GV-Eye.
12 Client Information Lists the information of the selected client.
13 Client List Lists the created clients.
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9.4.3 Creating Clients

You must create and arrange the clients first which user credentials will be centrally managed by the

Authentication Server. To create a list of GV-VMS clients, follow the steps below.

1. To create a GV-VMS client, highlight the Host List from the left pane and click the Add A Client

button +:H . The Client Information dialog box appears.

ﬁ,ﬂ Authentication Server --

x|
EESY ot Lt

....:-‘ EMap Server List
i35 Client List

Figure 9-10

2. Type the client’s information and select Automatic get connection info. The Name must match
that of local GV-VMS.

3. Optionally select Manual Setting and type the IP address of the Authentication Server. Keep the

default ports or modify them if necessary.

Client Information *
Mame: | |
TEL: | |
FAX: | |
Address

(O Automatic get connection info

® Manual Setting
P [218.161.78.103 |
Command Port: | 3388 |
Data Port: [s611 |
Log Port : [ 5552 |
Mobile Stream Port : [ 56000 |
DK Cancel
Figure 9-11
4. Click OK.
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Tip: To view the name of your GV-VMS server, select Toolbar n:- > Configure > System
Configure > General Setting.

General Setting [
Location Name Related Actions
Buiding A e
[T] Auto enable wave out
Monitor Opti
Salisibpien [ Auto toggle talk back
[l start Delay: & | Sec.
[¥] Auto switch PTZ mapping
[[]service Mode  (E)
Exit Option
Display
[ |Auto Restart Windows
[#] Enable DirectDraw
Figure 9-12

5. To create another client, repeat the steps above.

6. You can also arrange multiple clients under a group by highlighting a list and clicking the Add An

Area button (No. 1, Figure 9-9). The created group appears under the selected List.

9.4.4 Creating User Accounts

To create user accounts with different access rights and assign the user accounts to a group of

GV-VMS clients, follow the steps below.

1. Click the Account Setup button (No.8, Figure 9-9) > Password Setup. The Password Setup
dialog box appears.

2. Create a user account. Refer to Account and Password in Chapter 1.

Note: The Administrator has the authority of changing the passwords of any accounts.
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3. To assign the created user to a group of GV-VMS clients:

A. Click the Group Setting button.

[¥] Digable Account ] Expire in (days)

10 Guest

Pagsword :

Hint :

Level : Guest

Walid Group: |E.% Al DVR v|
I Group Setting "

[ User cannot change password

[IForce password change at next login

[IDisable account if user does not log in after (days)

Figure 9-13

B. Inthe Valid Group List window, click the New Group button.

Valid Group List —
& [ | >
'_:— Group List

Figure 9-14

n Useful Utilities

C. Inthe DVR Group Information window, name the group, select the GV-VMS clients to be

added to the group. Click OK.

-

DVR Group information

=)

Group Mame Building

¥ = Building &
v &, Building B
v ® Building C
¥ = Building O

SelectAll H UnselectAll ][ oK

] ’ Cancel

Figure 9-15

D. Click OK again to return to the Password Setup window.
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E. Use the Valid Group drop-down list to select the created group. The user will be able to log in
the assigned GV-VMS clients.

Valid Group: Ak Building l:]
=, All DVR
= Building A

= Building B
[C]User cannot change passwor @ pyilding ¢

| Force password change at ngwe.guilding 0

|- Building |

[ Disable account if user does

Figure 9-16
4. Optionally use the following functions to arrange the user and client accounts.

A. Right-click a user account to have two options. The Apply setting to option will apply the
same settings to a specific user account. The Apply setting to group option will apply the

same settings to all user accounts under the same account level.

e Guest [ Disable Account
User
- Powerldser ID:
=% Supenisor Pacewnrd -
o : m Add Mew Account
i . @ Building A Find Specific Account

- = Building B
- = Building C

Remowve This Account

Change Password

- = Building D
‘ serwispy Apply setting to group
Apply setting to 4
| = = — 35 S
| =1
Figure 9-17

B. Right-click a client account to have two options. The Apply setting to other DVR(s) option
allows you to apply the same settings to all clients under the same user account. For this
example, the settings of Building A client will be applied to all Building B, C and D clients. The

Copy option allows you to copy and paste one client’s settings and any client.

= Guest [] Disable Account
User
- PowerUser b
- Supenisar Password :
9‘ admin Hint.
P Q Apply setting to other DVR(s)
= Building B
... ® Building C Copy
. L. @ BuildingD Paste
w- 2 serwispy
Figure 9-18
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9.4.5 Importing Groups and Users from Active Directory

To create user accounts efficiently, you can import groups and users from Microsoft's Active Directory
to Authentication Server. You will need to install Active Directory on Windows Server and set up users

into groups before following the steps below.

Note: User accounts in Active Directory need to be grouped into Groups settings first as only groups

can be imported into Authentication Server.

1. Run Active Directory Domains and Trusts in Windows Server by clicking the Start menu and

opening Administrative Tools.

2. Right-click your local Active Directory system and select Manage. The Active Directive Users and

Computers dialog box appears.

33 Active Directory Domains and Trusts
File Action View Help
e @ EE
i FAEC
= T Type FAE.co
Raise Domain Functional Level... ns to show in this view. Mor
View 3
Export List...
Properties
Help
IT
E Active Directory Users and Computers = =] =
File Action View Help
LG EEREE TRETER
] Active Directory Users and Com|| Name Type Description
b (| Saved Queries “| Builtin builtinDomain
4 | FAE.com | Computers Container Default container for up...
b [ Builtin 2| Domain Controllers Organizational.. Default container for do...
b Camp.uters _| ForeignSecurityPrincipals Container Default container for sec...
4 :_— DDI"{'!EII'I Coﬂtrolla.rs i EI Infrastructure infrastructurel...
b - Enr:’-\gndS:(un;yPnnnpa\- | LostAndFound lostAndFound Default container for or...
= MDS " dosun ice A | Managed Service Accounts Container Default container for ma...
b — :r:nar?: ervice Accoun | NTDS Quotas msD5-CueotaC...  Quota specifications co..
b - P 21 persons Organizational...
I || Program Data - X .
< _| Program Data Container Default location for stor...
I [ ] System
b [ Users :_Systern . Container Builtin system settings
b [ NTDS Quotas _| TPM Devices msTPM-Infor...
b [ TPM Devices | Users Container Default container for up...
< n >
Figure 9-19

3. On the View menu, select Advanced Features.
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Note: If you use Windows Server 2008 instead of Server 2012, skip this step.

4. Right-click the folder saved with the user accounts or groups and select Properties.

Tip: You can change the query parameters or show all items for each folder by clicking View and

selecting Filter Options.

5. Select the Attribute Editor tab, double-click the attribute distinguishedName and copy the value
like OU=persons,DC=FAE,DC=com. You will need to paste the value at step 8, C to assign the

folder to import the user accounts or groups.

6. Inthe Authentication Server, click the Account Setup button (No.8, Figure 9-9) and select Active

Directory Setup. This page appears.

Configure -

Source Database
(O Default Database

(®) Active Directory

Active Directory Setup

Server IP Address |12?.D.D.‘I

Fort: 389

O Connect with current login information

(® Connect with administrator login information

User Name |administmtor |
Password : |uuuu. |
Test Connection
Distinguished name (DM) or naming context
Group Search Base: |0U=Der50n3.DC=FAE.DC=com |
User Search Base: |CN=Users.DC=FAE.DC=com |
Group Mapping Setup Auto Update Setup
[] Auto update

Assign Authority Level | 5

Please restart Authentication Server for changes to take effect.

| OK | | Cancel

Figure 9-20
7. Under Source Database, select Active Directory to enable the function.
8. To connect to the server with Active Directory:

A. Type the Server IP Address and the Port number of the server.
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B. To log into the server using your current login information, select Connect with the current
login information. To log into the server using the login information of its administrator, select

Connect with administrator login information and type the user name and password.

C. Paste the value of distinguished name you copied at step 5 respectively to Group / Users

Search Base.
D. Click Test Connection to see if you can connect to the server with Active Directory.
To assign groups in Active Directory to User, Power User or Supervisor authority levels:

A. Click the Assign Authority Level button. This dialog box appears.

Group Mapping Setup E|
Undefined Graup - User
windows AuUthorization Access Grou| iarouplos
Dornain Controllers Group00z
Denied RODC Password Replication
Server Operators
Darnain Adrmins

Cryphographic Operators
Metwork Configuration Operataors
Remote Desktop Users

Damain Users v 2
Enterprise Admins

Users

Certificate Service DCOM Access Povweruser

I15_IUSRS Group0ol

Replicatar

Darmnain Guests
Cert Publishers
Performance Log Users
Performance Monitor Users
Read-only Domain Controllers
Guesks
Terminal Server License Servers
. < >
Dornain Compukers
Distributed COM Users -
Print Operators Supervisar
Allowed RODC Password Replication
Incoming Forest Trust Builders
Pre-windows 2000 Compatible Acce:

Backup Operatars - -

Administratars

Account Operators

RAS and IAS Servers

Group Policy Creator Owwners L

< » ¢ s

[ OK l [ Cancel

Figure 9-21

B. Select the groups detected in Active Directory from the Undefined Group list and use the
arrow buttons to assign the groups to User, Power User or Supervisor level.
C. Click OK to import the user data into the Password Setup window.

To automatically update changes to user data in Active Directory, click Auto Update and specify

the update frequency in minutes.

Click OK and restart Authentication Server to apply the settings.
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9.4.6 Starting the Server

To configure the server and start the service, follow the steps below.

1. Click the Server Setup button (No. 7, Figure 9-9). This dialog box appears.

€5 Sarver Setup §|

Metwork Setting

Server Port 3663 Default
[¥] sutomatic Falover Support Setting

Security Setting
Authorized 1D

Authorized Password

[CJEnhance netwark security El
[JEnatle IP wWhite List
Server Setup
[ autorun server service upon startup
[IMotify when DWR is disconnected from server
[ oK ] l Cancel

Figure 9-22

2. Under Security Setting, type the Authorized ID and Authorized Password which will be used for
the client GV-VMS to log into the Authentication Server.

3. Click OK to apply the settings.

4. Click the Start/Stop Service button (No. 6, Figure 9-9) to start the services.

Optionally, you can configure the following settings before starting the Authentication Server:
[Network Setting]

B Server Port: The default port number is 3663. To use UPnP for automatic port configuration to

your router, click the Arrow button. For details, see UPnP Settings in Chapter 7.

B Automatic Failover Support: Select and click the Setting button to configure up to 2
Authentication Servers in case the primary Authentication Server fails. If fails, the second or the
third server will take over the connection from clients and provide uninterrupted services. Note the
settings of Authorized ID and Authorized Password on the failover server must match those of the

primary server.
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Tip: To set up the failover Authentication Server, you can export the current settings by using the

Export Account and Import Account functions in the Exit button.

Note: Once the primary Authentication Server is ready to resume the services, close the failover

Authentication Server so the connection from clients can move back to the primary.

[Security Setting]
B Enhance network security: Strengthen network security on Authentication Server.

B Enable IP White List: Click Edit to create a list of IP addresses only to establish connection with

Authentication Server.

[Server Setting]

B Auto run server service upon startup: Starts the service automatically upon the startup of

Authentication Server.

B Notify when DVR is disconnected from server: Notify the Authentication Server with a pop-up

window when the GV-VMS is disconnected with the Authentication Server.
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9.4.7 Connecting GV-VMS to the Server

To configure the GV-VMS in order to access the Authentication Server remotely through a network

connection, follow the steps below.

1. On the main screen of GV-VMS, click User k=i > Password Setup > Remote Authentication
Setup. The Setup Remote Authentication Server dialog box appears.

Setup Remote Authentication Server @

Server offdine

Allow local supervisorto Stop Use Remote Authentication
System.

| Allow user to use local account login remote application {eq.
Webcam Remate View).

Change User (L)

Logout () Login with authertication server backup account
Local Account Edit Password Setup >
Setup Server ]
I Remote Authentication Setup I
Startup Auto Login ok ] [ Cancel
Figure 9-23

2. Select Use Remote Authentication and optionally select:
[When Remote Authentication Server Off-line]

B Allow local supervisor to stop use Remote Authentication System: Allow the local
supervisor to stop the Authentication application when the connection fails with the
Authentication Server. Note if the option is disabled and the connection fails with
Authentication Server, the local supervisor will not be able to log into the GV-VMS, and the

dialog box will not be accessible until the connection resumes.

B Allow user to use local account login remote application: Allow local users to access
remote applications with their previous password and ID settings when the connection with

the Authentication Server fails.

B Login with authentication server backup account: Keep using password settings created

on the Authentication Server even though the connection with the server fails.
Click Setup Server. The Remote Authentication dialog box appears.
Type the IP address and port of the Authentication Server.

Type the Authorized ID and Authorized Password of the Authentication Server.

S

Click OK to start the connection. When the connection is established, the previous password
settings in GV-VMS will be invalid.
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7. Press [L] on the keyboard to call up the Login dialog box. The icon EI indicates that the
connection is established.

Login - Remote Authentication System E|
e

D I -

Password

Faorgot Password |

@ Change Passward |

@

0] 54 | Cancel|

Figure 9-24

As long as the Authentication Sever works, the Login dialog box will appear upon the starting of

GV-VMS. Type the user account created on the Authentication Server to log into the GV-VMS.

Note: The disconnection icon m will appear on the Login dialog box (Figure 9-24) when one of the
following situations occurs:

1. The login ID and Password do not match any of the user IDs and Passwords created on the

Authentication Server.
2. The client name does not match the location name of GV-VMS (Figure 9-12).

3. The network connection encounters traffic problems.
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9.4.8 Remote Access from Control Center and Remote E-Map

The Authentication Server supports E-Map Server, GV-Control Center, GV-Edge Recording Manager,
and GV-Eye to allow users to access a specified group of GV-VMS hosts through an Authentication

user account.

You must first set up remote authentication on E-Map Server and GV-Control Center. After the E-Map

Server and GV-Control Center are connected to the Authentication Server, the user will be prompted to
log in with the user ID and password you created on the Authentication Server. Once the user logs in, a
list of GV-VMS hosts authorized to the user account will be displayed, and the user will be able to view

the assigned cameras.

Setting up Authentication Server

You need to create and arrange client accounts of E-Map Server, GV-Control Center, GV-Edge
Recording Manager, or GV-Eye under their separate lists on the Authentication Server window (Figure
9-9).

1. Inthe Client List field, click the E-Map Server List or Client List, and click the Add A Client
button (No. 2, Figure 9-9). The Client Information dialog box appears.

2. Type the name and information of the desired software or mobile app to be connected. The name

does not need to match the location name of the software or mobile app.

3. Click OK to add the client.

Accessing from E-Map Server

The E-Map Server can access the user account setting of the Authentication Server.

1.  Runthe E-Map Server. For details, see E-Map Sever in Chapter 8.
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2. Inthe E-Map Server window, click Tools on the menu bar, and select Options. This dialog box

appears.

Options El
ehapS erver Part: [ |
Startup type: Manual v|

Uze Remote Authentication

[ Ok ][ Cancel l

Figure 9-25
3. Select Use Remote Authentication.

4. To enable the Authentication Server service to start automatically at Windows startup, select

Automatic. Keep the E-Map Server Port 80 as default or modify if necessary.
5. Click OK to apply the settings.
6. Inthe E-Map Server window, click Tools on the menu bar and select Remote Authentication.

This dialog box appears.

Remote Authentication rz|

Metwork Setup

Server P | 127.0.01 |

Server Fort |3563 | [ Default ]

Authorized D

| 123456 |

Autharized Passward

Client MName | 1 |

[ ok || cancer |

Figure 9-26

7. Type the IP address, authorized ID and authorized password of the Authentication Server, as well

as the E-Map Server’s client name created on the Authentication Server, and then click OK.

8. Inthe E-Map Server window, click Tools on the menu bar and select Start Service to start the

E-Map Server.

9. When you log into the E-Map Server, type the user ID and password created on the Authentication

Server. Alist of assigned GV-VMS clients to the user will be displayed.
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Accessing from GV-Control Center

The GV-Control Center can access account settings of the Authentication Server.

Note: The Authentication Server only supports GV-Control Center V3.1.2.0 or earlier.

1. Run the GV-Control Center. For details, see GV-Control Center User’s Manual.

2. On the Host List, right-click Host List by ID and select Remote Authentication Setup. A dialog

box appears.

3. Type the IP address, authorized ID and authorized password of the Authentication Server, as well
as Control Center’s client name created on the Authentication Server, and then click OK to enable

connecting to the Authentication Server.

4. To access the Authentication Server account settings, on the Host List, right-click Host List by ID

and select Get Host List by ID. A dialog box prompts you for ID and password.

5. Type a user ID and password created on the Authentication Server, and click OK. A list of

assigned GV-VMS hosts to the user will be displayed.

Accessing from GV-Edge Recording Manager / GV-Eye

For details, see Chapter 8 in GV-Edge Recording Manager User’s Manual or Chapter 13 in GV-Eye

Installation Guide.
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9.5 Fast Backup and Restore

With the Fast Backup and Restore (FBR) solution, you can change interface skin and customize

features to suit personal preference, as well as backing up and restoring your configurations in

GV-VMS.

9.5.1 Running the FBR Program

Go to Windows Start > Programs > GV-VMS > Fast Backup & Restore Main System. You will be

prompted to enter a valid ID and Password of GV-VMS, and then this window will appear.

#5 Fast Backup/Restore GV-VMS System

N~

Backup Remote AP
Settings (CenterV2,
VSM, CMS, Dispatch
Server)

Fast Backup/Restore Digital Surveillance System’s Settings
Please choose one of the selections below:

| Customize Features

Plugin Component

Backup GV-VMS Settings or Restore
Defaults

Backup Remote AP Settings

=

Figure 9-27
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9.5.2 Plugin Component

You can add programs to your GV-VMS to expand the applications.

1. Inthe FBR window (Figure 9-27), click the Plugin Component icon. This dialog box appears.

User define &|

Anplication File Parameter

Add Ok Cancel

Figure 9-28
2. Click Add. The Add New Item dialog box appears.

Note: For some applications, type /FBR in the Parameter column if necessary.

3. Type the name of the desired application, locate its path and click OK.

4. To add more applications, repeat steps 1 to 3 and click OK in the User Define dialog box.

5. To access the added applications, run the GV-VMS, click Home M > Toolbar K& > Tools

G, point to Plugin and select a desired application.
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9.5.3 Customizing the Features

Not every feature may be of equal interest to you. You can specify which features are to be displayed

at system startup.

1. Inthe FBR Window (Figure 9-27), click Customize Features. This dialog box appears.

Customize System Functions E|
Feature: Description;
Start/Stop/Edit the schedule

+ I/ Module
wideno Analysis
Metwork

User Setting
General Settings
Other

-

) Default Ok Cancel

Figure 9-29
2. Expand the folder(s) and click the function(s) you want to disable in the GV-VMS.
3. Click OK to save the settings.
4. Restart GV-VMS for the settings to take effect.
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9.5.4 Backing up and Restoring Settings

You can back up the configurations you made in the GV-VMS, and restore the backup data to the

current system or import it to another GV-VMS.

Backing up the settings

1. Inthe FBR window (Figure 9-27), click the Backup GV-VMS Settings or Restore Defaults icon,

and select Backup Current System.

2. Select which settings you want to back up and click the Next Step button (=]

3. Inthe Save As dialog box, select the destination to store the backup file. When the backup is

complete, the “Successfully Backup GV-VMS System Settings” message will appear:

Restoring the System

You can restore the current system with the backup of configuration file. Also, you can copy this

backup file to configure another system with the same settings as the current system.

1. Open the backup file (*.exe) you previously stored. A valid ID and password are required to

display this window.

¥ Fast Backup/Restore GV-VMS System I =1 e

Fast Backup/Restore Digital Surveillance System’s Settings
Please choose one of the selections below:

| Restore GV-VMS System or Restore
@ Defaults

gﬁ' Restore Remote AP

Figure 9-30

2. Click the Restore GV-VMS System icon and then select which backup settings you want to

restore.
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3. Click the Next Step button E to start restoring.

4. When the restoration is complete, the “Successfully Restore GV-VMS System Settings” message

will appear.

Scheduling Configuration Backup

You can now set up a regular schedule with password protection to back up the GV-VMS

configurations you made.

1. Go to Windows Start > Programs > GV-VMS > Fast Backup & Restore Main System. Type a
valid ID and Password of GV-VMS as prompted.

2. Click Backup GV-VMS Settings or Restore Defaults > Schedule Setup.

3. Select Active Schedule.

FBR Schedule Setting [

{¥  Active Schedule -

Schedule Type
' Daily Schedule

" Weekly Schedule ISUH ’l
" Monthly Schedule 1 YI

—Backup Setting
VMS: ¥ Password
vV General
v Schedule

IV Network ‘

Login Information
UserID |

Password I

Save Path -

C\GV-VMS\FBRIFBR_SCHE_Data\ | ‘

OK I Cancel |

Figure 9-31

4. Select a desired schedule type.
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5. Select desired options for backup.

Password: Back up all the user accounts and password settings of GV-VMS.

General: Back up all the settings of video analysis, IP devices, system configurations,
Content List, E-Map, GV-Keyboard / GV-Joystick, and System Log.

Schedule: Back up the recording schedule configuration.

Network: Back up the network configuration of connection to VSM (Vital Sign Monitor) and

to Center V2.

6. Type a user ID and password in the Login Information section. The ID and password must be
identical with that of a user account created in GV-VMS. You will need to use this ID and password

to restore the backup file.

7. Locate a path to save the backup contents.

Restoring Defaults

To restore the system default, click the Backup GV-VMS Settings or Restore Defaults icon (Figure

9-27), select Restore Defaults and follow the on-screen instructions to complete the process.
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9.6 Bandwidth Control

The Bandwidth Control is an independent application that controls and monitors the network traffic of

the WebCam Servers. It has the following features:

® Manage up to 5 GV-VMS systems

® Get bandwidth usages of every Webcam Server and every user
® Set bandwidth thresholds for specific users and IP addresses

® |P black and white list

® Kick unwanted users

9.6.1 Installing the Bandwidth Control

You can install GV-Bandwidth Control Client Site from Utility in GeoVision Website.
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9.6.2 The Main Window

After the installation is complete, double-click the Bandwidth Remote Control icon created on the

desktop. The Bandwidth Control window appears.

[B=Ey

= 555 Host & ServerMame  Usef Name IP Address Bandwidth Bandwidth | Bandwidth % Status Login Tirme ]
9__;\_&127001(127001 i@ WehCa 80.52 KB/s
@i WebCam -5 joyce (4] 127.0.01 27.09 KBis 33 % 2007-12-03
82 ‘Winnie (5) 192168.0245 26.65 KB/s 32 % 2007-12-03
82 JACK (B 192168.0245 27.08 KB/s 33% 2007-12-03
EventLog | Bandwidth Record
Ewen User Name IP Address Login Time
Servef Login WiebCam 127.0.0.19 2007-12-03 17:00:56
Servef Login WiebCam 127.0.0.1 2007-12-0317.00:56
User fagin 1 127.0.041 2007-12-0317:09:23
User fogin 2 192.168.0.245 2007-12-03 17:08:00
User fagin 3 182.168.0.245 2007-12-0317:08:16
User fogout 3 192.168.0.245 2007-12-0317:08:27
User fagout 3 182.168.0.245 2007-12-0317:0%:30
User fogin joyce 127.0.0.1 2007-12-0317:.09:36
User Rogin winnie 192.168.0.24% 2007-12-03 17:.09:52
e User fogout Winnie 192.168.0.245 2007-12-03 17:09:58
< > User Rogin JACK 192.168.0.245 2007-12-0317:10:08
Fed UM
Figure 9-32
No. Name Description
1 Connection Builds the connection to a WebCam Server.
2 Disconnect Stops the connection to a WebCam Server.
3 Get Control Obtains the right to remotely control a WebCam Server.
4 Give Up Control Ceases controlling WebCam Servers and users.
5 User List Displays the connected users and their status

6 Bandwidth Record Displays the network traffic in graph display.

7 Event Log Records activities of WebCam Servers and users.

8 Host List Displays all WebCam Servers to be connected.
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9.6.3 Allowing Remote Control

To allow the remote bandwidth control to the WebCam Server, follow the steps below.

2.

n Useful Utilities

—~ I
On the main screen of GV-VMS, click Home M > Toolbar K& > Configure Q > Network

& > WebCam Server. This dialog box appears.

#%Seryer Setup

General |Server Wideo | Audio | JPG Mohile

WehiZam Options

[JEnhance netwark security @
[JEnable Remate Cantral

[ Run Wiewlog Server

Run Bandwidth Control Server

[ ok ] [ cancel | [ Defautt

Figure 9-33

Under the General tab, select Run Bandwidth Control server. After this option is enabled, on

the Control Center Server option list, the Bandwidth Control Service is marked with a check.

v WebCam Server (W)

Connect to Centery2 ()

Connect to YSM (G)

Connect to Backup Center (B)

Failover Plugin

2

Start Default Service

Control Center Server %

Start All Service

Stop All Network Server

Control Center Service

Netwark Port Information

Remote YiewlLog Service

Network failure detection

Remote Desktop Service

I\/ Bandwidth Control Servicel

Stop &ll Service

Figure 9-34

303



Q GeoUision:

9.6.4 Connecting to WebCam Server

1. Click the Connection button (No. 1, Figure 9-32) on the toolbar. This dialog box appears.

Connection @I
Host
| Defaut -]
| Defaut | | Add J Delete
Host Default
IFP Address 127.0.01
Part 3388
User Mame
Password
[ save Password
[ OK l I Cancel
Figure 9-35

2. To add a WebCam Server to be connected to, click Add.

3. Type the host name, IP address, user name and password of the WebCam Server. Modify the

port if necessary.
4. Click OK. After the connection is established, the WebCam Server shows up in the Host List.
5. You can add up to 10 WebCam Servers by repeating above steps.

6. To stop the connection, select the host and click the Disconnect button (No. 2, Figure 9-32). The

host will be deleted from the host list.

7. Up to 5 users of the Bandwidth Control programs can connect to a single WebCam Server for
network traffic monitoring. However, only one user has the access to bandwidth settings. When
this user clicks the Give Up Control button (No. 4, Figure 9-32), the user no longer controls the
WebCam Server. Whoever clicks the Get Control button (No. 3, Figure 9-32) first has access to
bandwidth settings. For bandwidth settings, see Controlling a Specific WebCam Server later in

this chapter.
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9.6.5 Controlling a Specific WebCam Server

To disconnect a login user or set the bandwidth limit for a specific user, right-click the user to have the

options below:

Server Ma... User Name | [P Address Bandwidth Bandwidt... Bandwidt... Status Lagin Time
(=il Ve b . T36.00BIs
Joyce (4) ) 2021-04-1 .
. Gt Kick.
8 Peter (&) 1821 Black TP 2021-04-1...

Bandwidth Setup  »

Figure 9-36

B Kick: Disconnect the user from the WebCam Server.

B Block IP: Prohibit the user from connecting to the WebCam Server. To use the function, the

Enable IP Black List option (Figure 9-39) must be selected first.

B Bandwidth Setup: Select By Username to specify a bandwidth limit for the user, or select By IP
to limit the bandwidth used by the IP address. This setup dialog box will appear. In this example,
an IP address is selected for bandwidth limit setup. Select Bandwidth Setup, specify a

bandwidth limit and click OK.
Bandwidth Setup &|

IP Address

| 127.0.0.1

Bandwidth Setup

Bandwidth

100 KB hd

I OK ] ’ Cancel ]

Figure 9-37
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9.6.6 Setting up Bandwidth

You can manage the bandwidth of multiple hosts, allocated to a WebCam Server, by specifying certain

users and IP addresses when your network is busy or heavily loaded.

1. Click Configure on the menu bar and select Bandwidth Setup.

2. Inthe Bandwidth Setup dialog box, select the desired WebCam Server and click OK. This dialog

box appears.

Bandwidth Setup 3
WehCarm
O pandwidth limit
1 WE v
By IP
192.168.0.121 ~  192168.0.220  1000KA
< »
Add [ Edit || Delete
By Usernarme
Geo 1000 KB
3 >
add I Edit || Deete |
I Ok l l Cancel ]
Figure 9-38

B Bandwidth limit: Select to define the total bandwidth that the WebCam Server will be

allowed to use on your network.
B By IP: Click Add and specify an IP address or a range of IP addresses and its bandwidth
limit.

B By Username: Click Add and specify the user name and its bandwidth limit.

Note: If you have already specified the total bandwidth to a WebCam Server, it is prioritized before

the bandwidth limits set to user names and IP addresses.
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9.6.7 Block List Setup

Two types of block lists are provided to restrict the access to a WebCam Server: permitting and
denying a specified range of IP address to establish the connection. Note that only one type of block

list can be used at a time.

1. Click Configure on the menu bar and select IP White / Black List Setup. A dialog box prompts for

you to select a host.

2. Inthe IP White / Black List Setup dialog box, select the desired WebCam Server and click OK.

This dialog box appears.

IP White/Black List Setup 3
WiehCam w

[ Enable IF White List

192.168.0.220 - 192.168.0.230

| eag || Eat || Deete

[ Enahle IP Black List

sad | Edit [ Detete |

[ Ok ][ Cancel ]

Figure 9-39
3. Select a desired type of block list and click Add to define the IP addresses.

B Enable IP White list: Allow the defined range of IP addresses to establish the connection to
the WebCam Server.

B Enable IP Black list: Prohibit the defined range of IP addresses from establishing the

connection to the WebCam Server.

4. Click OK to apply the settings.
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9.6.8 General Setup

You can set up sound alarm for user log-in, or change the real-time graph display of network traffic.

Click Configure on the menu bar and select General Setup. This dialog box appears.

General Setup

Connection

Auto Connect

User Login

User Login Alarm

Bandwidth Display Option

)

| Bandwidth | | Grid Line
| Background |
Number of Grid Lines |E- v|
ok || cancal | | Default
Figure 9-40

B Auto Connect: Enable the application to connect to previously connected hosts automatically

next time the application restarts,

B User Login Alarm: Enable the computer alarm on when a user logs in.

B Bandwidth Display Option: Set the color of bandwidth save, grid lines of the graph and the

background color of the graph.

B Number of Grid Line: Set the number of grid lines to be displayed on the graph.

You can click the Bandwidth Record tab in the Bandwidth Control window to view the network traffic in

graph.

EventLog | Bandwidth Record

524.00 B3

498.00 BfS

472.00 B}S

420.00 B}S

|
vesoss W"“u"h/u”\hu"\(|U|"\|"|“f\|"\(|”|"\/|”/\|"u“"h"\ﬁu/u"\iumfh/\"\h‘“\"\hj\(u“"W"“\ﬂ““\/\ﬂ"“u"uh”hu(\/\i‘"\ﬁ""\|"\/|“|"\|"|u|"\(\i"iu/u/\"\hJ"\f\ﬁJ"\ﬂ"“\|"|U|"\|“""u"h/u”\ﬁu"\ﬂ"“\"\/|u|"\f|”/\|"\(|u|"\(|u(\/|uf\/\f\|"|“/\(\i"W"“\|"|“f\(|”(|”/u"|”/\|"\(|u|”\(|| IHH\'
| AN . i

(

|

U.W”"\”

Figure 9-41
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9.7 Language Setting

The user interface has been translated from English into 30 other languages. If you find the translation
to be unsuitable and would like to correct it, use the MultiLang Tool to revise the translation. Next, you
can apply the revised text to the applications and export a MRevise.exe file to make the same revision
on another computer. You can also send the revision back to GeoVision to have the revision included

in future software release.

9.7.1 Installing the MultiLang Tool

You can install GV-MultiLang Tool from Utility in GeoVision Website.
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9.7.2 Revising the Translated Text

Revising the Translated Text

1. After completing the installation, close all GeoVision applications, go to Windows Start >

programs > MultilingualConfig. This dialog box appears.

® MultilingualConfig

Language Tools Version

| [ Search 1

English Multiingual Text

[ Save ] [ Cancel

Figure 9-42
2. Click Language and select the language of the text you want to revise.
3. Click Version to select the version of the GV-VMS that you want to revise.

4. Inthe Search field, type all or part of the text in English or the target language and click Search.

The results are displayed.

Note: The search is case sensitive.

5. Double-click the text you want to revise. This dialog box appears.

Sizesirin Defing the maximun and minimum size of objects for mation detection,

< [
sefinir el maximo v minimo tamario de objetos para la Deteccion de Movimiento.
==
< 3
[ QK ] [ Cancel
Figure 9-43
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6. Revise the translated text and click OK.

Note:

1. Itis recommended to revise an entire sentence at a time instead of simply searching a single
word and replacing the word in all other strings.

2. The text may contain symbols such as %d or \n that instruct the application to perform certain
functions. Be careful not to change the symbols in the translated text.

3. Before making any revision, click Tools and select Revision Note to read the revision

instructions.

Applying the Revised Text

1. To apply the revised translation to the applications, click Save. This dialog box appears.

X

Updated:

Authserver: A
Chauthseryer!,

Control Center:
CihiZonkrol Cenkert,

DVR:
C:GY-RVRY

DYRPOS:
CAPO3 Daka Sendert,

POSTextSender:
CHAPOS Text Sender’, w

Figure 9-44

Note: The system will automatically locate the corresponding files on your computer and replace with
the revised translation for the following applications: GV-VMS, Authentication Server, Bandwidth
Control Client Site, Center V2, Dispatch Server, Fast Backup and Restore (FBR), GV-IP Device
Utility, MCamCtrl Utility, Remote E-Map and Remote ViewLog.

2. Click OK. The message “Do you want to apply the revised multilingual texts to another folder?”
appears. If the storage path for the application has been changed or if the associated application

is not listed in the dialog box, click Yes and select the folder of the application.
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Exporti

ng the Revised Text

1. To export the revision as an executable file, click Tools > Export > Export executable file. You

can copy the .exe file to another computer and apply the same translation revision by running

the .exe file.

2. To report the translation revision back to GeoVision:

If your default mail client is Outlook, Outlook Express or Mozilla Thunderbird, click Tools,

Export and Send Report to send the revision.

If your default mail client is not set up or supported, click Tools, Export and Export text file,

and email the exported text file to gvlocalize@geovision.com.tw.

3. For the distributors to duplicate Software DVD with the translation revision,

Copy and paste all the contents of Software DVD to your computer.
Export the revised translation file and rename the file as MRevise.exe.

Move MRevise.exe to the location you saved the contents of Software

DVD :\Software\Translation Revision.
Duplicate the Software DVD with the MRevise.exe file.

Test the Software DVD by clicking 10. Import Translation Revision from the Install Program

window to apply the translation revision.
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9.7.3 Setting up the Ul Language to English

The default user interface (Ul) language of the following GeoVision software and applications is set
according to the region detected. You can install the Set Language tool to set the Ul language to

English.
e GV-VMS
e GV-Fast Backup and Restore Multicam System
e ViewlLog
e GV-Remote ViewlLog
e  GV-IP Device Utility
e GV-Center V2
e GV-Dispatch Server
e GV-Control Center
e GV-Remote E-Map

You can install GV-Set Language tool from Utility in GeoVision Website.

1.  In the Configure window, select English from the Language drop-down list.

Setthe language to English or select Default to use the

language of your computer.

Language | v|
Figure 9-45

2.  Click OK and restart your GeoVision software or application to enable the English UI.

313


http://www.geovision.com.tw/download/product/GV-VMS

Q GeoUision:

9.8 GV-SD Card Sync Utility

GV-SD Card Sync Utility allows you to download videos from the Micro SD card inserted in the GV-IP
Camera. When the connection between GV-IP Camera and GV-VMS is lost, recordings are
automatically saved to the memory card inserted in the GV-IP Camera. To automatically synchronize
and download recordings from the micro SD card to a local folder, install and execute the program on
GV-VMS.

Note:

1. GV-SD Sync Card Utility is only supported by GV-IP Cam H.264 V1.11 or later, GV-IP Cam
H.265 V1.00 or later, GV-BX2600 V1.00 or later, GV-PPTZ7300 V1.01 or later, and GV-SD2411
/ BX12201 / FER12203 V1.01 or later.

2. Itis recommended to keep GV-SD Card Sync Utility running in the background to automatically

synchronize and download videos.

3. Besides the syncing SD card using GV-SD Card Sync Utility, GV-VMS also supports the Sync
recording from camera SD card when reconnected function; see 1.3.1 Setting up Global

Recording Settings for All Cameras.

9.8.1 Installing GV-SD Card Sync Utility

You can install GV-SD Card Sync Utility from Utility in GeoVision Website.
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9.8.2 Setting up GV-SD Card Sync Utility

1. Runthe GV-SD Card Sync Utility. The main window and the Setting window appear. The Setting

window pops up automatically upon first execution. Otherwise, click the Setting button

main window-

" GvSDCardSync

Setting

PlayVideo

IP Cameras [Laog |

P

= b—

| storage |

on the

Camera Type 1P Addre

Synchronization
O h

[ Autoratically synchronize at specified time every day

period fir

Download audio files

Metwork

Max download speed of each device (KBfsec)(0: unlimit)

General

Auto startup after login Windows

Free Space:

M =E
2330 B
(N

Figure 9-46

2. To configure synchronization, network and startup settings, select the Synchronization tab on

the Setting window. This page appears.

nchronizatio

| Storage |

Synchronization

Metwark

General

[ synchranize automatically at an interval iminutes)
[ gynchranize automatically at

Download audio files

Max download speed of each device (KBfsec)

[ start up automatically atWindows login

2320 -

8124

==

Figure 9-47
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[Synchronization]

m  Synchronize automatically at an interval: Automatically synchronize videos from micro SD

cards to a local folder at the specified interval.

m  Synchronize automatically at: Automatically synchronize videos from micro SD cards to a local

folder at the specified time.

m Download Audio Files: Download audio files along with the video files. This option is enabled
by default.

[Network]

m  Max. download speed of each device (Kb/sec): To make sure the bandwidth is not completely
taken up while downloading files from the memory card, specify a maximum download speed. If

you do not want to set a bandwidth limit, type 0.

[General]

m  Start up automatically at Windows login: Automatically launch GV-SD Card Sync Utility when

Windows starts up.

3. To configure the storage and recycling settings, select the Storage tab on the Setting window.

This page appears.

Synchranization || Storage |
Recycle
[ Recycle when the storage space is less than (GE) 1
[ Keep the downloaded files for (Days) 1
Storage Location DiGvSDCardsyne []
I 6128 ] I Cancel
Figure 9-48

Note: By default, downloads are saved to :\GvSDCardSync and are not recycled automatically.
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[Recycle]

m  Recycle when the storage space is less than (GB): Specify a minimum free space of your

local storage for file recycling.

m  Keep the downloaded files for (Days): Specify the number of days to keep the download files

at the local hard drive.
[
[Storage Location]

To configure the storage path, click the button next to the location field and specify a storage location.

4. Click OK to save the configuration and exit the Setting window.
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9.8.3 The Main Window

After installing GV-SD Card Sync Utility, point to Start > Programs > GV-SDCardSync > click
to launch the program. This window appears.

Play ¥ideo

Setting

Sync all devices

IP Address

Status

Camera Type Ungynchronized Size | Unsynchronized Files  Download Speed ' Latest Synchronized File Time |
GyNYR/DVR(Cam01) 192.168.2.21:80 0 bytes 0 0 hytesisec Mot suppart |
CyhYRIDVR(Cam04) 192.168.2.2:80 0 bytes 0 0 btesisec kot support
CYNVRIDVR(Cam0B) 192168.1.77:80 0 bytes 0 0 bytesisec Mat support
GVNYRIDVR(Cam07) 303 G 61 Jownloading flles 31312012 6:59:05 Ad
GyNVR/DVR(Cam03) 192 168.3.141:80 0 bytes 1] 0 bytesisec Mot suppart
GyNVR/IDVR(Cam02) 192168.2.11:80 0 bytes 0 0 hytesisec Synchronize complete 322012 5:5513 PM
Disk free space: 1,178 GB @
Figure 9-49
No. Name Description
) Plays downloaded recordings of the selected GV-IP Cameras using the
1 Play Video ) ] )
ViewLog player. For details, see Chapter 4 Video Playback.
Configures settings of synchronization, network, storage location and
2 Setting recycling criteria. See Running the GV-SD Card Sync Utility earlier in
this chapter.
) Manually synchronizes and downloads the recording files saved in
3 Sync all devices
GV-IP Camera.
4 IP Camera Tab Shows information of GV-IP Camera connected to GV-VMS,.
5 Log Tab Displays up to 100 event entries of GV-SD Card Sync Utility. Once the
og Ta
entries are full, recycling will start from the oldest file.
6 Storage Space Shows the storage space of the designated hard drive.
Note:

1. The synchronization time is recorded according to the system time of GV-IP Camera.

2. The logs are deleted once GV-SD Card Sync Utility is re-activated.
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9.9 Media Man Tools

The Media Man Tools program provides a hot-swap feature, allowing a non-stop recording. You can
add and remove a hot-swap or portable hard drive to the GV-VMS system without interrupting its

monitoring. When the new drive is added, it will be configured to the recording path automatically.

Additionally, you can back up the ViewLog player and database files to play back at any computer.

Note: The minimum disk capacity for the hot-swap feature is 32 GB.

9.9.1 The Media Man Tools Window

This program comes with the installation of GV-VMS. Click Drive C in My Computer, select the
GV-VMS folder, and then select Media Man Tools. This window will appear.

09?

P= '
<l Driverf- MedihanTools @M
Bit View Tools
Driver: C:\ Driver : D:\ Driver : H:\
Free Space : 21.15GB Free Space: 2.13 GB Free Space : 179.38
Total Space : : 48.83 Total Space ::3.73 GB Total Space :: 319.25
Status : Standby Status : Unused Status : Standby
[7] Display details [7] Display details [7] Display details
.
Vi
Figure 9-50
No. Name Description
1 Exit Closes or minimizes the Media Man Tools window.
2 View Refreshes the disk drive status shown in this window.

Sets up the LED panel and automatically logs in the Media Man Tools

3 Tools
window.

Select the option to view the status and information of the disk drives. For

4 Display Details ) o ) . o )
details, see Viewing Disk Drive Status later in this section.
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9.9.2 Viewing Disk Drive Status

To view the detailed information of a drive, check Display Details (No. 4, Figure 9-50) in the desired

drive section. The status window will appear.

r.‘.,u A @ﬂ
Media Type : Local
File System : MNTFS
Free Space : 2115 GB B Free Space o
Total Space : 4883 GB
Status? Standby ® Other Used
VM3 Event Information
Path : Empty
Size and Count : 0 Bytes (0 Files )
Oldest event : - 0
( Mever recycle events are excluded )
Latest event: o
VM3 Database Information
Path : Empty
Size and Count 0 Bytes ( 0 Files ) 9
MDB Information
Path : Empty 0
Size and Count: 0 Bytes ( 0 Files )
Object Index Information
Path : Empty _lﬁ
Size and Count 0 Bytes ( 0 Files )
Viewlog Information
Path : Empty 0
Figure 9-51
No. Name Description

Indicates disk information.

In “Media Type,” two messages may appear:

® L AN: indicates a network hard drive is connected.

® | ocal: indicates a local hard drive is connected.

] Disk Properties In “Status”, three messages may appear:

® Standby: indicates the hard drive already specified as the
recording path.

® Unused: indicates the hard drive not specified as the recording
path.

® Recording: indicates the files are being recorded to the disk.
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No. Name Description

Indicates the path, size and number of recorded events; the dates of the
2 VMS Event Info
oldest and latest events.

3 VMS Database Info Indicates the path, size and number of the ViewLog Event List log files.

4 MDB Info Indicates the path, size and number of System Log files.

5 Object Index Info  Indicates the path, size and number of Object Index files.

6 ViewlLog Info Indicates the location you have backed up the EZ ViewLog player.

Note: The VMS Event Info updates every minute. The MDB Info, VMS Database Info, Object Index

Info and ViewLog Info update as data changes.
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9.9.3 Adding a Disk Drive

1. Click Drive C in My Computer, select the GV-VMS folder, and select the Media Man Tools.

2. Insert a hot-swap hard drive or plug a portable hard drive to your computer. This dialog box

appears.

Find some partitions, What do you want ?
- B

Free Space : 2255 :H

Total Space : 43.84 B
Recording Falder :

H: \Data-H E]

& to recording path
Addto |S‘tnrage 1 L

Storage Information

DoATempn, Camera 1 -~
Camera 2 F
Camera 3
Camera 4
Camera 5
Camera B
Camera 7
Camera §
Catmera 9
Camera 10 w

Figure 9-52

3. Select Add to recording path and select the storage group from the drop-down list.

4. |If there are recording files saved on the hard drive, you may select the options of Delete all

events, Delete all database files or Delete all object index files.
5. Click OK to automatically configure the hard drive to the recording path.

To verify the hard drive is added successfully, check if the “Status” of the drive displays Standby
(see Figure 9-50).

Tip: To add a local drive to the recording path, right-click the desired drive on the Media Man Tools

window (Figure 9-50) and select Add for recording.
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9.9.4 Removing a Disk Drive

To remove a disk drive from the recording path, right-click the desired drive on the Media Man Tools
window (Figure 9-50), and select Remove from recording path. This dialog box will appear. You can
export related database files with the recordings on the hard drive. You can also export the ViewLog

player which allows you to play back the recordings on any computer.

Please select to do something before remove this disk

g0
Expott ViswLog Player
E:Wieslon,
@ Export Wiewlog with databaze files
O Export database files anly
Export System Log databasze files
E:Wienwlon \Datakase)

Expaort Ohject Index files
E:"iewlogiObjectinde:\

Figure 9-53

B Export ViewLog Player:

©® Export ViewLog with database files: Exports the ViewLog player together with ViewLog

Event List log files (.db files), related to the recordings on the hard drive.

© Export database files only: Exports ViewLog Event List log files (.db files) only if the
ViewLog program already exits on the hard drive.
B Export System Log database files: Exports the system log files (.mdb files), related to the
recordings on the hard drive.
B Export Object Index files: Exports the Object Index files, related to the recordings on the hard
drive.
® [...] button: If you want to change the default folder “Viewlog” created on the hard drive, click the

button.

Note: Removing the hard drive will affect ViewLog database. To restore these events, add the hard

drive back to the system and run Repair Database Utility.
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9.9.5 Logging in Automatically at Startup
To automatically log in and minimize the Media Man Tools window at Windows startup, follow these

steps:

1. Click Tools on the menu bar, and select Auto login at Windows startup. A dialog box appears.
2. Type the ID and password of the GV-VMS for automatic login in the future.
If you want to minimize the Media Man Tools window to the system tray at startup, select Auto
minimize at startup.
4. Click OK.

9.9.6 Setting up LED Panel

A LED panel on the screen provides a quick indication of the activity status of hard disk drives.

Ff y

O

OO O m@)@)ﬁ)@’\'
/2 5 6 7 8 9 10-

)N())

J!!l"!'r
(e
‘)

s

—

ol

4
©) g.' l(r\m © f\w((\\'

Figure 9-54
LED Color Description
Gray No HDD is assigned to this LED.
Green A HDD is assigned to this LED.
Red The HDD is full.

GV-VMS is recording or the video / audio files are played back in
Flashing Green
ViewlLog.

Flashing Red The HDD is recycling.
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1. Click Tools on the menu bar on the Media Man Tools window, and select Setup LED Panel. This

dialog box appears.

-
Setup LED Panel

V| LED Panel always stays on top

 Synchronize the LED Panel with the LED Device on @
'GV-Hot Swap GV-VMS
COM Port: COM 1 v
/| Enable disk full beep
Indicate HD status by LED @
i’... cA() 1| @ LED 1
“w H\(New Volume ) & LED 2
& LED3
& LED 4 =
& LEDS
& LED6
W LED7
& LEDS8
& LEDY9
& LED 10
& LED 11 =
[ OK ] [ Cancel w!
J
Figure 9-55

B |LED Panel always stays on top: Makes the LED panel stay on top of other windows when

the Media Man Tools window is minimized.

B Synchronize the LED Panel with the LED Device on GV-Hot Swap VMS: For GV-Hot
Swap VMS System only. If enabled, the LED device installed on the front panel of the
GV-Hot Swap VMS System will synchronize with the LED panel on the screen.

B Enable disk full beep: When the hard disk drive is full, the system makes the beeping
sound. Note this function only works when the motherboard is equipped or installed with a

PC speaker.

2. By default, only the hard disk drive that stores video and audio files will be assigned to LED. If you
want to re-assign the hard disk drive or assign other drives to LEDs, freely move the hard disk

drive to the desired LED on the tree.

3. Click OK to apply the settings, and minimize the Media Man Tools window to display the LED

panel on the screen.
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4. If you want to return to the Media Man Tools window, right-click the LED panel and select Switch

to the setup window.

Note:

1. Because the LEDs are designed to indicate the video and audio files are being written or read, it
is not recommended to assign the HDDs that store log files to the LEDs.

2. If the HDD that stores log files is assigned to a LED and its LED turns red, make sure the log
files are not being written before you remove it. Otherwise, the log files might be lost during the
removal. The default location for data storage is D:\Record\<camxx or audxx folder> for
recorded files, D:\CameraDBs\ for event database files, and C:\GV-VMS\Database for system

logs.
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9.10 Alert Notifications through SNMP Protocol

You can send alert notifications to SNMP-compatible software by using the SNMP Trap Notification

utility.

1.  Click Windows’ Start > All Programs > the GV-VMS folder > SNMPTrapNotification.exe. This

dialog box appears.

(%] SNMP Trap Notification Ea
P Address ]192.168.2.111
Port |1z

[~ Auto Run at Startup

v Send SNMP Trap
—Option -
[~ SelectAl ]

[~ Video Lost

a8 8

[~ Video Resume

&

v 10 Module Lost

=
2

[~ 10 Module Resumed

[~ Connection Lost

A

[~ Connection Resumed

a

[~ Surveillance System Abnormality

4 [ DiskFull

T

Apply | Close

Figure 9-56

2. Type the IP address of the software that will be receiving the alert notification, and modify the

Port if needed.
3.  Torun SNMP Trap Notification upon system startup, select Auto Run at Startup.
4. Select Send SNMP Trap to enable the function.
5. Under Option, select the types of natifications you want to send to the software.

6. Click Apply.
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9.11 Local and Remote Backup

GV-VMS can back up recorded files to any connected hard disk drives or GV-Backup Center over the
Internet. A copy of recorded files will automatically be backed up to the assigned path or GV-Backup

Center.

Note: You can only choose either Local Backup or Remote Backup (with GV-Backup Center). The

two backup methods can not be applied at the same time.

9.11.1 Remote Backup

To back up with GV-Backup Center, see 3.3 Connecting GV-DVR / NVR / VMS in_GV-Backup Center

User’s Manual.

9.11.2 Local Backup

To connect to a hard disk drive, follow the steps below:

1. Click Home W > Toolbar k4l > Network aa > Backup Center. The Backup Server dialog
box appears.

r
Backup Server ﬂ
Remaote Backup Local Backup
Local Backup
Storage
Save Path Total Space Free Space
(o)) 4883 GB 1271 GB
MNew Volume (H:\) 319.25 GB 110.57 GB
[ Used Space 208.68 GB
W Free Space 11057 GB
Advanced Settings E Connect | ‘ Exit
Figure 9-57
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Select Local Backup in the left pane.

Specify in which hard drive you want to back up your files. If you assign multiple hard drives,

when the first hard drive is full, the files will be backed up to the second hard drive.
For Advanced Settings, see the later section for details.

To configure file backup schedule and transfer time, see File Transfer Setting for Local Backup

later in this chapter.
Select your desired storage path and select Connect to back up files.

On the Windows taskbar, right-click on the Geo Backup Client icon. Three options are available:

RNy w -
o ; : Il
Figure 9-58
B Status: “Connected” indicates that Local Backup is successfully activated.

B Backup Status: indicates the status of file backup.

B Playback: open ViewlLog player for playback.

Backup File List ﬂ

File Mame Camera Mame | Progress Status Speed
Event20170208163116003.Avi  Camera3 | m— File Transfer OK 7320811 KB/

Figure 9-59

Note:

1. You can also click & on the first setting page of Local Backup to open ViewLog player.

2. Be sure to assign different Local Backup storage paths from those of GV-VMS.
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9.11.3 Advanced Settings

9.11.3.1 Advanced Settings for Local Backup

IGeneral Setting x

General

Recyde

Minimum Recyde Threshald: 32000 |mB

[keep Days: 20 pay(s)

Compact Video Files

[] Compact Video Files Before Backup

Reserved Frames{MIJPEG) : 3Frame(s) [ 1 5ec. w @

Upload Policy

[ Limit Bandwidth 50 KB/Sec
[JBack up except the latest 20 Day(s)

Bxport file quality Export original stream v

Other

Copy Viewlog to backup drives
[] elete these source files after the backup is complete

Cancel

Figure 9-60
B Minimum Recycle Threshold: Specify a minimum free space of your local storage for file
recycling.
B Keep Days: Specify the number of days to keep the download files at the local hard drive.
B Compact Video Files Before Backup: Compact the recorded video files before backing up.

o |If the recorded video is compressed with H.265 or H.264 codec, it will be compacted into key

frames only.

e |If the recorded video is compressed with MJPEG codec, you can use the Reserved Frames

(MJPEG) option to specify the number of frames.
B Limit Bandwidth xx KB/Sec: Specify a bandwidth limit when uploading files.

B Back up except the latest xx Day(s): Specify to exclude the latest number of days during

backup.

B Export file quality: Select the desired file quality from the following options:

®  Export original stream: Export files in both main and sub stream.
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Export main stream: Export files in main stream.
Export main key stream: Export files with only key frames in main stream.

Export sub stream: Export files in sub stream.

® ©®© 0 ©

Export sub key stream: Export files with only key frames in sub stream.

B Copy Viewlog to backup drives: Copy the ViewLog player to the assigned backup drives.

B Delete these source files after the backup is complete: Delete the recorded files in GV-VMS

after the files are successfully backed up.
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9.11.3.2 File Transfer Settings for Local Backup

The File Transfer Setting allows you to specify the recordings to back up and transfer time.

In this setting dialog box, you can define the following backup rules:

o The day of recordings to be transferred.

e The time period of recordings to be transferred.

o The type of recordings to be transferred, including motion detection, 1/O trigger or all types of
events.

e The time to back up the files.

8 File Transfer Setting E|
Warking Days |HOIidays Transfer Time
[ sunday Thursday
Monday Friday
Tuesday [ saturday
Yednesday
@
Time Span camera Event Type
0:00:00 ~ 23:59:59 All All
00:00:00 3| - 235959 @
1 oK I cancer |
Figure 9-61

[Working Days] Define up to 10 backup rules to specify which recordings, including which type, which

time period and on which working days they were recorded to be transferred to the assigned hard disk

drive.
1.  Select the day, including Monday to Sunday.

2.  Click the arrow button before Time Span and select Modify.

@
Time Span Camera Ewvent Type
E
Todify
Delete
Figure 9-62
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3. Inthis dialog box, select the Camera that you want to back up its recordings, specify Time Span
in which time period of recordings to be transferred, and select Events that you want to back up
all event files, Motion or I/O trigger events only.
1y Setting EI

Tine Span camera & 0
[¥] Camera 1

|I]I] 00:00

e g

Events

(O Transfer all eventfiles

(®iSelect the event types to transfer

[¥]Camera 2
[7] Camera 3
[#] Carnera 4
[¥]Camera s

[¥]Camera B
[#] Motion [¥] Camera 7 2
10 Trigger Camera 8
[¥]Camera g
[¥]Camera 10
[F] Camera 11
[¢] Camera 12
[¥] Camera 13
[¥]Camera14
[VICameral1s bt

[ Ok } [ Cancel ]

Figure 9-63

4. Click OK. The backup settings are created.

5.  To define another backup rule, click the button. A new Time Span is created.

B File Transfer Setting gl

‘working Days ‘Holidavs Transfer Time

[ sunday Thursday
Monday Friday
Tuesday [ saturday
\Wednesday

Time Span Camera Event Type
[ 0:00:00 ~23:59:59 1,234567.. Events
I 2 0:00:00 ~23:59:59 All All

[no:00:00 DR e |

[ ok [ cane |

Figure 9-64

6. Click the arrow button, select Modify and follow the step 3 to define the backup rule.

[Holidays] Define up to 10 backup rules for non-working days, which include which non-working day,
which camera and which type of recording to be transferred to the assigned hard disk drive. For how to

set up a rule, see the instructions in the above [Working Days].

[Transfer Time] Define the daily time, from 00:00 to 23:59:59, to back up the files from the hosts to the

assigned hard disk drive.
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9.12 Report Generator

Report Generator is a useful utility that allows users to generate daily and/or weekly reports, in MDB or
HTML format, for the recording data of GV-VMS without requiring additional installation.

For details, see Report Generator User’s Guide.

9.13 GV-Cloud Center

You can search events of GV-VMS with the cloud-based service, GV-Cloud Center. Using myGVcloud
NotifyApp, you can receive notifications, look up events, access live view and play back recordings
from any iOS or Android mobile devices. Without installing any software, you can also log onto
GV-Cloud Center Portal from a Web browser on any PC to access GV-Cloud Center for event search

and playback. For details, see GV-Cloud Center User’s Manual.

7Y | e view

Teee (“’) Notification
~ -
N~~

~
~
\ . Event Search
Q™ S
~ N
m s \‘m Playback
A
AY

GV-Cloud Center

1
GV-Recording GV-Cloud Center Gvcloud
Server Portal NotifyApp

Figure 9-65
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Point-Of-Sale (POS) Application

A POS device can be integrated to GV-VMS with transaction data overlaid on video channels.
Transaction alerts can be triggered to notify you of transaction events. Video searches can be

performed based on a specific transaction item or a specified time period.
GeoVision provides three POS integration solutions to meet a variety of needs.
1.  Direct POS Integration

2.  GV-Data Capture Box Integration

3.  Graphic Mode POS Integration

Please check the flowchart to find out which solution is suitable for you.
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10.1 Setting up Text Overlay

Point-of-Sale (POS) Application

To change the text font and position of the transaction data on the live view and recorded files, click the

Text Setup button on the POS Server Setup dialog box (Home > Toolbar > Configure > System

Configure > Accessories > POS Device Setup > select one POS device on the list > click the Modify

button).
Text Setup ﬁ
POS /' Wiegand Overlay Object
Text
€ Alignment
Print on video file
Print on screen @ . I
‘@ El
[ Clean time
[¥|Enable Clean time
Clean time 5 Sec.
Transaction end dwell time 5 Sec.
SetFont m
[ ok |[ cancel |

[Text]

B Print on video file: Displays POS data on the recorded video file.
B Print on screen: Displays POS data on the transaction scene.

B Alignment: Select the position of text overlay on the screen.

Figure 10-1

[Clean Time]

B Clean time: Specify the amount of time in seconds after which GV-VMS has not received the

transaction data from the POS device, i.e. the cashier stops entering the transaction data. The

already-displayed POS data will be hidden from the live view.

B Transaction end dwell time: Specify the amount of time in seconds that POS data stays on

the live view before the next transaction.

[Set Font] Click the Set Font button to set up the font for POS data.
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10.2 Filtering Transactions for a Product Item

POS Field Filter allows you to create an independent column for a transaction item in System Log. The

feature filters the transactions, and highlight the price of the item under the created column.

For this example, the transaction item is “Golden Pineapple” which transaction data stands out in the

System Log to attract your attention.

POS1| POSZ |pOS23

Time Content Camera Golden Pingapple
2115/2017 17:54:48 *Apple Juice $0.99 Camera.

21152017 17:54:52 *Papaya $1.00 Camera.
2115/2017 17:54:56 * Strawberry $5.99 Camera.
2i15/2017 17:55:00 *Peach $3.99 Camera.
2115/2017 17:55:04 Reg 4889 5 ltem Camera.
2M15/2017 17:55:08 Total §12 98 Camera.
2M5/2017 17.558:12 Cash $20.00 Camera...
2/15/2017 17:55:16  Cash Drawer open Change$17.04 Camera...
2152017 17.55:21 *All Natural Creamline milk $1.78 Camera...

20152017 17.55:25 * Golden P\neapplew Camera...
20152017 17:55:29 *Ben Jerry Ice Cream $2.00 Camera...
20152017 17:55:33 *Doritos Chips $1.78 Camera...
2i15/2017 17.55:37 Reg 4858 4 ltem Camera...
2115/2017 17.55:41 Total $12.35 Camera...

Figure 10-2

To set up the function, follow the steps below:
1. Onthe POS Server Setup dialog box, select a POS device, and select Capture Data Setting. The

POS Capture Data Setting dialog box appears.

POS5 Server Setup
[ Mew ] [ Modify ” Delete ] [ Capture Data Setting ]I[ Filter Setting ] [ SDK Server ]
Device Mapping Camera Parameter 1 Parametar 2 POS Module
POS 2 Camera 2 127.0.01 TCP/P Port=4000  POSTexSender
POS 23 Camera 1 127.0.01 TCP/P Port=4001 POSTextSender
POS Capture Data Setting B
Name Type Key Word

Figure 10-3
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2. Select a POS device from the drop-down list for setup.

3. Click the New button and select Caption Data. This dialog box appears.

POS Capture Data Setting &

Key Word

Capture Data Type

INumerir_ -

[ with Comma (e.q.1,000)
[]with Decimal Sign

|:| Transaction amount

MDB File Entry Mame

Loss Prevention Setting

[ OK ]I Cancel J

Figure 10-4

[Key Word] Type a keyword matching exactly a transaction item in the receipt. The field is case
sensitive.

[Capture Data Type] Select the type of data followed by the specific transaction item: Numeric,
Currency or Text. If the transaction item is followed by a price amount, select Numeric or
Currency. If it is followed by alphabets, select Text. Any defined amount or text after the keyword
will be brought out.

B With Comma: If there are commas in a price amount, e.g. $1,000, select the option.

B With Decimal Sign: If there are decimal signs in a price amount, e.g. $10.5, select the option.
B With Space: The option is only available when you select Text. If there is space among

letters, select the option.
[MDB File Entry Name] Name the file to store the data.

4. Click OK.
5. Open the POS Table (ViewLog > Toolbar > Tools > System Log) to see the filtering results.
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10.3 Triggering Transaction Alarms

When the abnormal transaction amount of an item occurs, this function can automatically activate the

output device and send out E-Mail alerts. To set up this function, follow these steps:

1. Follow the steps in Filtering Transactions for a Product Item earlier in this chapter to define a
transaction item first. Note that for this alarm function, a space between letters for the Keyword is
not allowed.

2. Click the Loss Prevention Setting button. This dialog box appears.

POS Capture Data Setting @ Loss Prevention Setting @
Key Word Alarm Conditions
Strawberry [#] Alarm Conditions
Capture Data Type > M
’Cun’enq-I v
-
[~ with Comma (2.q.1,000)
[¥] With Decimal Sign

|:| Transaction amount

Alarm Qutput

MDB File Entry M
V Ile Entry Name [] Alarm Qutput

Strawberry
Module L Pin 1

Loss Prevention Setting $ Alert llessage

[¥] Alert Message

Incorrect price

oK ” Cancel l

OK l ’ Cancel

Figure 10-5

[Alarm Conditions] Define the price range for an alarm condition. For this example, when the
price amount in a transaction is great than (>) than 2 dollars, the assigned alarm output and e-mail
alert will be activated.

[Advanced button] See Step 3 below to define the alarm frequency.

[Alarm Output] Assign an installed output module. When the defined alarm condition is met, the
output alarm will be triggered.

[Alert Message] Type an alert message (the space between letters is not allowed). When the
defined alarm condition is met, the e-mail alert will be sent. To enable e-mail notification, see
Setting up Email Notification in Chapter 1. And the alert message will also be noted in the System

Log.
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3. To eliminate false alarms, configure alarm frequency.

Advanced Setting ﬂ
Frequency Conditions
Frequency Conditions
Mumber of Occurrences
20|
Time
one hour -
||
|
|
]
[ OK ] [ Cancel
o — —

Figure 10-6

B Frequency Condition: Enable to set up the number of event occurrences within a time period
to trigger the alarm.
® Number of Occurrences: Specify the number of event occurrences.
®© Time Frame: Select one of the time periods: one hour, 12 hours, one day, one week or

one month.

4. Open the POS Table (ViewLog > Toolbar > Tools > System Log). The transactions met the

defined alarm conditions will be marked with “unusual transaction” event in the System Log.

POS 1| POS2
Time Event Content Camera coke Golden Pi Total Strawberry Note =
2N712017 17:10:57 Cash $100.00 Camera
2172017 171101 Change $87 63 Camera
2H712017 17:11:07 * Coke $0.99 Camera
272017 171 *Apple Juice $0.99 Camera...
21712017 17:11:15 ’Pw 51.00 Cw..
I 2M712017 171119 Unusual transaction * Strawberry $5.99 Camera... 5.99 Incorrectprice I
21712017 17:11:23 *Peach $3.99 Camera...
2712017 171127 Reg 4888 5 ltem Camera
2N72017 17113 Total $12.96 Camera 12,96

Figure 10-7
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10.4 Mapping Codepage

This feature is to support the display of special characters and symbols. When transaction text
incorrectly appears on the screen, a wrong character code may be used. To change a character code,

follow the steps below.

Note: When you cannot find a proper “Script” in the Set Font option (Figure 10-1), you may use the

Codepage feature to fix the display issue of transaction text.

1. Inthe Device dialog box, select Use Codepage Mapping and select a character code from the

drop-down list.

—
eVICE h
PR ColFertSeting
Device bos 1 COM Port
Fiter Seing st
Parly
[[1Use Codepage Mapping )
SIEE
[1252 (ans1-LatinD) ][]
Text Sotin
Figure 10-8

2. To verify the character code you selected, click the [...] button to preview its codepage.

Codepage Mapping Preview El

Fram To

- Urited [ =
01|z 34|56/ 7 /8|9 A B C|DEF ol1|z2|3/4|5 6 7|89 A B|CDEF
oloooojoooojoo (ool oo olojojooojooololo oo oo
10oooooojooooloooon i10j0jojoooojooojoooooaon
2 LA A IE AR RN A A Ia 2 VIME Sy e e, -
3lo1/2/3/4 5 67|89 :|;|<|=> 7 3/0(1(23 4|5 6/ 7|89 : ;|< =|> 2
4@ 4B C D E|F GHIJEKLHNNO 4/ @ A|B C D|EF|GHIJEKLHNHNO
S|P QR ST UV WY Z/M[Y1* S|P|QR|S T|UV WETYZ /41"
6 " abecde/ fighiilklimno 6 " |labcde fghiijklmno
Tl olr s|tju|v|wx|v z {|]l ¥ ~/0 Tlojlgris tuvwx vz { | |~ 0
BlC i|e 4848 cléle il i dd s €0, fl.|. 1t/ |s|d< &0 0
BEEEéU?QQVOUOE £ EXI RN = - ms sleOlE ¥
LlAalila a |l e]s]a o]k i il g B 8 «|o @
Bl e e[+ 0280 BERRE e Lo [ [x] 2
clt ==+ =+ [+ == e clb|ii|5|0xA3p|E|E|E BT 1]E)1
D = ==+ |+ |+ [+ +[+]|+ +]|! T D|p|H &0 oToTo @00 T8 flEls
Ela B|G p|S sut F|ToO4s fen E&aalddaldelcleéléeliiii
Fl=lf/==|t|[y|s["°]--|wn/ =]} Fléa|filadd oo+ e dddiavyh ¥

0K Cancel‘
Figure 10-9

3. Inthe From field, select one symbol or character that are not displayed correctly. In this example,
you can see its previous character code (From side: Ox9C) has been transferred to the default

equivalent (To side: OxA3).
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10.5 Coloring Transactions of a Product Item

You can highlight a desired transaction item in any color. When the transaction item is identified, its text
will have an outstanding color than others on the live view, and the alarm and e-mail alerts can be
triggered at the same time. For example, if the liquor is prohibited for sale in the midnight, a seller can

use this feature to prevent from any unintentional sale.

The identification will be recorded in the System Log for later retrieval as well. In this example, the
transaction item “Strawberry” is colored red, “Golden Pineapple” is orange, and “lce Cream” is pink

whenever these transaction items appear.

PO" b
[Pos 1] P05 2 [pos 23]
Time Event Content Camera coke Golden Pi...  Total Mote

2MB2017 9:58:46 *Apple Juice $0.99 Camera...

2MB/2017 9:58:50 * Papaya $1.00 Camera...

2MB6/2017 9:58:54 * Strawberry $5.99 Camera...

2162017 9:58:58 W Camera...

2MB/2017 9:59:02 Reg 4889 5 ltem Camera...

2162017 9:59:06 Total $12.96 Camera... 12.96

2M16/2017 9:59:10 Cash $20.00 Camera...

2M6/2017 9:59:14 Cash Drawer o... Change$17.04 Camera...

2M6/2017 9:59:19 *All Matural Creamline milk $1.78 Camera...

2MB2017 9:59:23 * Golden Pineapple $3.99 Camera... 3.99

2M6/2017 9:59:27 * Ben Jerry 53.00 Camera...

2MB2017 9:59:32 *m Camera...

2MBI2017 9:59:36 Reg 4888 4 ltem Camera...

2162017 9:59:40 Total $12.35 Camera... 12.35

2M6/2017 9:59:44 Cash $100.00 Camera...

L —
Figure 10-10
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To configure the coloring feature, follow the steps below:

1.

On the POS Server Setup dialog box, select Capture Data Setting. The POS Capture Data
Setting dialog box appears.
POS Server Setup @
[ nNew |[ moaiy |[ Detete | [  Capture Data Setting ]I[ Filter Setting | [ sokserver |
Device Mapping Camera Parameter 1 Parameter 2 POS Module
POS 2 Camera 2 127.0.0.1 TCP/P Port=4000  POSTextSender
POS 23 Camera 1 127.0.0.1 TCP/P Port=4001  POSTextSender
POS Capture Data Setting =5
MName Type Key Word
Figure 10-11
Click New and select Color Keyword. This dialog box appears.
Color Keyword Setting ﬁ
Key Word
liquor |
Caolor
Select Color
Time Setting
Only work between
00:00 S . 00:00 =
Loss Prevention Setting
[ OK J [ Cancel ]

e —
Figure 10-12
[Key Word] Type the keyword to be identified in the transactions. The field is case sensitive.

[Color] Select a color to show on the keyword.

[Only work between] Specify the time period of transactions to identify the keyword.

Note: You can set up to 32 keywords for identification.
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3. To trigger an alarm when the keyword is detected during the transactions, click the Loss

Prevention Setting button. This dialog box appears.

-
Loss Prevention Setting ﬁ

Alarm Conditions
[¥] Alarm Conditions

Alarm Qutput
[¥] Alarm Output

Module 1 *  Pin 1 -

Alert Message
[¥] Alert Message ]

Mot for sale|

[ OK ][ Cancel ]

Figure 10-13

B Alarm Conditions: Enable the alarm when the defined text is detected. To configure alarm
frequency, click the Advanced button. For details, see Step 3, Triggering Transaction Alarms

earlier in this chapter.
B Alarm Output: Assign an installed output module. When the defined alarm condition is met,

the output alarm will be triggered.
B Alert Message: Type an alert message. When the defined alarm condition is met, the e-mail

alert will be sent. To enable e-mail notification, see Setting up Email Notification in Chapter 1.

4. Click OK.

When the keyword is identified in the transactions, the identification appears not only on the live view,

but also are recorded in the System Log (ViewLog > Toolbar > Tools > System Log > POS Table).
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10.6 Displaying Receipt Details of a

Transaction

You can find out receipt details of a single transaction. You will know the amount of the transaction, as

well as the total number and total amount of all transactions during a defined period of time.

[] Event lists From 2017/02/07 to 2017/02/07 - Advanced Log Browser =8 %
File Tools View Help
& & ¥ | 9|k Q] i [Pos - POS - 01 - Bo
D Time Event Device Content Camera | Total ote DST Rollback
] 2017/02/07 00:00: POS1 *All natural creamline Camer. 7 N
7 2017/02/07 00:00:.. POS1  *GoldenPineapple $3... Camer. POS - 01 ==
8 2017/02/07 00:00 POS1 * ben jerry ice cream $3. Camer.
9 2017/02/07 00:00:... POS1  doritos chips $1.78 Camer. Transaction List
10 2017/02/07 00:00: POS1 Reg 4888 4 Item Camer. e
n 2017/02/07 00:00:... POS1  Total $12.35 Camer.. 12.35 2017{02{07 00:00:18 =
12 201710207 00:00:.. PO81  Cash§100.00 Camer.. 2017402407 00:00:52 - » A single transaction
13 2017/02/07 00:00 Stop Transaction POS1 Change$87 63 Camer 201702407 00:01:30
2017{02407 00:02:03
- 2017{02/07 00:02:41
All the transaction contents related to the 2017{02{07 00:03:15
single transaction 2017{02/07 00:03:53
2017{02/07 00:04:26
2017{02407 00:05:05
201702407 00:05:38
2017{02/07 00:06:16
2017/02/07 00:06:49
2017{02/07 00:07:27
2017{02407 00:08:00
2017/02/07 00:08:38
2017{02407 00:09:11
2017/02/07 00:09:49 2
Transaction Count Numiper of transactions during
TG the [defined period of time
Single Transaction Amount  Amigunt of the single
12.35 tramBaction
Total Transaction Amount ¢} amount of transactions
LE805.20 durifig the defined period of time
Search Completed Ttems: 8 NUM
Figure 10-14

To have the feature, you need to define the format of how the amount of a transaction is shown and

how a transaction ends on the receipt. Follow the 3 steps below to complete the settings:

Step 1: Defining the Amount of a Transaction Shown on the Receipt

Step 2: Define How a Transaction Ends on the Receipt

Step 3: Displaying Receipt Details of a Transaction
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Step1: Defining the Amount of a Transaction Shown on the Receipt

1. On the POS Server Setup dialog box, select a desired POS device, and select Capture Data
Setting. The POS Capture Data Setting dialog box appears.

2. Click the New button. This dialog box appears.

POS Capture Data Setting ﬁ
il

Key Word
Total

Capture Data Type

[Currvanu::!,-I -

[]with Comma (e.q.1,000) :
[¥] With Decimal Sign

Transaction amount 1

MDEB File Entry Mame

‘ Loss Prevention Setting ‘

[ OK ][ Cancel ]

Figure 10-15

3. Take the following receipt as an example.

*All Matural Creamline milk $1.78
* Golden Pineapple §$3.99

*Ben Jerry lce Cream $3.00

* Doritos Chips $1.78

Reg 4888 4 Item

Tatal §12.35

Cash $100.00

Change$87.63

Figure 10-16
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a. Type the keyword related to the amount of a transaction. In this example, the keyword is
“Total” which is a prefix in the amount and appears in every receipt. Note the field is case

sensitive.

b. Under Capture Data Type, define if the total amount is attached with a currency symbol. In

this example, select Currency because the currency symbol $ is used.

c. Select With Comma if there are commas in the total amount. Select With Decimal Sign if
there are decimal signs in the total amount. In this example of “Total $12.35”, select With

Decimal Sign.

4. Select Transaction Amount, and click OK.

Step 2: Defining How a Transaction Ends on the Receipt

5. Onthe POS Server Setup dialog box, select the specific POS device, and select Filter Setting.
The Filter Setting dialog box appears.

PQOS Server Setup @
New |[ Moaiy |[ Delete | [ capureDataSeting  |J Fiterseting J||  sokserver |

Device Mapping Camera Parameter 1 Parameter 2 POS Module

iPOS 2 Camera 2 127.0.0.1 TCP/IP Port=4000 POSTextSender

POS 23 Camera 1 127.0.0.1 TCP/IP Port=4001 POSTextSender
Filter Setting (23]

[ New | | Modify | | Delete |

POS Module

Figure 10-17
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Click the New button. This dialog box appears.

[ Add Filter |
Select Sample
POSTextSender -
Filter Mame

End of Transaction]|

| Add

] [ Cancel

Figure 10-18

Point-of-Sale (POS) Application

a. Under Select Sample, select the type of printer attached to the POS device, or the

GeoVision program installed in the POS device.

b.  Under Filter Name, name the filtering criteria. In this example, we will define how a

transaction ends on a receipt, so naming it as “End of Transaction”.

Click the Add button. The Filter Name appears in the list.

Select the created filter name and click the Modify button. This dialog box appears.

Filter Setting

[ MNew

| [ modiy | [ Delete |

=)

Key Word

ACK
BEL
BS
R
cR
£s1
CAN
pC2
DC3
DC4
ETX
EOT
ENQ
ETB
EM
ESC
FF

Command is change line Cut length

FALSE
FALSE
FALSE
TRUE

FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE

1

1
1
0
1
1
1
1
1
1
1
1
1
1
1
1
1

Use replace

FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE
FALSE

Replace word

s Jease o JRase | |FAl

TRAN_STOP

Action Use *

FAL
FAL
FAL
FAL|~
FAL
FAL
FAL
FAL—
FAL
FAL
FAL
FAL
FAL
FAL
FAL
FAL
FAL ™

<|

I

| +

OK ] [ Cancel

Figure 10-19
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9. Click the New button. This dialog box appears.

Add filter rule ==

Delimiter”"EX 1.2.3

Key Word
Ch,an,g,e

oy

[Use random word =
[[]Ccommand is change line

Cut length

[[Use replace

Replace
Action
-
Ok ][ Cancel
Figure 10-20

10. Type the keyword indicating the end of a transaction, and add comma (,) between every letter. In

this example, the keyword is “Change” which appears at the end of every transaction, so type
C,h,a,n,g.e.

* Al Matural Creamline milk $1.78
* Golden Pineapple $3.99

* Ben Jerry lce Cream $3.00

* Doritos Chips $1.78

Reg 4888 4 Item

Total $12.35

Cash $100.00

Change$8?.53

Figure 10-21
11. Under Action, select Stop Transaction.

12. Click OK several times to return to the POS Server Setup dialog box.

350



Point-of-Sale (POS) Application

13. Select the POS device in the list applied for the filter setting, and click the Modify button. The

Device dialog box appears.

14. Under Filter Setting, select the filter setting you set up for the end of a transaction. In this example,

its “End of Transaction”.

Device @
Printer Type [TCPﬂP Part v] TCPR/IP Setting
IP Address or Domain Name
Device 3 -| Pos 2
—
Mapping Camera [Cameraz v]
Browse Device Settin
Filter Setting POSText5ender - ’ g
i s e Device Port 4000
Epson
General ;
In} admin
d !
Use Codepage Mapplgéssfrfxcsssgsggr"re
Password .

Figure 10-22
15. Click OK.

Step 3: Displaying Receipt Details of a Transaction

16. Select ViewLog = > Toolbar 7% [N ToolsD > System Log > Advanced. The Open

Database dialog box appears.

17. Define a period of time to retreive the POS data.

18. From the left side of toolbar, select POS data, select which POS device, and click ~** to have a

list of transactions during the defined period of time.

[Z] Event lists From 2017/02/10 to 2017/02/12 - Advanced Log Browser

File Tools View Help
& & Y lPos - POS - 01 | 5
D Time Event T CuTeT UL Tota IO DST Rollback

There are no items.

Figure 10-23

19. When you click a transaction on the List, its related receipt content will be displayed.
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10.7 Filtering Transactions by a Keyword

You can filter transactions by a keyword to have the following functions: to start a new line after the
keyword, to remove unwanted text before the keyword, to replace a keyword with another, and/or to be

noted as Event, such as Cash Drawer Open, in the System Log when the keyword appears.

For example, we define “Change” as the keyword, and specify it as “Cash Drawer Open” event.
Whenever “Change” appears on the receipt, in the System Log, you will see not only the details of the

transaction, but also an event “Cash Drawer Open” recorded.

POS1| POS2 |POS 23

Time Content Camera Total Golden Pi...  Note

215/2017 16:15:09 *Ben Jerry Ice Cream $3.00 Camera..
211512017 16:15:13 * Doritos Chips $1.78 Camera.
2/15/2017 16:15:17 Reg 4388 4 ltem Camera.
201512017 17:24:47 Cash $100.00 Camera..
2/15/2017 17:24:51  Cash Drawer open Change$87.62 Camera..
21512017 17.24:57 * Coke $0.99 Camera..
2015/2017 17:25:01 *Apple Juice $0.99 Camera..

211512017 17:25:05 *Papaya $1.00 Camera.

2/15/2017 17:25:09 * Btrawberry $5.99 Camera.

211512017 17:25:13 *Peach 53,99 Camera.
201812017 17:25:117 Reg 4889 5 ltem Camera..
2152017 17.25:21 Total $12.96 Camera..
21812017 17.25:25 Cash $20.00 Camera..
21512017 17:25:29  Cash Drawer open Change$17 .04 Camera.

Figure 10-24
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To configure the function, follow the steps below:

1.  To open the following dialog box, follow Step 5 to 8 in Step 2: Defining How a Transaction Ends

on the Receipt, 10.6 Displaying Receipt Details of a Transaction.

Add filter rule =

Delimiter’ EX 1.2.3

Key Waord
C,h,a,n,q,e

Use random word ™

Command is change line
Cut length

Use replace

Replace
Action

-

[ Ok ] | Cancel

Figure 10-25

2. Type the keyword and add comma (,) between every letter. In this example, the keyword is

“Change”, so type C,h,a,n,g.e.

3. Ifthe keyword has a random prefix, select Use Random Word, and type the symbol (*) before

the keyword, e.g. *,C,h,a,n,g.e.

4. If you want the text to start a new line whenever the keyword appears, select Command is

change line.

5. If you want to remove garbled text before the keyword, type the number of characters you want to

remove in Cut Length.
6. If you want to replace the keyword with another, select Use Replace and type a desired word.

7. You can define an event to show in the System Log: Alert, Cash Drawer Open, Cash Drawer

Close, Start Transaction, Stop Transaction, or Valid Transaction.

8. Click OK several times to return to the POS Server Setup dialog box.
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9. Select the POS device in the list applied for the filter setting, and click the Modify button. The
Device dialog box appears.

10. Under Filter Setting, select the filter setting you set up before. In this example, it is Cash Drawer

Open.
Device @
Printer Type [TCPﬂP Part v] TCPR/IP Setting
IP Address or Domain Name
Device 3 -| Pos 2
127.0.0.1
Mapping Camera [Cameraz v]
Filter Setting Cash Drawer Open - [ Browse Device Setting
Cash Drawer Oper . 4000
End of Transaction Device Port
Epson | o admin
Use Codepage MappiGEES‘;SOSCapME
POSTextSender Password *
[ T Tom
[ — 1
Figure 10-26
11. Click OK.

12. Open the System Log (ViewLog > Toolbar > Tools > System Log > POS Table) to view the
filtering results.
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10.8 Searching for POS Events

With the POS Search function, you can instantly search for and play back POS events from the

ViewLog. To access this function, click ViewLog =/ > Toolbar

window appears.

bens& ey ice cream $3.00
du_‘s chips $1.78

Mapa Cabbage $1.99
OMpnic Seediess Grapes $7.98.
dzppicana juice $1.75.
$1.28.

nabisco cookies

> Tools [J > POS Search. This

| Red Graperuit 51689

QWL 5565 2@
POS Data Search é
D Tirma Coatar Eaap Davca M DST remback ™~ 152020 152020
6 202001015 17:58:42 Goiden Pineasple POS 1 (o0 60:00 = | B3sess o (ol R e
a7 20200115 17-68.45 benkparry ice craarm POS 1 '_D 0 ' ' '\9&'\_;‘@
1) 20200115 1758 48 doriles chips POS1 Ml POS |
] 202001/15 17 58 51 Napa Cabbage PGS 1 POS Event Find Tast
Al 2000115 17 58 B4 Ouganic Seedesa Grape PO& 1 . . -
&1 20200115 175857 wroplcana julce PoS1 SR
a2 202007715 175500 nabisco coakies POS1
43 202001115 1755803 Red Graparun O3
24 2020015 17500 auaker satrneal FO31
45 202007015 175000 campell soup POS1 v e
Figure 10-27
No. Name Description
i Displays the recording of the POS event or content selected. Right-click
1 Playback Window ) i
on the window to have the options of Play Mode, Render and Tools
) . Displays all POS transactions viewed while playing back on the Playback
2 Transaction Window .
Window.
3 Exit Click to close Quick Search screen
Includes Play, Pause, Previous 10 frames, Next 10 frames and End
4 Playback Panel buttons, as well as Time Period buttons to jump to 1 second, 10 seconds,

1 minute, 10 minutes and/or 1 hour later or earlier.
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Expand / Select Expand/Shrink Dialog to display the Transaction window or
Shrink Dialog select Advanced Search to display the Advanced Search panel.

Click Find Condition @ to search for specific keywords and/or a type of
POS transaction event forward or backward, starting from a date and
time set. Use the Find Previous @ and Find Next ® buttons to jump
from one search result to another.

6 Find Condition

Advanced Search

7 See 6.1.1 Advanced Search Settings later.
Panel
8 Search Results Displays the search results by Advanced Search.
9 320<->640 Click to switch between 640 x 480 and 320 x 240 display.

Advanced Search Panel

To search for POS events with detailed criteria, click Expand / Shrink Dialog ® on the POS Search
windo and select Advanced Search. The Advanced Search Panel appears.

1. Select the Start / End Dates and Start / End Times from the respective drop-down lists to

specify the desired time period of your POS search.
Select the POS devices you want to search for in the POS Device drop-down list.
Optionally select POS Event to search for a type POS transaction event.

Optionally select Find Text to type a keyword you want to search for.

o M 0N

After the desired conditions are set, click Search @ The search results will be displayed at the
left of the panel.
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